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Preface

This section provides supporting information for the Oracle Financial Services 
Enterprise Case Management Application Pack (OFS ECM) Installation Guide and 
includes the following topics:

• Summary

• Audience

• Related Documents

• Conventions

• Abbreviations

Summary
You can find the latest copy of this document in OTN Library which includes all the 
recent additions/revisions (if any) done till date.

Before you begin the installation, ensure that you have access to the Oracle Support 
Services Portal with the required login credentials to quickly notify us of any issues at 
any stage. You can obtain the login credentials by contacting Oracle Support Services.

Audience
Oracle Financial Services Enterprise Case Management Pack Installation Guide is 
intended for administrators and implementation consultants who are responsible for 
installing and maintaining the Application Pack components. 

Prerequisites for the Audience
The following are the prerequisites from the administrators installing OFS ECM:

This document assumes that you have experience in installing Enterprise components 
and basic knowledge about the following:

• OFS ECM pack components

• OFSAA Architecture

• UNIX Commands

• Database Concepts

• Web server/ Web application server

http://docs.oracle.com/cd/E60570_01/homepage.htm
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Related Documents
This section identifies additional documents related to OFS ECM. 

OFSAAI Related Documents

Following documents are available in OHC.

• Oracle Financial Services Advanced Analytical Applications Infrastructure 
Applications Pack Installation and Configuration Guide

• Oracle Financial Services Analytical Applications Infrastructure Environment 
Check Utility Guide

• Oracle Financial Services Analytical Applications Infrastructure Administration 
Guide

• Oracle Financial Services Analytical Applications Infrastructure User Guide

OFS ECM Application Related Documents

Following documents are available in OHC.

• Oracle Financial Services Enterprise Case Management Administration Guide

• Oracle Financial Services Enterprise Case Management User Guide 

• Oracle Financial Services Enterprise Case Management Configuration Guide

• Oracle Financial Services Enterprise Case Management Release Notes

The following documents are available in My Oracle Support (MOS). You should have 
SSO credentials to access MOS.

• Oracle Financial Services Analytical Applications Infrastructure Security Guide

Conventions
The following text conventions are used in this document:

Table 0–1 Conventions used in this guide

Convention Meaning

boldface Boldface type indicates graphical user interface elements 
associated with an action, or terms defined in text or the 
glossary.

italic Italic type indicates book titles, emphasis, or placeholder 
variables for which you supply particular values.

monospace Monospace type indicates commands within a paragraph, 
URLs, code in examples, text that appears on the screen, or 
text that you enter.

Abbreviations
The following table lists the abbreviations used in this document:

Table 0–2 Abbreviations and their meaning

Abbreviation Meaning

ECM Enterprise Case Management

GUI Graphical User Interface

HTTPS Hypertext Transfer Protocol Secure

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60593_01/homepage.htm
http://docs.oracle.com/cd/E60593_01/homepage.htm
http://docs.oracle.com/cd/E60593_01/homepage.htm
http://docs.oracle.com/cd/E60593_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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J2C J2EE Connector

J2EE Java 2 Enterprise Edition

JDBC Java Database Connectivity

LDAP Lightweight Directory Access Protocol

LHS Left Hand Side

MOS My Oracle Support

OFSAA Oracle Financial Services Analytical Application 

OFSAAI Oracle Financial Services Analytical Application Infrastructure

OLAP On-Line Analytical Processing

OS Operating System

SFTP Secure File Transfer Protocol

URL Uniform Resource Locator

Web Archive WAR

XML Extensible Markup Language

Table 0–2 Abbreviations and their meaning

Abbreviation Meaning
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1About OFSAA and OFSAA Applications Packs

This chapter provides complete details about Enterprise Case Management (ECM) 
Application Pack.

This chapter includes the following topics:

• About OFSAA

• Introduction to OFS ECM Application

• About OFSAA Infrastructure

• About Data Security Configurations

About OFSAA
In today's turbulent markets, financial institutions require a better understanding of 
their risk-return, while strengthening competitive advantage and enhancing long-term 
customer value. Oracle Financial Services Analytical Applications (OFSAA) enable 
financial institutions to measure and meet risk adjusted performance objectives, 
cultivate a risk management culture through transparency, lower the costs of 
compliance and regulation, and improve insight into customer behavior.

OFSAA uses industry-leading analytical methods, shared data model and applications 
architecture to enable integrated risk management, performance management, 
customer insight, and compliance management. OFSAA actively incorporates risk into 
decision making, enables to achieve a consistent view of performance, promote a 
transparent risk management culture, and provide pervasive intelligence.

With the help of OFSAA, the financial services organizations can achieve, 
management excellence with a lower total cost of ownership, due to our integrated, 
architecture, combining performance and risk applications into a single, seamlessly 
integrated framework.

OFSAA delivers a comprehensive and integrated suite of financial services analytical 
applications for both banking and insurance domain. 

The Figure 1—1 depicts the various Applications Pack that are available across the 
OFSAA Banking and Insurance domains: 
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Figure 1–1 OFSAA Applications Packs

Introduction to OFS ECM Application
OFS ECM Application Pack includes the following applications:

• Oracle Financial Services Analytical Applications Infrastructure (OFSAAI) 
powers the Oracle Financial Services Analytical Applications family of products to 
perform the processing, categorizing, selection and manipulation of data and 
information required to analyze, understand and report on specific performance, 
risk, compliance and customer insight issues by providing a strong foundation for 
the entire family of Oracle Financial Services Analytical Applications across the 
domains of Risk, Performance, Compliance and Customer Insight.

• Oracle Financial Services Inline Processing Engine (OFS IPE) provides real-time 
monitoring, detection and interdiction of single and complex fraud events across 
multiple channels and lines of business.

• Oracle Financial Services Enterprise Case Management (OFS ECM) supports the 
investigation and resolution of ML, KYC, Customer Screening, and third party 
events. A newly created case passes through various statuses as part of 
investigation and reaches closure through resolution actions. Enterprise Case 
Management supports the modification of the case details and the associated 
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business data. Investigation workflows can vary based upon the type of case being 
investigated. The case investigation and resolution are supported by various 
actions, which may be specific to the case type. Access to types of cases and 
actions are controlled based on the user role and access permissions. Cases are 
generated from various sources and cases are also manually created in the ECM. 
Enterprise Case Management supports product default case types that drive the 
Investigation workflow. Case types are configurable and can be defined by firms 
to meet their business need. ECM allows to design workflows using Process 
Modelling Framework.

About OFSAA Infrastructure
Oracle Financial Services Analytical Applications Infrastructure (OFSAAI) powers the 
Oracle Financial Services Analytical Applications family of products to perform the 
processing, categorizing, selection and manipulation of data and information required 
to analyze, understand and report on specific performance, risk, compliance and 
customer insight issues by providing a strong foundation for the entire family of 
Oracle Financial Services Analytical Applications across the domains of Risk, 
Performance, Compliance, and Customer Insight.

Components of OFSAAI
The OFSAA Infrastructure includes frameworks that operate on and with the Oracle 
Financial Services Analytical Applications Data Model and form the array of 
components within the Infrastructure. 

The OFSAA Infrastructure components/ frameworks are installed as two layers: 
primarily the metadata server and Infrastructure services run on one layer, and the UI 
and presentation logic runs on the other. The UI and presentation layer is deployed on 
any of the supported J2EE Servers.

The Figure 1—2 depicts the various frameworks and capabilities that make up the 
OFSAA Infrastructure:

Figure 1–2 Components of OFSAAI
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OFSAA Infrastructure High Availability
The current release of the OFSAA Infrastructure supports only "Single Instance" 
installation for the Infrastructure components. However, the High Availability (HA) 
for the Database Server and/or the Web application server clustering and deployment 
are supported in this release.

This release supports Active-Passive model of implementation for OFSAAI 
components. For more information, see Oracle Financial Services Analytical Applications 
Configuration for High Availability- Best Practices Guide.

About Data Security Configurations
Data Security refers to the protection of data against unauthorized access and data 
theft. OFSAA ensures Data Security with the following features:

• Multi-Factor Authentication

• Transparent Data Encryption (TDE)

• Data Redaction

• Key Management

• HTTPS

• Logging

For more details on the features in the previous list, see the relevant topics in this 
guide and the <Data Security and Data Privacy>section in the <Administration and 
Configuration Guide> .

http://docs.oracle.com/cd/E61555_01/books/Configuration%20for%20High%20Availability%20%28HA%29%20Best%20Practices%20Guide.pdf


2

                                                           Understanding OFS ECM Application Pack Installation 2-5

2Understanding OFS ECM Application Pack 
Installation

This chapter includes the following topics:

• Installation Overview

• Deployment Topology

• Hardware and Software Requirements

• Verifying System Environment

• Understanding the Installation Mode

Installation Overview
This release (8.0.6.0.0) of the OFS ECM Application Pack allows the users/ 
Administrators to install a new OFS ECM Application Pack 8.0.6.0.0 instance. 
Figure 2—1 shows the order of procedures required to follow to install a new OFS ECM 
Application Pack 8.0.6.0.0 instance. 
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Figure 2–1 Installation Overview

Table 2—1 provides additional information and links to specific documentation for 
each task in the flowchart.

Table 2–1 OFS ECM Application Pack Installation Tasks and Descriptions

Tasks Details and Documentation

Verify Systems 
Environment

To verify that your system meets the minimum necessary 
requirements for installing and hosting the OFS ECM 
Application Pack, see Verifying System Environment.

Obtain the software To access and download the OFS ECM Application Pack, see 
Obtaining Software.

Configure and Execute the 
Schema Creator Utility

To create the database schema, see Configuring and Executing 
Schema Creator Utility. 

Install OFS ECM Pack To install the OFS ECM Application Pack, see Installing the OFS 
ECM Application Pack.

Configure OFS ECM Pack 
after installation

To configure the OFS ECM Application Pack post installation, 
see Post Installation Configuration.

Deployment Topology
The Figure 2—2 shows the logical architecture implemented for OFS ECM Application 
Pack.
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Figure 2–2 Deployment Topology

Hardware and Software Requirements
This section describes the various Operating Systems, Database, Web server, and Web 
application server versions, and other variant details on which this release of the OFS 
ECM Application Pack has been qualified. 

Note:

OFS ECM Application Pack installation can be performed on both Virtual and 
Physical servers.

The following tables show the minimum hardware and software requirements for 
installing OFS ECM Application Pack.

Configurations supported for Java 7

Table 2–2  Configurations Supported for Java 7

Operating System
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Oracle Linux / Red Hat 
Enterprise Linux (x86-64)

• Oracle Linux Server release 6.1 and above - 64 bit

• Oracle Linux Server release 7.1 and above - 64 bit

Note: Same version of RHEL is supported

Shell • KORN Shell (KSH)

Note: 

• If the operating system is RHEL, install the package lsb_release with one of the following 
commands by logging in as root user:

• yum install redhat-lsb-core

• yum install redhat-lsb

Java Runtime Environment

Oracle Linux / Red Hat 
Enterprise Linux

• Oracle Java Runtime Environment (JRE) 1.7.x - 64 bit

Oracle Database Server and Client

• Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.3.0+) - 64 bit RAC/ 
Non-RAC with/ without partitioning option

• ?Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.4.0 +) - 64 bit 
RAC/Non-RAC with/ without partitioning option, Advanced Security Option**

• Oracle Database Server 12c Release 2 (12.2.0.1+) 

• Enterprise Edition with Oracle Database client 12c Release 1 (v12.1.0.1+)

• Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit

• Oracle Client 12c Release 1 (12.1.0.1+) - 64 bit

• Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin driver)

• Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle thin driver)

Note:

Ensure that the following patches are applied:

• Oracle Server 12c, v12.1.0.1 -17082699

• Oracle Server 12c, v12.1.0.2 - 20698050

• Also for latest information, see http://support.oracle.com/ ,  12.1.0.2 Bundle Patches for 
Engineered Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1)

• Oracle R Enterprise 1.4 requires Oracle Database Enterprise Edition 11.2.0.3/ 11.2.0.4/ 
12.1.0.1

OLAP

Oracle Hyperion Essbase • V 11.1.2.1+ (Server and Client) with Oracle 11g Database

• V 11.1.2.3+ (Server and Client) with Oracle 12c Database

Oracle OLAP • V 11.2.0.3+ with Oracle 11g Database

• V 12.1.0.1+ with Oracle 12c Database

Note:

• Oracle Hyperion Essbase and Oracle OLAP is required only if you are using the OLAP 
feature of OFSAAI. For Oracle OLAP, ensure that you have configured the Oracle 
Database server with OLAP option.

Web server/ Web application server

Table 2–2 (Cont.) Configurations Supported for Java 7
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Configurations supported for Java 8

Oracle Linux / Red Hat 
Enterprise Linux / IBM

Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 2.2.x/ IBM 
HTTP Server

• Oracle WebLogic Server 12.1.x and 12.2.x - 64 bit

• IBM WebSphere Application Server 8.5.5.9+ (Full Profile) 
with IBM Java Runtime - 64 bit

• Apache Tomcat 8.0.x - 64 bit

Note:

• OFSAA Infrastructure web component deployment on Oracle WebLogic Server with 
Oracle JRockit is not supported.

Desktop Requirements

Operating System MS Windows 7 / Windows 8/ Windows 10

Browser Microsoft Internet  Browser 11.x

Chrome 57.x

Firefox 52.x

Turn off Pop-up blocker settings. For more information, see 
Configuring Internet Explorer Settings

Office Tools • MS Office 2007/2010/2013 

• Adobe Acrobat Reader 8 or above

Screen Resolution 1280*1024

Other Software

Directory Services OFSAAI is qualified on both OPEN LDAP 2.2.29+ and Oracle 
Internet Directory v 11.1.1.3.0. However, it can be integrated 
with other directory services software such as MS Active 
Directory.

Note:

• Configuration of Directory services software for OFSAAI installation is optional. For 

more information on configuration, see Setting Infrastructure LDAP Configuration. 

• Open LDAP must be installed on MS Windows Server machine.

Table 2–3  Configurations Supported for Java 8

Operating System

Oracle Linux / Red Hat 
Enterprise Linux (x86-64)

• Oracle Linux Server release 6.1 and above - 64 bit

• Oracle Linux Server release 7.1 and above - 64 bit

Note: Same version of RHEL is supported

Shell • KORN Shell (KSH)

Note: 

• If the operating system is RHEL, install the package lsb_release with one of the following 
commands by logging in as root user:

• yum install redhat-lsb-core

• yum install redhat-lsb

Java Runtime Environment

Table 2–2 (Cont.) Configurations Supported for Java 7
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Oracle Linux / Red Hat 
Enterprise Linux

• Oracle Java Runtime Environment (JRE) 1.8.x - 64 bit

Oracle Database Server and Client

Oracle Database Server Enterprise Edition 11g Release 2 (11.2.0.3.0+) - 64 bit RAC/ Non-RAC 
with/ without partitioning option

Oracle Database Server Enterprise Edition 12c Release 1 (12.1.0.1+)- 64 bit RAC/ 
Non-RAC with/ without partitioning option

• Oracle Database Server 12c Release 2 (12.2.0.1+) 

• Enterprise Edition with Oracle Database client 12c Release 1 (v12.1.0.1+)

• Oracle Client 11g Release 2 (11.2.0.3.0+) - 64 bit

• Oracle Client 12c Release 1 (12.1.0.1.0+) - 64 bit

• Oracle 11g Release 2 (11.2.0.3+) JDBC driver (Oracle thin driver)

• Oracle 12C Release 1 (12.1.0.1+) JDBC driver (Oracle thin driver)

Note:

Ensure that the following patches are applied:

• Oracle Server 12c, v12.1.0.1 - 17082699

• Oracle Server 12c, v12.1.0.2 - 20698050

• Also for latest information, see http://support.oracle.com/ ,  12.1.0.2 Bundle Patches for 
Engineered Systems and DB In-Memory - List of Fixes in each Bundle (Doc ID 1937782.1)

• Oracle R Enterprise 1.4 requires Oracle Database Enterprise Edition 11.2.0.3/ 11.2.0.4/ 
12.1.0.1

OLAP

Oracle Hyperion Essbase • V 11.1.2.1+ (Server and Client) with Oracle 11g Database

• V 11.1.2.3+ (Server and Client) with Oracle 12c Database

Oracle OLAP • V 11.2.0.3+ with Oracle 11g Database

• V 12.1.0.1+ with Oracle 12c Database

Note:

• Oracle Hyperion Essbase and Oracle OLAP is required only if you are using the OLAP 
feature of OFSAAI. For Oracle OLAP, ensure that you have configured the Oracle 
Database server with OLAP option.

Web server/ Web application server

Oracle Linux / Red Hat 
Enterprise Linux/ IBM

Oracle HTTP Server 11.1.1.1/ Apache HTTP Server 2.2.x/ IBM 
HTTP Server

• Oracle WebLogic Server 12.1.x and 12.2.x - 64 bit

• IBM WebSphere Application Server 8.5.5.9+ with bundled 
IBM Java Runtime - 64 bit

• Apache Tomcat 8.0.x - 64 bit

Note:

• OFSAA Infrastructure web component deployment on Oracle WebLogic Server with 
Oracle JRockit is not supported.

• For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 8, download and 
install patch 18729264 from http://support.oracle.com/. 

Desktop Requirements

Operating System MS Windows 7 / Windows 8/ Windows 10

Table 2–3 (Cont.) Configurations Supported for Java 8

https://support.oracle.com/epmos/faces/MosIndex.jspx?_afrLoop=171145527063081&_afrWindowMode=0&_adf.ctrl-state=9bxcn9tmr_9
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http://support.oracle.com/
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Table 2—4 provides the recommended software combinations for OFS ECM 
Application Pack deployment.

Table 2–4 Recommended Software Combinations

Operating System Database Web application server Web server

Oracle Linux 5.3 up 
to 5.10/ 6.0 and 
above 

Oracle Database Oracle WebLogic Server 
/Apache Tomcat Server

Oracle HTTP Server/ 
Apache HTTP Server

Oracle Solaris 5.10/ 
5.11

Oracle Database Oracle WebLogic Server 
/Apache Tomcat Server

Oracle HTTP Server/ 
Apache HTTP Server

Verifying System Environment
To verify your system environment meets the minimum requirements for the 
installation, a Pre-Install Check utility is available within the Install Kit archive file. 
This utility can also be obtained separately by contacting Oracle Support Services.

Though the system environment verification is an integral and automated part of the 
installation of this software product, Oracle strongly recommends running this utility 
prior to beginning the installation as part of your organization's "Installation 
Readiness Verification Process".

Browser Microsoft Internet  Browser 11.x

Chrome 57.x

Firefox 52.x

Turn off Pop-up blocker settings. For more information, see 
Configuring Internet Explorer Settings

Office Tools • MS Office 2007/2010/2013 

• Adobe Acrobat Reader 8 or above

Screen Resolution 1024*768 or 1280*1024

Other Software

Directory Services OFSAAI is qualified on both OPEN LDAP 2.2.29+ and Oracle 
Internet Directory v 11.1.1.3.0. However, it can be integrated 
with other directory services software such as MS Active 
Directory.

Note:

• Configuration of Directory services software for OFSAAI installation is optional. For 

more information on configuration, see Setting Infrastructure LDAP Configuration. 

• Open LDAP must be installed on MS Windows Server machine.

Note: To upgrade an existing OFSAA 8.0.x Java 7 instance to Java 8, 
see Appendix P.

Table 2–3 (Cont.) Configurations Supported for Java 8
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Oracle Financial Services Analytical Applications Infrastructure 
Environment Check Utility Guide given in the Related Documents 
section.
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Understanding the Installation Mode
 The following modes of installation are available for the OFS ECM Application Pack.

• Installing in Silent Mode

Installing in Silent Mode
This mode mandates updating the installation configuration files with required details 
and performs installation in a "Silent" non user interactive format.



3

                                                           Preparing for Installation 3-13

3Preparing for Installation

Note:

• Starting from version 8.0.5.0.0, OFS ECM is available as a standalone 
application. If OFS ECM has to be installed with another FCCM 
application, ensure that you install both the applications on same 
schema/infodom.

• Release 8.0.6.0.0 of Oracle Financial Services Enterprise Case 
Management is not fully backward compatible with earlier versions of 
FCCM applications. You must upgrade all of your FCCM applications 
from existing 8.0.x versions to 8.0.6.0.0 version and cannot choose to 
upgrade only selective application packs to v8.0.6.0.0. 

• Upgrade of ECM to version 8.0.5.0.0 and 8.0.6.0.0 is not supported for 
FATCA case types.

This chapter provides necessary information to review before installing the Oracle 
Financial Services Enterprise Case Management (OFS ECM) Application Pack 
v8.0.6.0.0.

This chapter includes the following topics:

• Installer and Installation Prerequisites

• Obtaining Software

• Performing Common Pre-Installation Tasks

Installer and Installation Prerequisites
Table 3—1 provides the list of prerequisites required before beginning the installation 
for OFS ECM application. The Environment Check utility notifies you if any 
requirements are not met.
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Table 3–1  Prerequisite Information

Category Sub-Category Expected Value

Environment 
Settings

User Permission User to have 755 permission on the directory 
identified for installation (FIC_HOME). 

Note: User to have 755 permission on the .profile 
file

Java Settings • PATH in .profile file must be set to include 
the Java Runtime Environment absolute path. 
The path should include Java version (7 or 8) 
based on the configuration.

Note:

• Ensure that the absolute path to JRE/bin is set 
at the beginning of PATH variable.

• For example, 
PATH=/usr/java/jre1.7/bin:$ORACLE_
HOME/bin:$PATH

• Ensure that no SYMBOLIC links to JAVA 
installation are not set in the PATH variable

Oracle Database 
Settings

Oracle Database Server

• TNS_ADMIN must be set in.profile file 
pointing to appropriate tnsnames.ora file.

• Enable Transparent Data Encryption (TDE) 
and/ or Data Redaction**

For more information, see Appendix R, 
"Configuring Transparent Data Encryption 
(TDE) and Data Redaction in OFSAA".

OFSAAProcessing Server

• ORACLE_HOME must be set in .profile file 
pointing to appropriate Oracle DB Client 
installation.

• PATH in .profile file must be set to include 
appropriate $ORACLE_HOME/bin path.

• Ensure that an entry (with SID/ SERVICE 
NAME) is added in the tnsnames.ora file on 
the OFSAA server.
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OS/File System 
Settings

OS Level Settings You must set your locale to UTF-8 locale (LANG, 
NLS_LANG to be set in.profile). Specifying a locale 
depends on your data and the operating system 
installed on your system.

For example, 

• For Linux OS: export LANG=en_US.utf8

You can determine the locale on your system using 
the locale -a command

export NLS_LANG=AMERICAN_
AMERICA.AL32UTF8

File Descriptor 
Settings

Greater than 15000

Total Number of 
Process Settings

Greater than 4096

tmp space Prior to installation, ensure that sufficient free temp 
space (minimum 1 GB free) is available in /tmp 
directory of unix server hosting OFSECM.

Port Settings Default port numbers to be enabled on the system 
are 6500, 6501, 6505, 6507, 6509, 6510, 6666, 9999, 
and 10101.

Staging Area/ 
Metadata 
Repository

A directory to hold the application metadata 
artifacts and additionally act as staging area.The 
directory should exist on the same system as the 
OFSAA Infrastructure (can be configured on 
different mount). However, the owner of the 
installation directory mentioned above should have 
RWX (read, write, and execute) permissions on this 
folder.

Set 775 permission on this folder.

Note: This directory is also referred as FTPSHARE 
folder.

Installation 
Directory

A directory where the product files will be installed.

Assign User permission to 755 on the installation 
directory.

Temporary 
Directory

Default temporary directory where installation files 
are stored for a short period of time to support 
faster installation.

• For installation on UNIX OS, your UNIX 
administrator must give you the required 
read-write permissions for the /tmp directory 
and disable the NOEXEC option

• Configure adequate space on the /tmp 
directory. It is recommended that you allocate 
more than 10 GB of space.

Note: If NOEXEC is enabled, the extraction of files 
by the installer into the /tmp directory is prevented 
and the binaries will not execute in the directory, 
which will fail the installation. 

Download 
Directory

A directory where the product installer file will be 
downloaded/ copied.

Ensure user permission is set to 755 on the 
Download directory.

Table 3–1 (Cont.) Prerequisite Information

Category Sub-Category Expected Value
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Database Settings Database Instance 
Settings

• NLS_CHARACTERSET to be AL32UTF8

• NLS_LENGTH_SEMANTICS to be BYTE

• AVAILABLE OPEN CURSORS limit to be 
greater than 4096

For an Oracle Database installation, set your Oracle 
NLS_LANG environment variable to an 
appropriate UTF-8 character set. 

For example, setenv NLS_LANG AMERICAN_
AMERICA.AL32UTF8

Note: For other database tunable parameters 
required for OFS ECM, see Appendix S, "Tunable 
Database Parameters". 
Ensure that the OLAP_USER role is available in the 
database.

Web application 
server

WebSphere/ 
WebLogic/ 
Tomcat

Web application server should be installed and 
profile/domain created.

You are prompted to enter the WebSphere Profile 
path, WebLogic Domain path, or Tomcat 
Deployment path during OFSAAI installation.

Note: 

• See Appendix A for WebSphere Profile and 
WebLogic Domain creation.

• For deployment on Oracle WebLogic Server 
12.1.3+ (64 bit) with Java 8, download and 
install 

 18729264 from http://support.oracle.com/.

Web server Apache HTTP 
Server/ Oracle 
HTTP Server/

IBM HTTP Server.

This is an optional requirement. HTTP Server 
Installation to be present. You are prompted to 
enter the Web server IP/Hostname and Port details 
during installation.

Note: See Appendix A for Web server installation.

Operating System Solaris 11

Solaris 10

Upgrade to Oracle Solaris 11.3 with SRU09 or 
higher. See https://docs.oracle.com/cd/E53394_
01/html/E54845/index.html to upgrade to SRU09 
if you have a lower SRU version. Additionally, 
install the required runtime libraries. For more 
information, see Installing Only the Runtime 
Libraries on Oracle Solaris 11. 

Install the required OS patches. For more 
information, see Installing the Required Oracle 
Solaris 10 Patches. Additionally, install the required 
runtime libraries. For more information, see 
Installing Only the Runtime Libraries on Oracle 
Solaris 10.

Note: Before you install the OFS ECM Application 
pack, ensure that all the dependency packs have 
been upgraded to 8.0.6.0.0 version. 

Table 3–1 (Cont.) Prerequisite Information

Category Sub-Category Expected Value
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Obtaining Software
The 8.0.6.0.0 release of OFS ECM Application Pack can be downloaded from My 
Oracle Support (https://support.oracle.com/). You must have a valid Oracle account 
to download the software.

Performing Common Pre-Installation Tasks
The common pre-installation activities that you must carry out before installing the 
OFS ECM Application Pack are:

• Identifying the Installation, Download and Metadata Repository

• Downloading and Copying the OFS ECM Application Pack Installer

• Extracting the Software

• Setting Up Web application server

OFSAAI One-off 1. Since OFSAA 8.0.6.0.0 releases are not fully 
backward compatible with applications on 
earlier versions, you should apply the 
mandatory compatibility patch 28033582 and 
plan for one of the following:

• Perform entire OFSAA instance upgrade to 

8.0.6.0.0 version after confirming that all of 

the application packs in your instance are 

available for upgrade to 8.0.6.0.0 version.

• Upgrade only selective packs in your 

instance to 8.0.6.0.0, while retaining the 

remaining applications at their current 

versions. 

Note: The compatibility patch 28033582 is 
mandatory for both the options described in 
the preceding list. The instructions to 
download and apply the patch is described in 
further steps and sections in this document. 

2. Download the mandatory consolidated one-off 
patches 27938294 and 28079607 from 
http://support.oracle.com/. 

3. Download the mandatory compatibility patch 
28033582 from http://support.oracle.com/. 
This patch enables you to upgrade selected 
packs in your OFSAA instance to 8.0.6.0.0 and 
makes the existing packs from earlier versions 
compatible with 8.0.6.0.0. 

4. Download the mandatory consolidated one-off 
patch 28033370 from 
http://support.oracle.com/.

IPE One-off Download the consolidated one- off patch for bug 

number 28045149 from http://support.oracle.com/.

Table 3–1 (Cont.) Prerequisite Information

Category Sub-Category Expected Value

http://support.oracle.com/
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Identifying the Installation, Download and Metadata Repository 
To install OFSAA Application packs, create the following directories:

• OFS ECM Download Directory (Optional) - Create a download directory and 
copy the OFS ECM Application Pack Installer File (archive). This is the directory 
where the downloaded installer/patches can be copied.

• OFS ECM Installation Directory (Mandatory) - Create an installation directory 
and copy the installation files. Perform the installation from this directory. Set the 
variable FIC_HOME variable in the .profile file to point to the OFS ECM Installation 
Directory.

• OFS ECM Staging/Metadata Directory (Mandatory) - Create a Staging/Metadata 
Directory to copy data loading files, save data extracts and so on. Additionally, 
this directory also maintains the OFSAA metadata artifacts. This directory is also 
referred to as "FTPSHARE".

Note:

Assign 755 user permission to the Installation and Download Directory.

Assign 755 user permission to the Staging Directory.

Downloading and Copying the OFS ECM Application Pack Installer
To download and copy the OFS ECM Application Pack Installer, follow these steps:

1. To download the OFS ECM Application Pack, log in to My Oracle Support 
(https://support.oracle.com/) with a valid Oracle account.

Download the mandatory installer one-off patch 28080898 from My Oracle 
Support.    

2. Enter Oracle Financial Services Enterprise Case Management in the search box to 
search.

3. Download the installer archive into the Download Directory (in Binary mode) in 
the setup identified for OFS ECM installation.

Extracting the Software

Note: 

You must be logged in to the UNIX operating system as a non-root 
user.

1. Download the unzip utility (OS specific) unzip_<os>.Z and copy it in Binary mode 
to the directory that is included in your PATH variable. If you already have the 
unzip utility to extract the contents of the downloaded archive, skip this step.

2. Uncompress the unzip installer file with the command:

uncompress unzip_<os>.Z

Note:

If an error message "uncompress: not found [No such file or 
directory]" is displayed when the package is not installed, contact 
your UNIX administrator.

https://support.oracle.com/
https://edelivery.oracle.com


Performing Common Pre-Installation Tasks

                                Preparing for Installation 3-19

3. Assign EXECUTE permission to the file with the command:

chmod 751 unzip_<OS>

For example, chmod 751 unzip_sparc

4. Extract the contents of the OFS ECM Application Pack 8.0.6.0.0 installer archive 
file in the download directory with the following command:

unzip OFS_ECM_PACK.zip

Note

Do not rename the Application Pack installer folder name on 
extraction from the archive.

5. Navigate to the download directory and assign execute permission to the installer 
directory with the following command:

chmod -R 755 OFS_ECM_PACK

Setting Up Web application server
For setting up the environment based on your selected Web application server, see 
Configuring Web application servers.
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4Installing OFS ECM Application Pack

This chapter describes the steps to be followed to install the OFS ECM Application 
pack depending on the offline and online modes of installation.

Note: If you are installing an Application Pack on an environment, where another 
Applications Pack is already installed, you may sometimes get a warning message 
such as Object Already Exists. This message can be ignored.

This chapter includes the following sections:

• About Schema Creator Utility

• Configuring and Executing Schema Creator Utility

• Installing the OFS ECM Application Pack

• Verifying Installation

About Schema Creator Utility
Creating database users/schemas is one of the primary steps in the complete OFS 
ECM installation. This release of OFSAA provides a utility to quickly get started with 
the OFSAA 8.0.6.0.0 installation by allowing easier and faster creation of database 
User(s)/ Schema(s), assign the necessary GRANT(s), and so on. Additionally, it also 
creates the required entities in the schemas and so on. 

The schema creator utility must be configured and executed before installation of any 
OFSAA Application Pack.

This section includes the following topics:

• Configuring Schema Creator Utility

• Selecting Execution Modes in Schema Creator Utility

• Selecting Execution Options in Schema Creator Utility

Configuring Schema Creator Utility
The schema creator utility should be configured and executed mandatorily every time 
prior to installation of any OFSAA Applications Pack.

The types of schemas that can be configured are:

• CONFIG - This schema holds the entities and other objects required for OFSAA 
setup configuration information. 



Note: There can be only one CONFIG schema per OFSAA instance.
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• ATOMIC - This schema holds the data model entities. One ATOMIC schema is 
attached to one Information Domain.

Note: There can be multiple ATOMIC schemas per OFSAA Instance 
and an Information Domain can have only one ATOMIC schema.

Selecting Execution Modes in Schema Creator Utility
Schema creator utility supports the following modes of execution:

• Online Mode: In this mode, the utility connects to the database and executes the 
Data Definition Language (DDL) for User, Entities, and GRANTS.

Note: To execute the utility in Online mode, you need to connect as 
"<User> AS SYSDBA".

• Offline Mode: In this mode, the utility generates an SQL script with all the 
required DDLs for User, Entities and GRANTS. This script must be executed by 
the DBA on the appropriate database identified for OFSAA usage.

Note: For running the sql script generated in offline mode, the script should 
reside in the same directory where the 'SQLScripts' directory is available.

Note: 

1. To execute the utility in Offline mode, you must connect as a user 
with the following GRANTS (alternatively, you can also connect 
as a user with SYSDBA privileges):

• SELECT ON DBA_ROLES

• SELECT ON DBA_USERS

• SELECT ON DBA_DIRECTORIES

• SELECT ON DBA_TABLESPACES

• CREATE SESSION

2. Do not modify the OFS_ECM_SCHEMA_OUT.XML file generated after 
the execution of this utility

3. If there are any errors during the SQL script execution, 
reconfigure the OFS_ECM_SCHEMA_IN.xml file and execute the 
utility. This regenerates the scripts with corrected information. For 
more information, see Configuring OFS_ECM_SCHEMA_IN.xml File.

4. Do not modify the OFS_ECM_SCHEMA_OUT.XML file generated after 
the execution of this utility.

5. Do not keep any backup files of xml's in the download directory.
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Selecting Execution Options in Schema Creator Utility
Depending on the option selected to run the OFSAA Applications Pack installer, you 
must select the appropriate schema creator utility execution option. To run the OFSAA 
Applications Pack installer in Silent mode, it is mandatory to execute the schema 
creator utility with -s option.

Configuring and Executing Schema Creator Utility
This section includes the following topics:

• Prerequisites

• Configuring Schema Creator Utility

• Executing the Schema Creator Utility

• Verifying the Schema Creator Log Files

Note: If you intend to use Oracle OLAP feature, execute the below 
grant on all ATOMIC schema(s): grant olap_user to &database_
username.

Prerequisites
The prerequisites you must have before configuring the Schema Creator Utility are:

• Oracle User ID/Password with SYSDBA privileges

• JDBC Connection URL for RAC/Non RAC database

• HOSTNAME/IP of the server on which OFSAA is being installed.

• TNSNames.ora should have entry for the database planning to install the Database 
objects.

• For enabling Transparent Data Encryption (TDE) in your OFSAA instance during 
installation, perform the steps explained in the Appendix R, "Configuring 
Transparent Data Encryption (TDE) and Data Redaction in OFSAA".

Configuring Schema Creator Utility
This section explains the steps to configure the Schema Creator Utility.

Note: The extracted media pack folder name must not be changed.

To configure the Schema Creator Utility, follow these steps:

1. Log in to the system as non-root user.

2. Navigate to the following path: OFS_ECM_PACK/schema_creator/conf directory.

3. Edit the OFS_ECM_SCHEMA_IN.xml file in a text editor.

4. Configure the following elements as described in the section Configuring OFS_
ECM_SCHEMA_IN.xml File:

5. Save the OFS_ECM_SCHEMA_IN.xml file.



Note: On successful execution of the utility, the entered passwords 
in the OFS_ECM_SCHEMA_IN.xml file are nullified.

Do not clean up the OFS_ECM_SCHEMA_OUTPUT.XML file 
post-installation as it would be required in future patch installations 
and upgrades.

Note: While editing the OFS_ECM_SCHEMA_IN.xml, ensure only the 
values/tag attributes mentioned in must be modified and none of 
other tags should be modified.

Do not modify the following list of attributes:

• APP_PACK_ID

• SCHEMA. APP_ID

• SCHEMA. DEFAULTTABLESPACE

• SCHEMA.TYPE

• TABLESPACE.NAME
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Executing the Schema Creator Utility 
You can execute the schema creator utility in Online mode or Offline mode. This 
section includes the following topics:

• Executing the Schema Creator Utility in Online Mode

• Executing the Schema Creator Utility in Offline Mode

• Executing the Schema Creator Utility with -s Option

• Executing the Schema Creator Utility while Installing Subsequent Applications 
Pack

Executing the Schema Creator Utility in Online Mode
In Online mode, the Schema Creator Utility creates all the Schemas, Schema Objects, 
Tablespaces, Grants, and Roles in the database during the execution process.

To execute the Schema Creator Utility in Online mode, follow these steps:

1. Log in to the system as non-root user.

2. Navigate to the following path: OFS_ECM_PACK/schema_creator/bin/

3. Execute the osc.sh file using the following command:

./osc.sh
4. The following message is displayed: You have chosen ONLINE mode. Triggering 

the utility in ONLINE mode will execute the DDLs directly on the Database. Do 
you wish to proceed? (Y/y or N/n).

5. Enter Y/ y to proceed with the script generation.

6. Enter the DB Username with SYSDBA Privileges. For example: SYS as SYSDBA.

7. Enter the User Password.
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Figure 4–1 Schema Creation - Online  Mode

Note: On successful execution of Schema Creator utility, the console displays 
the following status message:

Schema Creator executed successfully. Please proceed with the installation. 

See log file in OFS_ECM_PACK/schema_creator/logs directory for 
execution status. If there are any errors, contact Oracle Suport 
Services.

Executing the Schema Creator Utility in Offline Mode
In Offline Mode, the Schema Creator Utility creates an output in the SQL file format. 
This script must be executed manually by logging as database user with SYSDBA 
privileges. The SQL file contains the creation of Schemas, Schema Objects, and Roles.

Prerequisites:

To execute the utility in Offline mode, you must connect a database user with the 
following GRANTS (Alternatively, you can also connect as a user with SYSDBA 
privileges):

• SELECT ON DBA_ROLES

• SELECT ON DBA_USERS
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• SELECT ON DBA_DIRECTORIES

• SELECT ON DBA_TABLESPACES

• CREATE SESSION

To execute the schema creator utility in Offline mode, follow these steps:

1. Log in to the system as non-root user. 

2. Navigate to OFS_ECM_PACK/schema_creator/bin directory.

3. Execute the osc.sh file using the following command:

./osc.sh -o

4. Enter Y /y to generate the script. 

5. The following message is displayed: You have chosen OFFLINE mode. Triggering 
the utility in OFFLINE mode will generate the script. Do you wish to proceed? 
(Y/y or N/n).

6. Enter the DB Username with SELECT privileges.

7. Enter the User Password.

Figure 4–2 Schema Creation - Offline Mode

8. The console runs the initial validation checks and displays the following message: 
You have chosen to install this Applications Pack on <Name of the Atomic 
Schema>ATOMIC schema. Do you want to proceed? (Y/N). 

9. Enter Y/y to start the script generation. The following message is displayed. You 
have chosen to install this Applications Pack on <Name of the Infodom>. Do you 
want to proceed? (Y/N)).

Note: Explicit GRANTS to the user are required. GRANTS assigned 
through Roles are not supported



Note: On successful execution of schema creator utility, the console displays 
the following status message: 

Success. Please execute OFS_ECM_PACK/schema_creator/sysdba_
output_scripts.sql before proceeding with the installation.
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Figure 4–3 Schema Creation - Offline Mode

10. Navigate to the directory: 

OFS_ECM_PACK/schema_creator

11. Open the sysdba_output_scripts.sql file and modify SET PAGESIZE 0 FEEDBACK 
OFF VERIFY OFF HEADING OFF ECHO OFF to SET PAGESIZE 0 FEEDBACK OFF 
VERIFY OFF HEADING OFF ECHO OFF SQLBLANKLINES ON.

12. Login to SQLPLUS with a user having SYSDBA Privileges.     

13. Connect to the Oracle DB Server on which the OFS ECM Application Pack 
installation is to be performed and execute the sysdba_output_scripts.sql file 
using the following command:

SQL>@sysdba_output_scripts.sql

Figure 4–4 Schema Creator - Offline Mode
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Alternatively, you can copy the sysdba_output_scripts.sql file and 
SQLScripts directory to a remote server and execute sysdba_output_scripts.sql 
file.

Note: See log sysdba_output_scripts.log file for execution status. 
If there are any errors, contact Oracle Support Services. SQL Scripts 
folder and SQl file should reside in the same folder.

14. Once the above file gets executed, a warning is displayed as shown in the above 
screen.

15. Run the following scripts in config schema:

1. Navigate to the <OFS_ECM_PACK>/schema_creator/SQLScripts/oracle folder.

2. Connect to the config schema through sqlplus

3. Execute the @compile_objects.sql command.

4. Commit the change.

Executing the Schema Creator Utility with -s Option
If you want to run the OFS ECM Application Pack Installer in Silent mode, it is 
mandatory to execute the schema creator utility with -s option.

To execute the utility with -s option, follow these steps:

1. Edit the file OFS_ECM_PACK/schema_creator/conf/OFS_ECM_SCHEMA_IN.xml in text 
editor.

2. Execute the utility with -s option.

For example ./osc.sh -s

Figure 4–5 Schema Creator with - s option

Note: To execute the utility in OFFLINE mode with Silent option, type 
./osc.sh -o -s
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Executing the Schema Creator Utility while Installing Subsequent 
Applications Pack
While executing the schema creator utility for subsequent Applications Pack, you can 
choose to install the pack either on the same Information Domain/Atomic Schema or 
on a new Information Domain/Atomic Schema. You can execute the Schema Creator 
Utility either in Online or Offline mode.

To execute the schema creator utility while installing OFS ECM Pack over an existing 
Application Pack, follow these steps:

1. Perform the steps 1 to 5 from the Executing the Schema Creator Utility section.

Note: On successful execution of Schema Creator utility, the console 
displays the following status message:

Success. Please proceed with the installation. 

See the log file in OFS_ECM_PACK/schema_creator/logs directory for 
execution status, if scripts are executed in online mode. 

See the log sysdba_output_scripts.log for execution status, if 
executed in offline mode.

If there are any errors, contact Oracle Support Services.

Verifying the Schema Creator Log Files
You can verify the log files for any errors faced during the schema creation process in 
the following location: OFS_ECM_PACK/schema_creator/logs.

Installing the OFS ECM Application Pack
This section provides instructions to install the OFS ECM Application Pack depending 
on the mode of installation.

• Installing in Silent Mode

Installing in Silent Mode
In the Silent Mode Installation you must configure the product XML files and follow 
instructions in the command prompt.

Configuring OFSAAI_InstallConfig.xml
Follow these instructions to configure OFSAA_InstallConfig.xml file:

1. Log in to the system as non-root user.

2. Identify a directory for installation and set the same in the user .profile file as the 
following:

FIC_HOME=< OFSAA Installation Directory >

export FIC_HOME

3. Execute the user .profile.

4. Navigate to the file: OFS_ECM_PACK/OFS_AAI/conf/OFSAAI_InstallConfig.xml

5. Configure the OFSAAI_InstallConfig.xml as mentioned in the section 
Configuring OFSAAI_InstallConfig.xml file. Set the InteractionVariable parameter 
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values manually as mentioned in the table. If a value is not applicable, enter NA 
and ensure that the value is not entered as NULL.

Configuring InstallConfig.xml
To configure the InstallConfig.xml file, follow these steps:

1. Navigate to the file: OFS_ECM_PACK/OFS_ECM/conf/InstallConfig.xml 

2. Enter the details mentioned in the tags (<!-- Start: User input required for silent 
installer.  --> and <!-- End: User input required for silent installer. -->) as 
mentioned in the following table. 

Table 4–1  InstallConfig.xml Parameters

Placeholder Name Significance and Expected Value Mandatory

##OFS_ECM_BASE_
COUNTRY##

ISO country code to use during data ingestion to record 
institution-derived geography risk on parties on transactions that 
are internal to the OFSECM client.

For example: base_country=US

base_country=US

Yes

##OFS_ECM_
DEFAULT_
JURISDICTION##

Jurisdiction to assign the derived entities and derived addresses.

For example:

default_jurisdiction=AMEA

Yes

##OFS_ECM_SMTP_
HOST##

Hostname of the e-mail gateway to be used by the application for 
e-mail notifications.

For example:

smtp_host=mailhost.domain.com

smtp_host=mailhost.domain.com

Yes

##OFS_ECM_NLS_
LENGTH_
SEMANTICS##

##OFS_AML_NLS_LENGTH_SEMANTICS##NLS_LENGTH_
SEMANTICS database variable for executing the DDL scripts.

Applicable values are CHAR/BYTE.

Note: Recommendation to go with CHAR.

Yes

##OFS_ECM_
ANALYST_DATA_
SOURCE##

Name of the Analyst Data source used for Admin Tools 
Configurations. 

For example: Create a data source with name ANALYST

Yes

##OFS_ECM_MINER_
DATA_SOURCE##

Name of the Miner Data source used for Admin Tools 
Configurations

For example: Create a data source with name MINER

Yes

##OFS_ECM_
CONFIGURE_OBIEE##

Mention flag as ‘1” to configure OBIEE URL.

Otherwise mention as ‘0’

Yes

##OFS_ECM_OBIEE_
URL##

In case ##OFS_AML_CONFIGURE_OBIEE_URL## mentioned as 
‘1’…provide the URL in the pattern

Yes
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Running the installer in Silent Mode
To install the OFSAA Infrastructure in Silent mode for java 7 and java 8, follow these 
steps:

1. Navigate to the OFS_ECM_PACK/bin folder.

2. Execute the command in the console:

./setup.sh SILENT 

Completing the installation in Silent Mode
On launching the installer in silent mode, the environment check utility is executed. 
Enter the required information to execute the utility as explained:

Note: The above table item is asked if environment check utility  is 
executed in the standalone mode.

##OFS_ECM_CS_
SOURCE##

##OFS_ECM_CS_
LOADTYPE##</

If the data is from same database then pass the schema name:

For example, Atomic Schema: CS_ATOM

then,

<Variable name="CSSOURCE">CS_ATOM</Variable>

<Variable name="CSLOADTYPE"></Variable>

If the data is from different database then pass the 'DBLINK_
NAME'…..LOADTYPE = DBLINK

For example, 

<Variable name="AMLSOURCE">AMLDBL</Variable>

<Variable name="AMLLOADTYPE">DBLINK</Variable>

Similarly, configure the following placeholders depending on 
your requirement:

##OFS_ECM_AML_SOURCE##

##OFS_ECM_AML_LOADTYPE##

##OFS_ECM_KYC_SOURCE##

##OFS_ECM_KYC_LOADTYPE##

Yes

Table 4–1 (Cont.) InstallConfig.xml Parameters

Placeholder Name Significance and Expected Value Mandatory



Note: 

• Enter the Infrastructure FTP/SFTP password value, when 
prompted at the command prompt to access Product 
Staging/Metadata repository directory in the application server. 

• Enter Always, when prompted to add host key fingerprint.

Installing the OFS ECM Application Pack

4-32   Oracle Financial Services Enterprise Case Management Application Pack                     



Installing the OFS ECM Application Pack

                                Installing OFS ECM Application Pack 4-33 

1. The OFSAAI License Agreement is displayed as shown in the figure:

Figure 4–6 OFSAAI License Agreement Page

2. Enter Y/y to accept the License Agreement. 



Note: SYSADMN and SYSAUTH are the two default OFSAAI 
administrative users created.
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Note: The installation process continues on the console. Do not close 
the console until the installation process is complete. 

Execute .profile from user home directory after the installation is 
completed.
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3. Perform steps mentioned in the Verifying Installation section.

Verifying Installation
Verify the following logs files for more information:

• See the Pack_install.log file in the folder: /OFS_ECM_PACK/logs

• See the OFSAA logs under /OFS_ECM_PACK/OFS_AAI/logs

Note: The warning message, "name is already used by an existing 
object" is displayed after successful Pack on Pack installation. This 
warning can be ignored.

• See the ECM_log files located in the folder: /OFS_ECM_PACK/OFS_ECM/logs for OFS 
ECM Application Pack Installation log file.  

Note: If there are any errors, do not proceed with further installation 
and contact Oracle Support Services.

Mandatory Patches to Install
Install the patches listed in the following table. Refer to the Description column for 
details: 

Patch Number Type Description

27938294 Mandatory one-off patch Refer to the Readme available with the patch for 
further instructions on installing the patch.

28079607 Mandatory one-off patch Refer to the Readme available with the patch for 
further instructions on installing the patch.

28033582 Mandatory compatibility 
patch

Enables you to upgrade selected packs in your 
OFSAA instance to 8.0.6.0.0 and makes the 
existing packs from earlier versions compatible 
with 8.0.6.0.0. Applying this patch resolves 
compatibility issues.

28033370 Mandatory OFSAAI 
Maintenance Level 
one-off

OFSAAI 8.0.6.1.0 ML is regularized with all the 
mandatory patches released on top of 8.0.6.0.0 
release. This ML has the compatibility patch as 
well, which enables you to upgrade selected 
packs in your OFSAA instance to 8.0.6.x.x and 
makes the existing packs from earlier versions 
compatible with 8.0.6.x.x.

1. DMT migration utility is available as part of the installer to migrate the DMT 
metadata (PLC/Data Source/Data Mapping/Data File Mapping) to be persisted 
in tables instead of XML. To identify when to migrate, what/how to migrate, and 
how to handle migration issues, see OFSAA DMT Metadata Migration Guide.

https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAA%20DMT%20Metadata%20Migration%20Guide%208.0.6.0.0.pdf
https://docs.oracle.com/cd/E60058_01/PDF/8.0.6.x/8.0.6.0.0/OFSAA%20DMT%20Metadata%20Migration%20Guide%208.0.6.0.0.pdf


Note: Execute the DMT Migration Utility to manually migrate the 
DMT metadata of the Applications which are not upgraded to 
8.0.6.0.0. 
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2. Install the consolidated one-off patch 28045149. Refer to the Readme available 
with the patch for further instructions on installing the patch.

3. Extract and apply the patch 28398331. Refer to the Readme.txt file packaged with 
the patch for details on how to apply the patch.   
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5Upgrading the OFS ECM Applications Pack

Release 8.0.6.0.0 of OFS ECM is not fully backward compatible with earlier versions of 
OFSAA applications. You can either upgrade all of your applications from existing 
8.0.x versions to 8.0.6.0.0 version or choose to upgrade only selective application packs 
to v8.0.6.0.0. In the case of the latter, you must also apply the forthcoming 
compatibility patches for the required application packs, so that the remaining 
application-packs can continue to be at their pre-8.0.6.0.0 versions.

This chapter includes the following topics:

• Prerequisites

• Upgrading from OFS ECM 8.0.5.0.0 to OFS ECM 8.0.6.0.0

• Post Installation Steps

• Upgrading BD 8.0.4.0.0 to ECM 8.0.6.0.0

Prerequisites
Follow these steps before proceeding with the upgrade process:

Note:

• If you are upgrading from OFS ECM 8.0.5.0.0 to OFS ECM 
8.0.6.0.0, then you should first apply the patch 28919727 (OFS 
ECM 8.0.5.0.22) from https://support.oracle.com and follow the 
instructions mentioned in Readme. Take complete backup of the 
environment before upgrade 

• Ensure to take the backup of File System (FIC_
HOME/FTPSHARE), Atomic schema, and Config schema before 
performing upgrade.

• Delete records from table “PR2_FIRERUN_FILTER”  in Config 
schema before running upgrade script.

• Ensure that the dispatcher is not running. If the dispatcher is 
running, stop and then start the upgrading process.

• Ensure that you end all the batches before you start the upgrade 
process.

• Ensure that you run the END_MANTAS_BATCH before starting 
the upgrade.
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Upgrading from OFS ECM 8.0.5.0.0 to OFS ECM 8.0.6.0.0
Perform the following steps before upgrade:

1. Execute below scripts 

delete from pr2_object_tl a

where a.v_object_id in ('1533192888956')

/ 

delete from pr2_object_trace b

where b.v_object_id in ('1533192888956')

/

delete from ofsa_object_application_map c

where c.md_code in ('OCS_FCC_EVENT_ENTITY_MAP_ACCT');

/

delete from pr2_process_task_precedence d

where d.v_process_id in ('1533192888956')

/

delete from pr2_process_task_parameter e

where e.v_process_id in ('1533192888956')

/

delete from pr2_process_task f

where f.v_process_id in ('1533192888956')

/

delete from pr2_process_b g

where g.v_process_name = 'OCS_FCC_EVENT_ENTITY_MAP_ACCT'  AND 
g.n_process_version = 0

/

Note: In below script, ##INFODOM## needs to be changed 
appropriately according to the environment.

INSERT INTO INFODOM_PATCHES

  (V_INFODOM,

   N_SERIAL_NO,

   V_PATCH_NAME,

   V_APP_ID,

   V_REMARKS,

   D_APPLIED_DATE)

  SELECT '##INFODOM##',

         (SELECT MAX(N_SERIAL_NO) + 1 FROM INFODOM_PATCHES),
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         '8.0.6.0.0',

         'NGECM',

         'Financial Services Enterprise Case Management',

         SYSDATE

         FROM DUAL

/

 

2. Take the backup of below tables and truncate them: 

FCC_TRANSACTION_PIVOT_TRANSFRM

FCC_TRXN_PIVOT_TRANSFORM_DS

FCC_CLIENTBANKSMRY_LOOKUP   

FCC_WIRE_TRXN_INSTN_LEG_EVNT     

FCC_ACCT_ID_INSTN_ID_MAP

FCC_BACK_OFFICE_TRXN

FCC_CUST_ACCT_ROLE

FCC_WATCH_LIST

FCC_WIRE_TRXN_INSTN_LEG

FCC_ACCT_ATM_SMRY_DAILY_EVNT

FCC_HH_SMRY_MNTH_EVNT

FCC_CUST_SMRY_DAILY

Refer to the following instructions to download, extract, install, and configure this 
release:

1. Download and copy 28183877_GENERIC.zip to the local host. To download and 
copy the OFS ECM Applications Pack v8.0.6.0.0 archive file, see Downloading and 
Copying the OFS ECM Application Pack Installer section.

Note: The archive files are different for every operating system like 
AIX, Solaris, and RHEL/Oracle Linux.

2. Navigate to the directory and extract the contents of the folder.

3. Execute the below mentioned sql scripts in ECM 805 Config Schema Sequentially

Backup_Table_Creation.sql

Temp_Table_Creation.sql

pr2_process_b_806.sql

pr2_run_b_806.sql

Process_Update_806.sql

4. Download the ECM 806 Installer from MOS and unzip the same.

5. Navigate to OFS_ECM_PACK and grant execute (755) permission for all 
executables
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$ chmod 755 *

6. Modify PatchConfig.xml under OFS_ECM_PACK/OFS_
ECM/conf/PatchConfig.xml with appropriate values as follows:

Placeholder Name Significance and Expected Value Mandatory

##OFS_ECM_SAVE_
METADATA##

This attribute is used by the installer to decide whether to execute 
hierarchy Resave. Applicable value is ALL.

Yes

##EXECUTE_PRE_
AND_POST_
SCRIPTS##

This flag indicates if certain scripts need to be executed just before 
and just after the datamodel upload Applicable value is 1.

Yes

##OFS_ECM_
ANALYST_DATA_
SOURCE##

Name of the Analyst Data source used for Admin Tools 
Configurations. 

For example: Create a data source with name ANALYST

Yes

##OFS_ECM_MINER_
DATA_SOURCE##

Name of the Miner Data source used for Admin Tools 
Configurations

For example: Create a data source with name MINER

Yes

##BASE_COUNTRY## ISO country code to use during data ingestion to record 
institution-derived  geography risk on parties on transactions that 
are internal to the OFSECM client.

For example: base_country=US

base_country=US

Yes

##DEFAULT_
JURISDICTION##

Jurisdiction to assign the derived entities and derived addresses.

For example:

default_jurisdiction=AMEA

Yes

##TNS_ADMIN## This attribute refers to the path where TNSNAMES.ORA is 
placed.

For example, /scratch/ofsaaapp

Yes

##BIG_DATA_
ENABLE##

Placeholder to enable Big Data. Enter FALSE. Yes

##OFS_ECM_DATA_
CM_TBSP##

This attribute refers to the Data Tablespace values present in 
OFS_ECM_SCHEMA_OUTPUT.xml which was generated at the 
time of installation

Yes

##OFS_ECM_IDX_CM_
TBSP##

This attribute refers to the Index Tablespace values present in 
OFS_ECM_SCHEMA_OUTPUT.xml which was generated at the 
time of installation

Yes

7. Navigate to the OFS_ECM_PACK/bin folder.

8. Execute setup.sh file using the following command:

$./setup.sh SILENT

9. Check whether upgrade is successful by referring the logs. Contact Oracle Support 
in case of any errors.

Below mentioned 7 types of unique constraint violation warnings and 1 fatal error 
in OFS_ECM_LOG.log can be ignored.

 Warn:ORA-00001: unique constraint (BDATOM.PK_690) violated

Warn:ORA-00001: unique constraint (BDATOM.PK_1889) violated

Warn:ORA-00001: unique constraint (BDATOM.PK_FCC_DM_DEFINITION) 
violated
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procedure_COMPILE_IR.txt does not exist

Post Installation Steps
Follow these steps:

1. Execute the below mentioned sql scripts in ECM 806 Atomic Schema Sequentially

ACTIONVALIDITYCHECK.sql

CASEVALIDITYCHECK.sql

2. Execute the below mentioned sql script in ECM 806 Config Schema

Config_Insert.sql

3. Apply AAI one-off, which is a mandatory patch that needs to be applied once 
upgradation is done

Bug 27938294 - consolidated one-off for 8.0.6.0.0 release

4. If the Weblogic Version is 12.1.3.0.0, then follow the below mentioned steps else 
skip to Step 5.

 a. Navigate to $FIC_WEB_HOME/webroot/WEB-INF/web.xml

b. Search for <servlet-name>FCCMOBService</servlet-name> and 
comment the line tag <load-on-startup>1</load-on-startup> as 
mentioned below

<servlet>

<servlet-name>FCCMOBService</servlet-name>

<servlet-class>com.sun.jersey.spi.container.servlet.Servle
tContainer</servlet-class>

<init-param>

<param-name>com.sun.jersey.config.property.packages</param
-name>

<param-value>com.ofs.aai.onboard</param-value>

</init-param>

 <init-param>

<param-name>com.sun.jersey.config.property.resourceConfigC
lass</param-name>

<param-value>com.sun.jersey.api.core.ClassNamesResourceCon
fig</param-value>

 </init-param>

<init-param>

<param-name>com.sun.jersey.config.property.classnames</par
am-name>

<param-value>com.ofs.aai.onboard.controller.OnboardingCont
roller</param-value>

</init-param>

<!--<load-on-startup>1</load-on-startup>-->
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c. Re-create ear/war on application server and extract the same on the web 
application server

d. Navigate to $Extracted_Path/WEB-INF/weblogic.xml on web 
application server

e. Add the below mentioned xml tags inside 
<prefer-application-packages>

<package-name>com.sun.jersey.*</package-name>

<package-name>org.glassfish.jersey.*</package-name>

<package-name>org.glassfish.hk2.*</package-name>

<package-name>org.jvnet.hk2.*</package-name>

<package-name>jersey.repackaged.org.objectweb.asm.*</packa
ge-name>

<package-name>com.sun.research.ws.wadl.*</package-name>

<package-name>com.sun.ws.rs.ext.*</package-name>

<package-name>org.codehaus.jackson.*</package-name>

<package-name>com.fasterxml.jackson.*</package-name>

<package-name>org.codehaus.jettison.*</package-name>

<package-name>javax.ws.rs.*</package-name>

<package-name>org.objectweb.asm.*</package-name>            
<package-name>antlr.*</package-name>

5. Redeploy new ear/war on the web application server after modiying the 
weblogic.xml.

6. Restart the OFSAA services.

Upgrading BD 8.0.4.0.0 to ECM 8.0.6.0.0
You can upgrade BD 8.0.4.0.0 to ECM 8.0.6.0.0 in following order:

BD804->BD806->ECM806

1. Before upgrading to BD 8.0.6.0.0, follow these steps:

a. Execute below query in atomic schema:

update rev_tables_b g set g.version = 80414 where g.version = 
804014

b. Navigate to $FIC_HOME/ftpshare/FCCMINFO/erwin/fipxml. 

c. Open FCCMINFO_DATABASE.XML, search 804014 and replace all with 80414.

2. Upgrade to BD 8.0.6.0.0 by updating only PatchConfig.xml. For more 
information, see chapter 5 of BD 8.0.6.0.0 Installation and Configuration guide on 
OHC.

3. Shutdown the servers.

4. Run schema creator for ECM 806.

5. Execute the below insert scripts in config schema:

insert into AAI_APP_B (V_APP_ID, V_VERSION, V_COMMENTS, V_MDB_APP_
ID, V_ACCESS_CODE, F_IS_SEEDED, F_IS_CLOUD_ENABLED)

https://docs.oracle.com/cd/E91253_01/install.htm
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values ('OFS_NGECM', '8.0.4.0.0', null, 'OFS_NGECM', 'OFSNGECM', 
'Y', 'N'); 

insert into AAI_APP_PACK_B (V_APP_PACK_ID, V_VERSION, V_COMMENTS, 
V_APP_PACK_HOME)

values ('OFS_ECM_PACK', '8.0.4.0.0', null, null); 

insert into APP_PACK_APP_MAPPING_MASTER (V_APP_PACK_ID, V_APP_ID, 
PREREQ_APP_ID, COMMENTS)

values ('OFS_ECM_PACK', 'OFS_NGECM', 'OFS_AAI', null); 

insert into AAI_APP_TL (V_APP_ID, V_APP_NAME, V_APP_DESC, V_LOCALE_
CODE)

values ('OFS_NGECM', 'Financial Services Enterprise Case 
Management', 'Application for Enterprise Case Management', 'en_
US');

Commit;

6. Run the ECM 806 installer and deploy.

7. Update OFS_NGECM version in AAI_APP_B to 8.0.6.0.0 under config schema.

8. Run the below insert scripts under config schema:

insert into CSSMS_FUNCTION_MAST (V_FUNCTION_CODE, V_FUNCTION_NAME, 
V_FUNCTION_DESC, V_FUNCTION_TYPE, V_CREATED_BY, D_CREATED_DATE, V_
LAST_MODIFIED_BY, D_LAST_MODIFIED_DATE, FUNCTION_KEY, FUNCTION_
DESC_KEY)

values ('OFSNGECM', 'Function for common ECM Menu', 'Function for 
common ECM Menu', 'USER', 'SYSADMN', '17-DEC-12', 'SYSADMN', 
'17-DEC-12', null, null);

insert into CSSMS_ROLE_FUNCTION_MAP (V_ROLE_CODE, V_FUNCTION_CODE)

values ('CMANALYST1', 'OFSNGECM');

insert into CSSMS_ROLE_FUNCTION_MAP (V_ROLE_CODE, V_FUNCTION_CODE)

values ('CMANALYST2', 'OFSNGECM');

insert into CSSMS_ROLE_FUNCTION_MAP (V_ROLE_CODE, V_FUNCTION_CODE)

values ('CMEXAUDITR', 'OFSNGECM');

insert into CSSMS_ROLE_FUNCTION_MAP (V_ROLE_CODE, V_FUNCTION_CODE)

values ('CMEXCUTIVE', 'OFSNGECM');

insert into CSSMS_ROLE_FUNCTION_MAP (V_ROLE_CODE, V_FUNCTION_CODE)

values ('CMINAUDITR', 'OFSNGECM');

insert into CSSMS_ROLE_FUNCTION_MAP (V_ROLE_CODE, V_FUNCTION_CODE)

values ('CMINITIATR', 'OFSNGECM');

insert into CSSMS_ROLE_FUNCTION_MAP (V_ROLE_CODE, V_FUNCTION_CODE)

values ('CMMANADMN', 'OFSNGECM');

insert into CSSMS_ROLE_FUNCTION_MAP (V_ROLE_CODE, V_FUNCTION_CODE)

values ('CMSUPRVISR', 'OFSNGECM');

insert into CSSMS_ROLE_FUNCTION_MAP (V_ROLE_CODE, V_FUNCTION_CODE)

values ('CMVIEWER', 'OFSNGECM');

commit;                  

9.  Restart the servers.
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10. Navigate to $FIC_HOME/utility/AppPckMastSynch/bin/AppPckMastSynch.sh. 
Replace $PACK_NAME with OFS_ECM_PACK and execute the same.

11. Execute the below mentioned queries sequentially to find the difference between 
the pack and their respective tables and add those missing records in the 
respective tables:

select t.v_group_code,t.v_role_code from CSSMS_GROUP_ROLE_MAP_PACK  
t where v_app_id = 'OFS_NGECM'

minus 

select tt.v_group_code,tt.v_role_code from CSSMS_GROUP_ROLE_MAP tt;

select y.v_function_code,y.v_function_name from cssms_function_
mast_pack y where v_app_id = 'OFS_NGECM'

minus

select o.v_function_code,o.v_function_name from cssms_function_mast 
o;

select folder_name,v_function_code from cssms_folder_function_pack 
where v_app_id = 'OFS_NGECM'

minus

select folder_name,v_function_code from cssms_folder_function_map;

select v_group_code,v_group_code from cssms_group_mast_pack where 
v_app_id = 'OFS_NGECM'

minus

select v_group_code,v_group_code from cssms_group_mast;

select v_group_code,V_ROLE_CODE from cssms_grp_role_map_unauth_pack 
where v_app_id = 'OFS_NGECM'

minus

select v_group_code,v_role_code from cssms_group_role_map_unauth;

select v_role_code,v_function_code from cssms_role_function_map_
pack where v_app_id = 'OFS_NGECM'

minus

select v_role_code,v_function_code from cssms_role_function_map;

select v_group_code from cssms_usr_group_dsn_map_pack where v_app_
id = 'OFS_NGECM'

minus

select v_group_code from cssms_usr_group_dsn_seg_map;

select * from cssms_usr_group_dsn_map_pack

minus

select * from cssms_usr_group_dsn_map_unauth;
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1Post Installation Configuration

On successful installation of the Oracle Financial Services Enterprise Case 
Management Application Pack, see the following post installation sections:

This chapter includes the following sections:

• Deploying OFS ECM Application Pack 

• Deploying Analytic Reports and Threshold Analyzer

• Configuring Resource Reference

• Configuring Web application server

• Configurations for Java 8

Note: Ensure to clear the application cache prior to the deployment of 

Applications Pack Web Archive. This is applicable to all Web servers 

(WebSphere, WebLogic, and Tomcat). For more information, see the Clearing 
Application Cache section.

Deploying OFS ECM Application Pack 
To create and deploy the Applications Pack web archive, follow these steps:

1. Navigate to the $FIC_WEB_HOME directory.

2. Execute the command:

./ant.sh

3. This will trigger the creation of EAR/WAR file - <contextname>.<extn>. Here 
<contextname> is the context name given during installation.

Note: Creating ear/war files are done by the installer automatically. If 
the files are not created, user can execute these steps.

4. On completion of the EAR/WAR files creation, the "BUILD SUCCESSFUL" and 
"Time Taken" message is displayed and you are returned to the prompt.

5. The EAR/WAR file - <contextname>.<extn> - is created under "$FIC_WEB_HOME" 
directory.



Note: This process overwrites any existing version of EAR/WAR file in the 
path. If the web application server is Apache Tomcat, the file created 
would be <contextname>.war.

Deploying Analytic Reports and Threshold Analyzer
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6. Deploy the generated EAR/WAR file on to the web application server. For 
detailed information, see Deploying EAR/WAR File.

Deploying Analytic Reports and Threshold Analyzer
This section explains how to deploy Analytics on Oracle Business Intelligence 
Enterprise Edition (OBIEE) and integrate Analytic Reports and Threshold Analyzer in 
the OFSECM UI.

This section includes the following topics:

• Installing OBIEE Server

• Installing OBIEE Windows Administration Client

• Disabling the Cache Feature in OBIEE Server

• Change Default Repository Password

• Configuring OBIEE Connection Pool

• Deploying OFS ECM Report Analytics

• Creating Application Role (Only for OBIEE 11.1.1.9.0)

• Configuring TreeMap Graph

• Disable Single Sign On

• Accessing Reports through OFS ECM Application

Installing OBIEE Server 
To install the Oracle Business Intelligence Enterprise Edition (OBIEE) server, see 
Oracle Business Intelligence Enterprise Edition 12.2.1.3.0. After installation, get the 
Enterprise Manager URL, Username, Password, and OBIEE installed directory from 
the system administrator. For OBIEE server 11.1.1.9.0, see Oracle® Business 
Intelligence Applications Installation Guide 11g Release 1 (11.1.1.9.0).

Installing OBIEE Windows Administration Client
To install the OBIEE repository administration client for Windows machine, see Oracle 
Business Intelligence Enterprise Edition 12.2.1.3.0. For OBIEE server 11.1.1.9.0, see 
Oracle® Business Intelligence Applications Installation Guide 11g Release 1 
(11.1.1.9.0).

The OBIEE repository administration client can be downloaded from running OBIEE 
setup from the following URL:

<protocol>://<OBIEE Server Name>:<OBIEE Analytics port>/analytics 

From LHS menu, click Download BI Desktop tools under the Most Popular section.

https://docs.oracle.com/middleware/12213/biee/index.html
https://docs.oracle.com/middleware/1221/core/BIEIG/GUID-E6545BC6-D0BF-4521-B3E7-160ABBBB6CD3.htm#BIEIG-GUID-E6545BC6-D0BF-4521-B3E7-160ABBBB6CD3
https://docs.oracle.com/middleware/1221/core/BIEIG/GUID-E6545BC6-D0BF-4521-B3E7-160ABBBB6CD3.htm#BIEIG-GUID-E6545BC6-D0BF-4521-B3E7-160ABBBB6CD3
https://docs.oracle.com/middleware/12213/biee/index.html
https://docs.oracle.com/middleware/12213/biee/index.html
https://docs.oracle.com/cd/E53672_01/doc.111191/e53673.pdf
https://docs.oracle.com/cd/E53672_01/doc.111191/e53673.pdf
https://docs.oracle.com/cd/E53672_01/doc.111191/e53673.pdf
https://docs.oracle.com/cd/E53672_01/doc.111191/e53673.pdf
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Disabling the Cache Feature in OBIEE Server

OBIEE 12.2.1.3.0:
Login to the Enterprise Manager and perform the following steps:

1. Click the Target Navigation icon  

2. Expand the Business Intelligence section and then click biinstance.

3. Click the Configuration tab.

4. Click the Lock icon   and then click Lock & Edit to enable the Cache Enabled 
check box.

5. Under the Enable BI Server Cache section, deselect the Cache Enabled check box 
and make the required changes

6. Click the Lock icon    and then click Release Configuration to save the 
changes made.

Figure 1–1 Disabling the Cache Feature in OBIEE Server (12.2.1.3.0)

OBIEE 11.1.1.9.0:
Login to the Enterprise Manager and perform the following steps:

1. Expand the Business Intelligence section and then click coreapplication.

2. Click the Capacity Management tab. 

3. Under that tab, click the Performance tab.

4. Click Lock and Edit Configuration to disable the Cache feature. 

5. Clear the Cache Enabled check box.

6. Click Apply.

7. Click Activate Changes. The confirmation window is displayed.

8. Click Close.
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Figure 1–2 Disabling the Cache Feature in OBIEE Server (11.1.1.9.0)

Change Default Repository Password

OBIEE 12.2.1.3.0:
Copy FCCM806.rpd from $FIC_HOME/OBIEE/Repository to the Windows 
machine where the OBIEE Windows administration client is installed. 

To change the default password for the repository follow these steps:

1. Open the Repository using the OBIEE Windows administration client from 
Windows machine. From the File menu, select Open and click Offline. Browse to 
the Repository on Windows machine. The Oracle BI Administration Tool - 
FCCM806.rpd windows is displayed.

2. Enter default Repository password: FCCM$806

To change the default password, follow these steps:

1. From File menu, choose Change Password.

2. Enter the new password and click OK.

OBIEE 11.1.1.9.0:
Copy FCCM806.rpd from $FIC_HOME/OBIEE/Repository to the Windows machine 
where the OBIEE Windows administration client is installed.

To change the default password for the repository, follow these steps:

1. Open the Repository using the OBIEE Windows administration client from 
Windows machine. From the File menu, select Open and click Offline. Browse to 
the Repository on Windows machine. The Oracle BI Administration Tool - 
FCCM806.rpd windows is displayed.

2. Enter default Repository password: FCCM$806
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To change the default password, follow these steps:

1. From File menu, choose Change Password.

2. Enter the new password and click OK.

Configuring OBIEE Connection Pool

OBIEE 12.2.1.3.0:
To configure the Connection Pool of the repository, follow these steps:

1. Open the same Repository (as in the previous step) on the Windows machine. The 
Oracle BI Administration Tool - FCCM806.rpd windows is displayed. 

2. Expand the FCCM folder in the Physical section.

3. Double-click Connection Pool to open the Connection Pool Properties window.

4. Enter the following in the Data Source Name text box of the Connection Pool 
Properties window after modifying <Database Server Host Name> and <Database 
Name> Data Source Name = 
(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=<Database Server 
HostName>)(PORT=1521))(CONNECT_DATA=(SERVER=DEDICATED) 
(SERVICE_NAME=<Database Name>)))

5. Enter the Atomic Schema user in the User name text box.

6. Enter the Atomic Schema user password in the Password text box.

7. Click OK.

8. Expand the folder and test connection for any one table name by Right Click > 
view data.

9. Perform similar changes in the Connection Pools for all remaining folders in the 
Physical Layer by providing the following schema details for all Connection Pools:

• KYC Analytics >Atomic Schema

Note: Initial block and connection pool: both should point towards 
the atomic schema.

• UIC_73 > CaseMng connection pool ->Atomic Schema

• UIC_73 > Security connection pool->Atomic Schema

• TA > Atomic Schema 

• CTRBI-> Atomic Schema

• ORCL->Atomic Schema

• FCCM > Atomic Schema

10. Select Save option from the File menu. The following message is displayed: Do 
you want to check global consistency?.

11. Click Yes. The following message is displayed: Consistency check didn’t find any 
errors, warning or best practices violations. 

12. Click OK.



Deploying Analytic Reports and Threshold Analyzer

1-6 Oracle Financial Services Enterprise Case Management Application Pack                     

OBIEE 11.1.1.9.0:
To configure the Connection Pool of the repository, follow these steps:

1. Open the same Repository (as in the previous step) on the Windows machine. The 
Oracle BI Administration Tool - FCCM806.rpd windows is displayed.

2. Expand the FCCM folder in the Physical section.

3. Double-click Connection Pool to open the Connection Pool Properties window.

4. Enter the following in the Data Source Name text box of the Connection 
PoolProperties window after modifying <Database Server Host Name> and 
<Database Name> Data Source Name 
=(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=<Database Server 
HostName>)(PORT=1521))(CONNECT_DATA=(SERVER=DEDICATED) 
(SERVICE_NAME=<Database Name>)))

5. Enter the Atomic Schema user in the User name text box.

6. Enter the Atomic Schema user password in the Password text box.

7. Click OK.

8. Expand the folder and test connection for any one table name by Right Click > 
View data.

9.  Perform similar changes in the Connection Pools for all remaining folders in the 
Physical Layer by providing the following schema details for all Connection Pools:

• KYC1.1DEV-179 >Atomic Schema

Note: Initial block and connection pool: both should point towards 
the atomic schema.

• UIC_73 > CaseMng connection pool ->Atomic Schema

• UIC_73 > Security connection pool->Atomic Schema

• TA > Atomic Schema

• CTRBI-> Atomic Schema

• ORCL->Atomic Schema

10. Select Save option from the File menu. The following message is displayed: Do 
you want to check global consistency?.

11. Click Yes. The following message is displayed: Consistency check didn’t find any 
errors, warning or best practices violations.

12. Click OK

Deploying OFS ECM Report Analytics

OBIEE 12.2.1.3.0:
To deploy Analytic Reports, follow these steps:

1. Change the value in Nqsconfig.ini file located at <FMW_HOME>/user_
projects/domains/bi/config/fmwconfig/biconfig/OBIS

From EVALUATE_SUPPORT_LEVEL = 0;
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To EVALUATE_SUPPORT_LEVEL =2;

2. Copy the FCCM806.rpd file in the working directory.

3. Navigate to the working directory and execute the following script: 

<obiee_home>/user_
projects/domains/bi/bitools/bin/datamodel.sh uploadrpd -I 
FCCM806.rpd -SI ssi -U <user> -P <password>

4. Restart OBIEE server from Enterprise Manager by following these steps: (see 
figure Restarting OBIEE Server)

5. Click the Target Navigation icon  

6. Expand the Business Intelligence section and then click biinstance.

7. Click the Availability tab.

8. Click Stop All.

9. Copy the file FCCM_ANALYTICS.bar  in the same working directory and execute 
the following script: 

<obiee_home>/oracle_common/common/bin/wlst.sh

10. A new prompt wls:/offline> is displayed. Execute the following script: 

importServiceInstance('<obiee_home>/user_
projects/domains/bi','ssi','<Working directory>/FCCM_
ANALYTICS.bar',importRpd=false,importWebcat=true,importJazn=t
rue,includeCredentials=None)

11. Click Start All.

Figure 1–3 Restarting OBIEE Server

OBIEE 11.1.1.9.0:
To deploy Analytic Reports, follow these steps:
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1. Stop Oracle Process Manager and Notification Server (OPMN) services by 
executing the following command from <OBIEE Installed 
Directory>/instances/instance1/bin

./opmnctl stopall

2. Change the value in Nqsconfig.ini file located at <FMW_
HOME>/instances/instance1/config/OracleBIServerComponent/core
application_obis1/ directory

From EVALUATE_SUPPORT_LEVEL = 0;

To EVALUATE_SUPPORT_LEVEL=2;

3. Login into Enterprise Manager, click the Business Intelligence folder on the left 
hand side and select coreapplication, and then click the Deployment tab.

4. Click the Repository tab.

5. Click the Lock and Edit Configuration tab. The confirmation window is 
displayed. 

6. Click Close.

7. In the Upload BI Server Repository Section, browse the repository file from the 
Windows machine.

8. Enter the new repository password in the Repository Password and Confirm 
Password text boxes.

9. In BI Presentation Catalog section, provide the Catalog Location as <OBIEE 
Installed 
Directory>/instances/instance1/bifoundation/OracleBIPresentat
ionServicesComponent/coreapplication_
obips1/catalog/ANALYTICS_REPORT

10. Click Apply.

11. Click Activate Changes. The confirmation window is displayed.

12. Click Close.

13. Modify <obiee_home>/user_
projects/domains/bi/config/fmwconfig/biconfig/OBIPS/instanceconfig.xml as 
the following

From

<Security>

<!--This Configuration setting is managed by Oracle Enterprise Manager 
Fusion Middleware Control-->

<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>

</Security>

To

<Security>

<!--This Configuration setting is managed by Oracle Enterprise Manager 
Fusion Middleware Control-->

<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>

<InIFrameRenderingMode>allow</InIFrameRenderingMode>
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</Security>

14. Open the Catalog Manager and access analytics URL as follows:

   http://<host>:<port>/analytics/saw.dll

15. Expand Catalog Root in LHS menu. Expand Shared Folders. Delete all the 
contents under Shared Folders.

16. Navigate to File->Unarchive->Browse. Select FCCM_ANALYTICS.catalog from 
window machine. Click OK.

Creating Application Role (Only for OBIEE 11.1.1.9.0)
This section is applicable only for OBIEE 11.1.1.9.0. Follow these steps for creating 
Application Role:

1. Login to OBIEE installed command prompt.

• Change the directory cd <<OBIEE Installation Path>>/Oracle_
BI1/common/bin

For example, cd /scratch/Obiee11g/Oracle_BI1/common/bin 

2. Copy CreateAppRoles.py to the aforementioned path and execute the 
following command:

./wlst.sh “CreateAppRoles.py” <<admin user>> <<admin 
password>> t3://<<server ip or server host>>:<<console port>>

For example, ./wlst.sh "CreateAppRoles.py" WebLogic WebLogic123 
t3://ofss232465.in.oracle.com:7001

3. Once the role has been created, remove the file CreateAppRoles.py. 

Configuring TreeMap Graph
To configure the TreeMap Graph, follow these steps:

1. Login to OBIEE server.

2. Navigate to OBIEE Home. 

Note: OBIEE Home is the OBIEE installed path.

3. Execute the following command:

cd  <obiee_home>

4. Execute the following command to find the available treemap-canvas.js:

find -name treemap-canvas.js

Four different files, all named treemap-canvas.js are displayed. 

5. Back up these four files.

6. Edit window.top.console to console in these four files and save.

Disable Single Sign On
Execute the following to disable Single Sign On:

<obiee_Home>/oracle_common/common/bin/wlst.sh
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disableBISingleSignOn('<obiee_Home>/user_projects/domains/bi')

Accessing Reports through OFS ECM Application
For more information on Accessing Reports, see the Alert Management User Guide.

Configuring Resource Reference
This section describes the details for configuring the resource reference in WebSphere, 
WebLogic, and Tomcat Application Servers. For detailed information, see Configuring 
Resource Reference.

Configuring Web application server
This section describes the details to configure the different web application servers for 
OFSAA Infrastructure deployment namely, IBM WebSphere, Oracle WebLogic, and 
Apache Tomcat Servers. For detailed information, see Configuring Web application 
servers.

Configurations for Java 8
Follow these steps to extract and apply the patch.

1. Follow the instructions given in the Readme to apply the patch.

2. If the Oracle Database version is 12c, copy ojdbc7.jar from $ORACLE_
HOME/jdbc/lib to the following locations:

• $FIC_HOME/utility/OFSAAGenerateRepository/lib/

• $FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/

• $FIC_HOME/ficdb/lib/

• $FIC_HOME/ficapp/icc/lib/

• $FIC_HOME/ficapp/common/FICServer/lib/

• $FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/

• $FIC_HOME/ficweb/webroot/WEB-INF/lib/

Note: If ojdbc6.jar is already present in any of the aforementioned 
folders, you need to remove it.

3. If the Oracle Database version is 11g, copy ojdbc6.jar from $ORACLE_
HOME/jdbc/lib to the following locations:

• $FIC_HOME/utility/OFSAAGenerateRepository/lib/

• $FIC_HOME/realtime_processing/WebContent/WEB-INF/lib/

• $FIC_HOME/ficdb/lib/

• $FIC_HOME/ficapp/icc/lib/

• $FIC_HOME/ficapp/common/FICServer/lib/

• $FIC_HOME/FMStandalone/FormsManager/WEB-INF/lib/

• $FIC_HOME/ficweb/webroot/WEB-INF/lib/

http://docs.oracle.com/cd/E60570_01/homepage.htm
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2Post Deployment Configuration

This section provides detailed information about the Post Deployment Configurations. 
lists the various configurations to be completed before you use the OFSAA 
Applications. 

• Creating Application Users

• Mapping Application User(s) to User Group

• Performing Administrative activities for OFS ECM

• Performing Configurations for OFS ECM

• Setting OFS ECM UI as Home Page of OFSAAI for a Particular User

Creating Application Users
Create the application users in the OFSAA setup prior to use.

Note: This step may not be required if you have already setup users 
in the OFSAA setup.

For more information see user creation section from the Oracle 
Financial Services Analytical Applications Infrastructure User Guide.

Mapping Application User(s) to User Group 

Starting the OFSAA 8.0 release, with installation of every OFSAA Applications Pack, 
pre-configured application user groups are seeded. These user groups are unique to 
every OFSAA Applications Pack and have application roles pre-configured.

User Groups seeded with the OFS ECM Application Pack are listed in Table 2—1.

Table 2–1 Seeded User Groups

Name Description

Modeler Group User mapped to this group have access to all the menu items for 
Enterprise modeling, but do not have authorization rights for 
sandbox population, model deployment and modeling 
technique authorization.

Modeling Administrator 
Group

User mapped to this group have access to all the menu items for 
Enterprise modeling and authorization rights for sandbox 
population, model deployment and modeling technique 
authorization.

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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Map the application user(s) to the respective Application User Group(s) and 
subsequently authorize the entitlements by logging in as SYSAUTH (System 
Authorizer) user.

Note: In case the User Groups related to OFS ECM are not mapped, 
ensure that you map it accordingly in OBIEE catalog for Statement 
View report.

In order to view the MIS reports in ECM Standalone, map the Case 
Analyst2 User Group in the Application.

For more information, see Mapping/Unmapping Users section from the Oracle 
Financial Services Analytical Applications Infrastructure User Guide.

Performing Administrative activities for OFS ECM
Access the OFS ECM UI as ECMAP Administrator and perform all the steps given in 
the following sections of the Administration Guide.

• About Configuring Access Control Metadata

• Mapping Users To Access Control Metadata

• About Scenario Manager Login Accounts

• About Changing Passwords for System Accounts

• About Configuring File Type Extensions

Inline Processing Admin 
Group

User mapped to this group have access to all the menu items 
and actions for Inline Processing module.

Business Administrator User mapped to this group have access to all the menu items 
and actions for advanced operations of metadata objects.

Business Authorizer User mapped to this group have access to all the menu items 
and actions for authorization of changes to metadata objects.

Business Owner User mapped to this group have access to all the menu items 
and actions to read and write metadata objects

Business User User mapped to this group have access to all the menu items 
and actions to access and read metadata objects.

Identity Administrator User mapped to this group have access to all the menu items to 
manage User entitlements, User Group Entitlements and Access 
Management configurations.

Identity Authorizer User mapped to this group have access to all the menu items to 
authorize User entitlements, User Group Entitlements and 
Access Management configurations.

System Administrator User mapped to this group have access to all menu items to 
manage the setup configurations.

Object Administrator User mapped to this group have access to all menu items to 
manage object migration and metadata traceability using 
metadata browser.

Guest Group User mapped to this group have access to certain menu items 
with view only access privileges.

Table 2–1 Seeded User Groups

Name Description

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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• About Configuring File Size

• About Configuring Status To User Role Table

Note: Once Security Attributes mapping is completed for the 
ECMAP Administrator user, restart OFSAAI and Web Application 
servers before accessing the Admin Tools application.

Performing Configurations for OFS ECM
Access the OFS ECM UI as ECMAP Administrator and perform all the steps given in 
the following sections of Configuration Guide.

• Configuring the Base Time Zone

• Configuring the Default Currency Code

• Configuring E-mail

• Configuring XML Export

• Configuring Case Correlation Owner

• Configuring Default Case Owner

Setting OFS ECM UI as Home Page of OFSAAI for a 
Particular User 

To set OFS ECM UI as home page of OFSAAI, follow these steps:

1. Log in as an ECM Administrator/Supervisor user.

2. Navigate to Home page.

3. Click on logged in user name in the right top corner.

4. Click Preferences and a new page is displayed.

5. Select Enterprise Case Management as your default page and click Save.
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AConfiguring Web server

This section covers the following topics:

• Configuring Web server

• Configuring Web application servers

Configuring Web server
This step assumes the installation of a Web server exists as per the prerequisites.

See the product specific installation guide to install and configure the Web server. If an 
installation already exists, skip and proceed to the next step.

Note: 

• Make a note of the IP Address/ Hostname and Port of the web 
server. This information is required during the installation 
process.

• Add umask 0027 in the .profile  of the UNIX account which manages the 
WEB server to ensure restricted access permissions

• See Oracle Financial Services Analytical Applications 
Infrastructure Security Guide mentioned in the Related Documents 
section for additional information on securely configuring your 
Web server.

Configuring Web application servers
This step assumes an installation of a web application server exists as per the 
prerequisites. To configure the Web application server for OFSAA Deployment see the 
following sections. 

This section includes the following topics:

• Configuring WebSphere Application Server for Application Deployment

• Configuring WebLogic for Application Deployment

• Configuring Apache Tomcat Server for Application Deployment



Note: 

• Make a note of the IP Address/ Hostname and Port of the web 
application server. This information is required during the 
installation process (required if Web server is not configured).

• See OFSAA Secure Configuration Guide/ Security Guide 
mentioned in the Related Documents section for additional 
information on securely configuring your Web server.

Configuring Web application servers
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 Configuring WebSphere Application Server for Application Deployment
You can deploy multiple OFSAA applications on different profiles of a stand-alone 
WebSphere application server. To create multiple WebSphere "Profiles" in a 
stand-alone server, use the command line option as explained in the following section. 
A profile is the set of files that define the runtime environment. At least one profile 
must exist to run WebSphere Application Server.

This section covers the following topics:

• Creating New Profile in WebSphere

• Managing IBM WebSphere SDK Java Technology Edition Versions

• Deleting WebSphere Profiles

• Configuring WebSphere Shared Library to Support Jersey 2x and Jackson 2.9x 
Libraries

• Configuring WebSphere HTTPS

• Configuring WebSphere Memory Settings

• Configuring WebSphere for REST Services Authorization

• Configuring Application Security in WebSphere

Creating New Profile in WebSphere
The Profile is created in WebSphere through command line using the 
manageprofiles.sh that resides in the <WebSphere Install directory>/AppServer/bin 
folder.

The command to create a profile without admin security through command line is as 
follows:

"manageprofiles.sh -create -profileName <profile> -profilePath <profile_
path> -templatePath <template_path> -nodeName <node_name> -cellName <cell_
name> -hostName <host_name>"

Example:

$usr/home>./manageprofiles.sh -create -profileName mockaix 
-profilePath/WebSphere/webs64/Appserver/profiles/mockaix 
-templatePath/WebSphere/webs64/Appserver/profileTemplates/default 
-nodeName ipa020dorNode04 - cellName ipa020dorNode04Cell -hostName 
ipa020dor

The command to create a profile with admin security through command line is as 
follows:

"manageprofiles.sh -create -profileName <profile> -profilePath <profile_
path> -templatePath <template_path> -nodeName <node_name> -cellName <cell_
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name> -hostName <host_name> -enableAdminSecurity true -adminUserName 
<Admin User Name> -adminPassword < Admin User Password> -samplespassword 
<sample User Password>" 

Example:

$usr/home>./manageprofiles.sh -create -profileName mockaix 
-profilePath/WebSphere/webs64/Appserver/profiles/mockaix 
-templatePath/WebSphere/webs64/Appserver/profileTemplates/default 
-nodeName ipa020dorNode04 -cellName ipa020dorNode04Cell -hostName 
ipa020dor -enableAdminSecurity true -adminUserName ofsaai -adminPassword 
ofsaai -samplespassword ofsaai"

Note: While using the manageprofiles.sh command to create a 
New Profile in WebSphere, you can also use "-validatePorts" to 
validate if the specified ports are not reserved or in use. Additionally, 
you can specify new ports with "-startingPort <base port>" which 
specifies the starting port number to generate and assign all ports for 
the profile. For more information on using these ports, see 
manageprofiles command

WebSphere 
.

Managing IBM WebSphere SDK Java Technology Edition Versions
By default, WebSphere Application Server V8.5.5.X uses the Java 6.0 SDK. You must 
upgrade to Java 7.X SDK or JAVA 8.X SDK.

Prerequisites: Install the IBM WebSphere SDK Java Technology Edition Versions 
1.7.X_64 or 1.8.X_64.

Perform the following steps to upgrade to Java 7.X SDK or JAVA 8.X SDK:

1. Enter the WebSphere URL in the format http://HOST_NAME:PORT_
NUMBER/ibm/console (use https if SSL is enabled.). For example, 
http://192.168.1.0:9000/ibm/console.

2. Login with your administrator user ID and password.

3. From the LHS menu, click Servers to expand and view the menu.

4. Click Server Types to expand the menu further and then click WebSphere 
Enterprise Application Servers to view the Application servers window.

5. On Application servers window, click the required Application Server link. For 
example, server1 in the following illustration:

https://www.ibm.com/support/knowledgecenter
https://www.ibm.com/support/knowledgecenter
https://www.ibm.com/support/knowledgecenter
https://www.ibm.com/support/knowledgecenter
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Figure A–1 Application Server - Java SDKs

6. Click Java SDKs link from Server Infrastructure to view the list of Java SDKs.

Figure A–2 Application Server - List of Java SDKs

7. Select either 1.7_64 or 1.8_64 based on the JVM version with which you plan to 
install OFSAA or have installed with.
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8. Click Make Default button and save to master repository.

9. Restart the WebSphere Application Server to apply the changes to the IBM 
application profile.

Managing Applications in WebSphere
To manage the installed applications in WebSphere, follow these steps:

1. Open the administrator console using the following URL:

http://<ipaddress>:<Administrative Console Port>/ibm/console

For example: http://10.111.222.333:9003/ibm/console (https if SSL is 
enabled.)

Note: Administrative Console Port value is available in 
serverindex.xml file within <WebSphere Profile 
Directory>/config/cells/<Node Cell>/nodes/<Node Name> 
directory.

The Integrated Solutions Console Login window is displayed.

Figure 2–1 Integrated Solutions Console Login

2. Log on with the User ID provided with the admin rights.

3. From the LHS menu, expand the Applications > Application Type> WebSphere 
Enterprise Applications.
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The Enterprise Applications screen is displayed.

Figure 2–2 Enterprise Applications

 This Enterprise Applications screen helps you to:

• Install new application

• Uninstall existing applications

• Start or Stop the installed applications

Configuring WebSphere Application Server to Use a Load Balancer or 
Proxy Server
The configuration prevents the process server from redirecting to an internal port 
when using a load balancer or proxy server.

The following steps describe the configuration:

1. Enter the WebSphere URL in the format http://HOST_NAME:PORT_
NUMBER/ibm/console (use https if SSL is enabled.). For example, 
http://192.168.1.0:9000/ibm/console.

2. Login with your administrator user ID and password.

3. From the LHS menu, click Servers to expand and view the menu.

4. Click Server Types to expand the menu further and then click WebSphere 
Enterprise Application Servers to view the Application servers window.

5. On Application servers window, click the required Application Server link. For 
example, server1 in the following illustration:
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Figure A–3 Application Servers - Load Balancer Proxy Server

6. Click Web Container Settings > Custom Properties.

7. Add the following properties:

• Name: trusthostheaderport

Value: true

• Name: com.ibm.ws.webcontainer.extractHostHeaderPort

Value: true

8. Restart the WebSphere Application Server to apply the changes.

Deleting WebSphere Profiles
To delete a WebSphere profile, follow these steps:

1. Select the checkbox adjacent to the required application and click Stop.

2. Stop the WebSphere profile to be deleted.

3. Navigate to WebSphere directory:

<WebSphere_Installation_Directory>/AppServer/bin/

4. Execute the command:

manageprofiles.sh -delete -profileName <profile_name>

5. Delete profile folder.

Example: <WebSphere_Installation_
Directory>/AppServer/profiles/<profile_name>

6. Execute the command:

manageprofiles.sh -validateAndUpdateRegistry

Configuring WebSphere Shared Library to Support Jersey 2x and 
Jackson 2.9x Libraries
Perform the following configuration to set WebSphere shared library to support jersey 
2x and Jackson 2.9x libraries.
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1. Click Environment from the menu on the left to expand and view the list. Click 
Shared Libraries to open the Shared Libraries window.

2. Enter details as shown in the following: 

• Name: Enter a unique identifiable name.

• Description: Enter a valid description.

• Classpath: Enter the absolute path where the JARs related to Jersey 2.x and 
Jackson 2.9x are copied. These jars are available in the <OFSAA_
HOME>/utility/externallib/WEB-INF/lib directory after creation of the EAR 
file.

3. Select Use an isolated class loader for this library.

4. Click OK to save to master configuration.

5. Select the application or module and map the shared libraries. Click OK. In the 
following illustration, ofsa is selected.
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6. From the Shared Library Mapping window, move the required shared libraries 
from Available to Selected. In the following illustration, JERSEY2x is selected.

7. Click OK.

8. Similarly, select the next application or module and repeat the procedure from 
steps 5 to 7.
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9. Disable the built-in JAX-RS via JVM property. 

1. Go to WebSphere admin console in Servers > WebSphere Application 
Servers > yourServerName.

2. In Server Infrastructure section, go to Java and Process Management > 
Process definition > Java Virtual Machine > Custom properties.

3. Add the following property:

com.ibm.websphere.jaxrs.server.DisableIBMJAXRSEngine=true

10. Restart the application.

Configuring WebSphere HTTPS
To configure an HTTPS Transport on WebSphere, follow these steps:

1. Create a profile using the Profile Creation Wizard in WebSphere.

Note: Note down the https port specified during this process and 
use the same as servlet port or web server port during OFSAAI 
installation.

2. To enable https configuration on Infrastructure, assign value 1 to "HTTPS_
ENABLE" in OFSAAI_InstallConfig.xml for Silent mode OFSAAI installation.

Configuring WebSphere Memory Settings
To configure the WebSphere Memory Settings, follow these steps:

1. Navigate to WebSphere applications server > Application servers > 
server1 > Process definition > Java Virtual Machine.

2. Change the memory setting for Java Heap:

Initial heap size = 512

Maximum heap size = 3072
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Configuring WebSphere for REST Services Authorization
Configure the following in WebSphere to enable REST API authorization by OFSAA:

1. Log on to WebSphere console with the User ID provided with the admin rights.

2. Expand Security menu in the LHS and click Global security > Web and SIP 
security > General settings. 

3. De-select the Use available authentication data when an unprotected URI is 
accessed checkbox.

4. Click OK.

5. Click Save to save the changes to master configuration.

Configuring Application Security in WebSphere
This is a mandatory security procedure for WebSphere to restrict the unauthorized 
access of configuration files in directories. For detailed information, see the Oracle 
Financial Services Analytical Applications Infrastructure Security Guide.

https://docs.oracle.com/cd/E61555_01/books/OFSAAI_Security_Guide.pdf
https://docs.oracle.com/cd/E61555_01/books/OFSAAI_Security_Guide.pdf
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Configuring WebLogic for Application Deployment
You can deploy multiple Infrastructure applications on different domains of a 
stand-alone WebLogic application server. To create multiple WebLogic "Domains" in a 
stand-alone server you can use the Domain Creation wizard. A domain is the set of 
files that define the runtime environment. At least one domain must exist to run 
WebLogic Application Server.

Note: For deployment on Oracle WebLogic Server 12.1.3+ (64 bit) with Java 

8, download and install patch 18729264 from http://support.oracle.com/.

Following configuration is required only if OFS Big Data Processing is licensed 

and enabled in your OFSAA instance and OFSAA is deployed on Oracle 

WebLogic Server version 12.2.x:

• The jersey-server-1.9.jar file should be copied to <HIVE_LIB_ PATH> 
path.  

This section covers the following topics:

• Creating Domain in WebLogic Server

• Deleting Domain in WebLogic

• Configuring WebLogic Memory Settings

• Configuring WebLogic for REST Services Authorization

Creating Domain in WebLogic Server
To create a new domain using Configuration Wizard in WebLogic, follow these steps:

1. Navigate to the directory <WLS_HOME>/wlserver/common/bin and execute the 
command:

./config.sh

The Configuration Type window of the Configuration Wizard is displayed.

http://support.oracle.com/
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Figure 2–3 Configuration Type

2. Select Create a new domain option and click Next.

The Templates window is displayed.

Templates
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3.  Select the Create Domain Using Product Templates option and click Next. 

The Administrator Account window is displayed.

Administrator Account

4. Enter the user name to be assigned to the administrator, the password and confirm 
the password. Click Next.
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The Domain Mode and JDK window is displayed

Domain Mode and JDK

5. Select from the following options:

In the Domain Mode section, select the required mode (Development or 
Production).

In the JDK section, select the required option. If you select Other JDK Location, 
click Browse, navigate to the JDK location, and select. Click Next.

The Advanced Configuration window is displayed.
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Figure A–4 Advanced Configuration

6. Select Administration Server. A WebLogic Server domain must have an 
Administration Server. You can also select Manages Servers, Clusters and 
Machines and RDBMS Security Store, if required. Click Next.

The Administration Server window is displayed.
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Figure A–5 Administration Server

7. Enter Administration Server details such as the Server Name, Listen address, 
Listen Port, Enable SSL(for secure login using https, select this check box), and SSL 
listen port. Click Next.

The Configuration Summary window is displayed.
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8. Verify the configuration details of the WebLogic domain and click Create.

The Configuration Progress window is displayed with the status indication of the 
domain creation process.
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9. Click Next when 100% of the activity is complete. 

The End of Configuration window is displayed
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Figure A–6 End of Configuration

10. Click Finish. The domain server is created enabling the deployment of multiple 
Infrastructure applications on a single WebLogic.

Note: ?Note down the HTTPS port specified during this process and 
use the same as servlet port or web server port during OFSAAI 
Installation.

To enable https configuration on Infrastructure, assign value 1 to 
"HTTPS_ENABLE" in OFSAAI_InstallConfig.xml for silent mode 
OFSAAI installation.

11. Add a java option entry -DUseSunHttpHandler=true in WLS_HOME/bin/ 
"setDomainEnv.sh" file (Required only if self signed certificate is used).

Deleting Domain in WebLogic
To delete a domain in WebLogic, follow these steps:

1. Navigate to the following directory:

<WebLogic Installation directory>/user_projects/domains/<domain 
name>/bin
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2. Execute stopWebLogic.sh to stop the WebLogic domain.

3. Delete the WebLogic domain.

Configuring WebLogic Memory Settings
To configure the WebLogic Memory Settings, follow these steps:

1. Change the memory setting for Java Heap to -Xms512m -Xmx3072m in 
setDomainEnv.sh file, which resides in the folder <DOMAIN_HOME>/bin and in 
CommEnv.sh file which resides in the folder common/bin.

2. Edit this file for customizing memory settings and garbage collector settings 
depending on the available hardware configuration.

Example 1:

if [ "${JAVA_VENDOR}" = "Sun" ] ; then

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_64BIT

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_32BIT

else

WLS_MEM_ARGS_64BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_64BIT

WLS_MEM_ARGS_32BIT="-Xms512m -Xmx1024m"

export WLS_MEM_ARGS_32BIT

Example 2:

JAVA_VM=

MEM_ARGS="-Xms256m -Xmx1024m"

Configuring WebLogic for REST Services Authorization
1. Open the config.xml file located in the domain where OFSAA is deployed, that is 

<domain_home>/config/config.xml

2. Add the following in the security-configuration tag:

<enforce-valid-basic-auth-credentials>false</enforce-valid-basic-auth-c
redentials>

Configuring Apache Tomcat Server for Application Deployment
This section is applicable only when the Web application server type is Tomcat.

This section includes the following topics:

• Tomcat User Administration

• Configuring Tomcat to use JAVA 64 bit Executables

• Configuring Servlet Port

• Configuring SSL Port

• Configuring Apache Tomcat Memory Settings
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• Configuring Axis API

• Configuring Tomcat for User Group Authorization and Data Mapping

• Uninstalling WAR Files in Tomcat

Tomcat User Administration
The Tomcat administration and manager application does not provide a default login. 
You are required to edit "$CATALINA_HOME/conf/tomcat-users.xml" as instructed 
below.

This file contains an XML <user> for each individual user, which will display the 
username and password used by admin to log on to Tomcat, and the role names to 
which the admin user is associated with. For example, <user name="admin" 
password="admin" roles="standard,manager" />

1. Add the manager role to any one of the existing username/password combination 
as shown in the preceding example.

2. Use the same username/password to which the manager role has been assigned to 
access the Tomcat Application Manager.

3. If the Tomcat server is already running, it requires a re-start after the above 
configuration is done.

Configuring Tomcat to use JAVA 64 bit Executables
To configure Tomcat to use JAVA 64 bit, follow these steps:

1. Navigate to the $CATALINA_HOME/bin folder.

2. Edit the setclasspath.sh file as follows:

3. Replace the following block of text

# Set standard commands for invoking Java.

_RUNJAVA="$JRE_HOME"/bin/java

if [ "$os400" != "true" ]; then

_RUNJDB="$JAVA_HOME"/bin/jdb

With:

# Set standard commands for invoking Java.

_RUNJAVA="$JAVA_BIN"/java

if [ "$os400" != "true" ]; then

_RUNJDB="$JAVA_BIN"/jdb

4. If the Tomcat server is already running, it requires a re-start after the above 
configuration is done.



Note: In case tomcat is installed under different Unix profile, set 
JAVA_BIN environment variable in .profile to include the Java 
Runtime Environment absolute path.

For example:

export JAVA_BIN /usr/java6_64/jre/bin

export JAVA_BIN = /usr/java6_64/jre/bin//sparcv9 for Solaris 
Sparc
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Configuring Servlet Port
The default servlet port configured for the Tomcat installation is 8080. Ignore this 
section if you need to use the default port.

If you need to use a different port number, you must first configure the port in the 
server.xml file in the conf directory of Tomcat Installation directory. 

To configure the Servlet Port, follow these steps:

1. Navigate to $CATALINA_HOME/conf. Open server.xml and locate the tag:

"Define a non-SSL HTTP/1.1 Connector on port 8080 " 

Against this tag, a parameter is specified 'Connector port = "8080" '. Edit this 
value to the new port number that was used during the Infrastructure installation 
process. 

2. Save your changes in the server.xml file.

Note: Make a note of the servlet port configured. This information is 
required during the installation of OFSAA Applications Pack.

Configuring SSL Port
If you need to configure and access your OFSAA setup for HTTPS access, ensure that 
the following connect tag under Define a SSL HTTP/1/1 Connector on port 8443 in 
<Tomcat_installation_folder>/conf/server.xml file is uncommented for SSL 
Configuration. (By default, it is commented).

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"

maxThreads="150" scheme="https" secure="true"

clientAuth="false" sslProtocol="TLS"

Note: 

• Make a note of the servlet port configured. This information 
would be required during the installation of OFSAA Applications 
Pack.

• To enable https configuration on Infrastructure, assign value 1 to 
HTTPS_ENABLE in OFSAAI_InstallConfig.xml file for 
Silent mode OFSAAI installation.
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For more information related to SSL Configuration on Tomcat, see 
http://tomcat.apache.org/.

Configuring Apache Tomcat Memory Settings
To configure the Apache Tomcat Memory Settings, follow these steps:

1. Locate the catalina.sh file that resides in the  <CATALINA_HOME>/bin folder.

2. Edit this file for customizing the memory settings and garbage collector settings 
depending on the available hardware configuration.

3. Add the memory setting for Java Heap to -Xms512m -Xmx1024m.

For example:

if [ -z "$LOGGING_MANAGER" ]; then

JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m

-Djava.util.logging.manager=org.apache.juli.ClassLoaderLogManager"

else

JAVA_OPTS="$JAVA_OPTS -Xms512m -Xmx1024m $LOGGING_MANAGER"

fi

Configuring Axis API
Copy the jaxrpc.jar from the <OFSAA Installation Directory>/axis-1_
4/webapps/axis/WEB-INF/lib and place it in the  <Tomcat Installation 
Directory>/lib folder and restart the Tomcat Server.

Configuring Tomcat for User Group Authorization and Data Mapping

Users with system authorization roles can access User Group Authorization. However, 
to make it available on Tomcat web server, you have to perform the following 
configuration steps:

1. Navigate to the $CATALINA_HOME/conf folder and open web.xml file.

2. Enter the following in the web.xml file.

<init-param>

<param-name>mappedfile</param-name>

<param-value>false</param-value>

</init-param>

3. Save and close the file.

Uninstalling WAR Files in Tomcat
To uninstall WAR files in tomcat, see Uninstalling WAR Files in Tomcat.

http://tomcat.apache.org/
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BConfiguring Resource Reference in Web 
application servers

This section covers the following topics:

• Configuring Resource Reference in WebSphere Application Server

• Configuring Resource Reference in WebLogic Application Server

• Configuring Resource Reference in Tomcat Application Server

Configuring Resource Reference in WebSphere Application 
Server

This section is applicable only when the Web application server type is WebSphere.

This section covers the following topics:

• Creating JDBC Provider

• Creating Data Source

• Creating J2C Authentication Details

• Defining JDBC Connection Pooling

Creating JDBC Provider
1. Open the WebSphere admin console in the browser window: 

http://<ipaddress>:<administrative console port>/ibm/console. (https if 
SSL is enabled). The Login window is displayed. 

2. Login with the user id that has admin rights.

3. Expand the Resources option in the LHS menu and click JDBC > JDBC Providers. 
The JDBC Providers window is displayed.
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Figure 2–4 JDBC Providers

4. Select the Scope from the drop-down list. Scope specifies the level at which the 
resource definition is visible.

5. Click New to add new JDBC Provider under the Preferences section. The Create 
new JDBC provider window is displayed.
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Figure 2–5 Create a new JDBC Provider

6. Enter the following details:

Table B–1 Fields and their description

Field Description

Database Type Oracle

Provider Type Oracle JDBC Driver

Implementation Type  Connection pool data source

Name The required display name for the resource

Description The optional description for the resource

7. Click Next. 
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Figure 2–6 Enter database class path information

8. Specify the directory location for "ojdbc<version>.jar" file. Ensure that you do 
not use the trailing slash file separators. 

The Oracle JDBC driver can be downloaded from the following  Oracle Download 
site:

• Oracle Database 11g Release 2 (11.2.0.4) JDBC Drivers

• Oracle Database 12c Release 1 (12.1.0.1) JDBC Drivers

Once downloaded, you need to copy the file in the required folder on the server. 

Note: See Appendix O for identifying the correct 
ojdbc<version>.jar version to be copied.

9. Click Next. The Summary window is displayed.

http://www.oracle.com/technetwork/apps-tech/jdbc-112010-090769.html
http://www.oracle.com/technetwork/database/features/jdbc/jdbc-drivers-12c-download-1958347.html
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Figure 2–7 Summary

10. Verify the details and click Finish to create the JDBC Provider.

11. The options to Save and Review are displayed. Click Save.

Creating Data Source
The steps given below are applicable for both config and atomic data source creation.

1. Open this URL in the browser window: http://<ipaddress>:<administrative 
console port>/ibm/console. (https if SSL is enabled). The Login window is 
displayed. 

2. Login with the user id that has admin rights.

3. Expand the Resources option in the LHS menu and click  JDBC > Data sources 
option. The Data sources page is displayed.

Figure B–1 Data Sources
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4. Select the Scope from the drop down list. Scope specifies the level at which the 
resource definition is visible.

5. Click New. The Create a Data Source window is displayed.

Figure B–2 Create Data Source

6. Specify the Data Source name and JNDI name for the new "Data Source".

The JNDI and Data Source name are case sensitive and ensure that JNDI name is 
same as the "Information Domain" name. 

7. Click Next. The Select JDBC provider window is displayed.

Figure B–3 Select JDBC provider

8. Select the option Select an Existing JDBC Provider and select the required JDBC 
provider from the drop-down list. Click Next.
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Figure B–4 Enter database specific properties

9. Specify the database connection URL.

For example: jdbc:oracle:thin:@<DB_SEREVER_IP>:<DB_SERVER_PORT>:<SID>

10. Select Data Store Helper Class Name from the drop-down list and ensure that the 
check box Use this data source in container managed persistence (CMP) is 
selected. 

Note: For RAC configuration, provide the RAC url specified during 
installation.

Example: jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS_
LIST=(ADDRESS=(PROTOCOL=TCP)(HOST=10.11.12.13)(port=1521))(ADDRESS=(PRO
TOCOL=TCP)(HOST=10.11.12.14)(PORT=1521))(LOAD_
BALANCE=no)(FAILOVER=yes))(CONNECT_DATA=(SERVICE_NAME=pqadb)))

11. Click Next.

Figure B–5 Enter Database specific properties
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12. Map the J2C authentication alias, if already created. If not, you can create a new 
J2C authentication alias by accessing the link given (Global J2C authentication 
alias) or you can continue with the data source creation by clicking Next and then 
Finish.

Figure B–6 Summary

You can also create and map J2C authentication alias after creating the data 
source.

13. You must create another Data source by following the above procedure with 
jdbc/FICMASTER as JNDI name pointing to the "configuration schema" of 
Infrastructure.

Creating J2C Authentication Details
The steps given below are applicable for creating both config and atomic J2C 
Authentication.

To create J2C Authentication details, follow these steps:

1. Select the newly created Data Source and click JAAS - J2C authentication data 
link under Related Items. 

JAAS- J2C authentication data
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Figure B–7 JAAS- J2C authentication data

2. Click New under the Preferences section.

Figure 2–8 JAAS- J2C authentication data- New

3. Enter the Alias, User ID, Password, and Description. Ensure the following:

• User ID is the Oracle user ID created for the respective Config and Atomic 
Schema for the "Information Domain".



Configuring Resource Reference in WebLogic Application Server

B-34 Oracle Financial Services Enterprise Case Management Application Pack                  

• Specify the Config database user ID and password information for the 
jdbc/FICMASTER data source, and specify the Atomic database user ID and 
password information for the Atomic schema data source that you created 
earlier.

4. Click Apply and save the details.

Defining JDBC Connection Pooling
To define the JDBC connection pooling ensure that you have created JDBC Provider 
and Data source to access the data from the database.

1. Expand the Resources option in the LHS menu and click JDBC > Data sources 
option. The Data sources page is displayed.

2. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path Data 
sources>$DATA_SOURCE$>Connection pools.

Figure B–8 Connection pools

3. Set the values for Connection timeout to 0 seconds, Maximum connections to 100 
connections, and Minimum connections to 10 connections as shown in the above 
figure. You can also define Reap Time, Unused Timeout, and Aged Timeout as 
required.

Configuring Resource Reference in WebLogic Application 
Server

This section is applicable only when the Web application server type is WebLogic.This 
section includes the following topics:
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• Creating Data Source

• Creating GridLink Data Source

• Configuring Multi Data Sources

• Configuring Advanced Settings for Data Source

• Defining JDBC Connection Pooling

In WebLogic, you can create "Data Source" in the following ways:

• "For a Non RAC Database instance, Generic Data Source has to be created. See 
Create Data Source.

• "For a RAC Database instance, Gridlink Data Source has to be created. See Create 
GridLink Data Source.

• "When Load Balancing/Fail over is required, Multi Data Source has to be created. 
See Configure Multi Data Sources.

Creating Data Source
The steps given below are applicable for both config and atomic data source creation.

1. Open the following URL in the browser window: 
http://<ipaddress>:<administrative console port>/console. (https if SSL is 
enabled). The Welcome window is displayed. 

2. Login with the Administrator Username and Password. 

Figure B–9 Welcome

3. From the LHS menu (Domain Structure), click Services > Data Sources. The 
Summary of JDBC Data Sources window is displayed.
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Figure B–10 Summary of JDBC Data Sources

4. Click New and select Generic Data Source option. The Create a New JDBC Data 
Source window is displayed.

You can also select GridLink Data Source or Multi Data Source while creating a 
Data Source. For more information, see Creating Data Sourceor Configuring Multi 
Data Sources.

Figure 2–9 Create a New JDBC Data Source
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5. Enter JDBC data source Name, JNDI Name, and select the Database Type from 
the drop-down list. Click Next.

Ensure the following:

• The JNDI Name field should be in the format "jdbc/informationdomain"

• Same steps needs to be followed to create a mandatory data source pointing to the 
"configuration schema" of infrastructure with jdbc/FICMASTER as JNDI name. 

• JNDI Name is the same as mentioned in web.xml file of OFSAAI Application.

• Required "Database Type" and "Database Driver" should be selected.

Figure B–11 JDBC Data Source Properties

6. Select the Database Driver from the drop-down list. You need to select the 
Database Driver depending on database setup, that is, with or without RAC. Click 
Next.

Figure B–12 Transaction Options

7. Select the Supports Global Transactions check box and the One-Phase Commit 
option.
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8. Click Next. The Connection Properties window is displayed.

Figure B–13 Connection Properties

9. Enter the required details such as the Database Name, Host Name, Port, Oracle 
User Name, and Password. 

10. Click Next. The Test Database Connection window is displayed.
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Figure B–14 Test Database Connection

11. Verify the details and click Test Configuration and test the configuration settings.

A confirmation message is displayed stating "Connection test succeeded."

12. Click Finish. The created "Data Source" is displayed in the list of Data Sources.



Note: 

• "User ID" is the Oracle user ID that is created for the respective 
"Information Domain".

• "User ID" to be specified for data source with "FICMASTER" as 
"JNDI" name should be the Oracle user ID created for the 
"configuration schema".
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13. Select the new Data Source and click the Targets tab. 

Figure B–15 Select Targets

14. Select the AdminServer option and click Finish.

Creating GridLink Data Source
If you have selected the option, New > GridLink Data Source while creating the "Data 
Source", you can directly specify the JDBC URL as indicated.
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Figure 2–10 Create a New JDBC GridLinkData Source

1. Enter Data Source Name, and JNDI Name.

Ensure that the "JNDI Name" field is specified in the format "jdbc/infodomname" and 
the XA Driver check box is not selected. Click Next.

Figure 2–11 JDBC GridLinkData Source- Connection Properties
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2. Specify Complete JDBC URL, Database User Name, and Password. Click Finish. 
The created "Data Source" is displayed in the list of Data Sources.

Configuring Multi Data Sources
A JDBC multi data source is an abstraction around a group of data sources that 
provides load balancing and failover between data sources. As with data sources, 
multi data sources are also bound to the JNDI tree. Applications can look up a multi 
data source on the JNDI tree and then reserve a database connection from a data 
source. The multi data source determines from which data source to provide the 
connection.

When the database used is Oracle RAC (Real Application Clusters) which allows 
Oracle Database to run across a set of clustered servers, then group of data sources can 
be created for instances running on a set of clustered servers and a JDBC multi data 
source can be created so that applications can look up a multi data source on the JNDI 
tree to reserve database connection. If a clustered server fails, Oracle continues 
running on the remaining servers.

1. Open WebLogic Admin Console in the browser window: 
http://<ipaddress>:<administrative console port>/console. (https if SSL is 
enabled). The Login window is displayed. 

2. Login with the "User ID" that has admin rights.

3. In the LHS menu (Domain Structure), select Services > JDBC > Multi Data 
Sources. The Summary of JDBC Multi Data Sources window is displayed. 

Figure 2–12 Summary of JDBC Multi Data Sources

4. Click New. The New JDBC Multi Data Source screen is displayed.

Note: Ensure that the Data Sources which needs to be added to new 
JDBC Multi Data Source has been created.
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Figure 2–13 Configure the  Multi Data Source

5.  Enter the JDBC Source Name, JNDI name, and select the Algorithm Type from 
the drop-down list. Click Next.

Note: 

• The JNDI Name has to be specified in the format 
jdbc/infodomname. 

• JNDI Name of the Data Sources that will be added to new JDBC 
Multi data source should be different from the JNDI name 
specified during Multi Data Source. 

• Same steps needs to be followed to create a mandatory data 
source pointing to the "configuration schema" of infrastructure 
with jdbc/FICMASTER as JNDI name for Data Source. 

• JNDI Name provided in multi data source should be the same 
name that will be mentioned in the web.xml file of OFSAAI 
Application.

• You can select the Algorithm Type as Load-Balancing.
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Figure 2–14 Select Targets

6. Select the AdminServer check box and click Next.

Figure 2–15 Select Data Source Type

7.  Select the type of data source which will be added to new JDBC Multi Data 
Source. Click Next.

Figure 2–16 Add Data Sources

8.  Map the required Data Source from the Available Data Sources. Click Finish.

 The New JDBC Multi Data Source is created with added data sources.



Configuring Resource Reference in WebLogic Application Server

                       Configuring Resource Reference in Web application servers B-45

Configuring Advanced Settings for Data Source
Perform the following steps for advanced settings for Data Source:

1. Click the new Data Source from the Summary of JDBC Data Sources window. The 
Settings for <Data Source Name> window is displayed.

2. Select the Connection Pooling tab given under Configuration.

3. Go to the Advanced option at the bottom of the page, and check the Test 
Connection of Reserve check box (Enables WebLogic Server to test a connection 
before giving it to a client).

To verify if the data source is valid, select "Data Source name". For example, 
FICMASTER.

Figure 2–17 Settings for <Data Source Name>

4. Select the server and click Test Data Source.

A message is displayed indicating that the test was successful.

5.  Once the "Data Source" is created successfully, the following messages are 
displayed:

• All changes have been activated. No restart is necessary.

• Settings updated successfully. 

If not, follow the steps given above to recreate the data source. 

Defining JDBC Connection Pooling
To define the JDBC connection pooling, ensure that you have created JDBC Provider 
and Data source to access the data from the database.

1. Click the newly created Data Source $DATA_SOURCE$ and navigate to the path 
Home >Summary of Services: JDBC >Summary of JDBC Data Sources >JDBC 
Data Source-<INFODDOM_NAME>

2. Set the values for Initial Capacity to 10, Maximum Capacity to 100, Capacity 
Increment by 1, Statement Cache Type to LRU, and Statement Cache Size to 10.
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3.  Click Save.

Configuring Resource Reference in Tomcat Application 
Server

This section is applicable only when the Web application server type is Tomcat.

This section covers the following topics:

• Creating Data Source

• Defining JDBC Connection Pooling

• Configuring Class Loader for Apache Tomcat

Copy the Oracle JDBC driver file, "ojdbc<version>.jar" from <Oracle Home>/jdbc/lib 
and place it in <Tomcat Home>/lib.

Note: See Appendix O for identifying the correct 
ojdbc<version>.jar version to be copied.

Creating Data Source
To create "data source" for Infrastructure application, navigate to <Tomcat Home>/conf 
and edit the following block of text by replacing the actual values in server.xml.

Note: The User-IDs for configuration/ atomic schemas have the 
prefix of setupinfo depending on the value set for PREFIX_SCHEMA_
NAME in <<APP Pack>>_SCHEMA_IN.XML file of Schema Creator 
Utility. 

For example: if the value set for PREFIX_SCHEMA_NAME is DEV 
and the schema name was mentioned as ofsaaconf, then the actual 
schema created in the database would be DEV_ofsaaconf.

<Context path ="/<context name>" docBase="<Tomcat Installation 
Directory>/webapps/<context name>" debug="0" reloadable="true" 
crossContext="true">

<Resource auth="Container" 

name="jdbc/FICMASTER"

type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username="<user id for the configuration schema>" 

password="<password for the above user id>" 

url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"

maxActive="100" 

maxIdle="30"

maxWait="10000"/>

<Resource auth="Container"
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name="jdbc/< INFORMATION DOMAIN NAME >"

type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username="<user id for the atomic schema>"

password="<password for the above user id>"

url="jdbc:oracle:thin:@<DB engine IP address>:<DB Port>:<SID>"

maxActive="100"

maxIdle="30"

maxWait="10000"/>

</Context>

Note: 

• The <Resource> tag must be repeated for each Information 
Domain created.

• After the above configuration, the "WAR" file has to be created 
and deployed in Tomcat.

Defining JDBC Connection Pooling
To define the JDBC connection pooling, do the following:

1. Copy $ORACLE_HOME/jdbc/lib/ojdbc<version>.jar to the path $TOMCAT_
DIRECTORY/lib/.

Note: See Appendix O for identifying the correct ojdbc<version>.jar 
version to be copied.

2. Edit the server.xml present under the path $TOMCAT_DIRECTORY/conf/ with the 
below changes, which is required for connection pooling.

<Context path="/ $CONTEXTNAME$" docBase=" $APP_DEPLOYED_PATH$ " debug="0" 
reloadable="true" crossContext="true">

<Resource auth="Container"

name="jdbc/ $INFODOM_NAME$"

type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username=" $ATOMICSCHEMA_USERNAME$"

password="$ATOMICSCHEMA_PASSWORD$"

url="$JDBC_CONNECTION_URL"

maxActive="100"

maxIdle="30"

maxWait="10000"

removeAbandoned="true" removeAbandonedTimeout="60"
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logAbandoned="true"/>

</Context>

Note the following:

Note: 

• $APP_DEPLOYED_PATH$ should be replaced by OFSAAI application 
deployed path.

• $INFODOM_NAME$ should be replaced by Infodom Name.

• $ATOMICSCHEMA_USERNAME$ should be replaced by Atomic schema 
database user name.

• $ATOMICSCHEMA_PASSWORD$ should be replaced by Atomic schema 
database password.

• $JDBC_CONNECTION_URL should be replaced by JDBC connection 
string jdbc:Oracle:thin:<IP>:<PORT>:<SID>. For example, 
jdbc:oracle:thin 10.80.50.53:1521:soluint

• The User-IDs for configuration/ atomic schemas have the prefix of 
setupinfo depending on the value set for PREFIX_SCHEMA_NAME in 
<<APP Pack>>_SCHEMA_IN.XML file of Schema Creator Utility. For 
example: if the value set for PREFIX_SCHEMA_NAME is DEV and the 
schema name was mentioned as ofsaaconf, then the actual schema 
created in the database would be DEV_ofsaaconf.

Configuring Class Loader for Apache Tomcat
1. Edit the server.xml available in  $TOMCAT_HOME/conf/ folder.

2. Add tag <Loader delegate="true" /> within the <Context> tag, above the 
<Resource> tag. This is applicable only when the web application server is Apache 
Tomcat 8.

Note: This configuration is required if Apache Tomcat version is 8.
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CConfiguring Work Manager in Web Application 
Servers

Process Modelling framework requires creation of Work Manager and mapping it to 
OFSAA instance. This configuration is required for WebSphere and WebLogic Web 
Application Server types.

This section covers the following topics:

• Configuring Work Manager in WebSphere Application Server

• Configuring Work Manager in WebLogic Application Server

Configuring Work Manager in WebSphere Application Server
This section is applicable only when the Web Application Server type is WebSphere.

This section covers the following topics:

• Creating Work Manager

• Mapping Work Manager to OFSAA WebSphere Instance

Creating Work Manager 
1. Open the WebSphere admin console in the browser window: 

http://<ipaddress>:<administrative console port>/ibm/console. 
(https if SSL is enabled). The Login window is displayed
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2. Login with the user id that has admin rights. 

3. From the LHS menu, expand Resources > Asynchronous beans and select Work 
Managers.
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4. Select the required Scope from the drop-down list. 

For example, Node=whf00aqnNode01, Server=server1.

5. Click New in the Preferences section.

6. Enter the Name as ‘wm’ and JNDI name as ‘wm/WorkManager ‘ in the respective 
fields. 

7. Enter the Thread pool properties.

8. Click Apply.
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9. Click Save. 

After creating work manager successfully, you have to map it to OFSAA instance.

Mapping Work Manager to OFSAA WebSphere Instance
1. From the LHS menu, expand Applications > Application Types and select 

WebSphere enterprise applications.
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2. Click OFSAAI instance hyperlink.

3. Click Resource references link under References section.
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4. Click Browse corresponding to the Work Manager Resource Reference. The 
available resources are displayed.

5. Select the newly created Work Manager (‘wm’) and click Apply.
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6. Select the Work Manager (‘wm/WorkManager’) and click OK.

7. Click Save.
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Configuring Work Manager in WebLogic Application Server
This section is applicable only when the Web Application Server type is WebLogic.

Creating Work Manager
1. Open the WebLogic admin console in the browser window: 

http://<ipaddress>:<administrative console port>/console. 
(https if SSL is enabled). The Welcome window is displayed.

2. Login with the user id that has admin rights. 

3. From the Domain Structure menu in the LHS, expand Environment and select 
Work Managers. The Summary of Work Managers window is displayed.
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4. Click New to create a new work manager component.

5. Select Work Manager and click Next. 
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6. Enter the Name as ‘wm/WorkManager’.

7. Click Next.

8. Select the required deployment target and click Finish. 
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DCreating and Deploying EAR/ WAR File

This section covers the following topics:

• Creating EAR/WAR File

• Deploying EAR/WAR File

Creating EAR/WAR File
To create EAR/WAR File, follow these steps:

1. Navigate to the $FIC_WEB_HOME directory on the OFSAA Installed server.

2. Execute  ./ant.sh to trigger the creation of EAR/ WAR file. 

3. On completion of the EAR files creation, the "BUILD SUCCESSFUL" and "Time 
taken" message is displayed and you will be returned to the prompt.

Figure D–1 Creating EAR/ WAR File

4. The EAR/ WAR file - <contextname>.ear/ .war - is created. 



Note: The <contextname> is the name given during installation. This 
process overwrites any existing version of EAR file that exists in the 
path.

In case of OFSAA configured on Tomcat installation, 
<contextname>.war is created.
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Deploying EAR/WAR File

Note: Remove the existing Admin Tools deployment (which is 
integrated with OFS ECM pack).

This section covers the following topics:

• Deploying EAR/WAR Files on WebSphere

• Deploying EAR/WAR files for WebLogic

• Deploying Tomcat WAR Files on Tomcat

Note: Ensure to clear the application cache prior to the deployment 
of Applications Pack Web Archive. This is applicable to all Web 
servers (WebSphere, WebLogic, and Tomcat). For more information, 
see Clearing Application Cache section.

Deploying EAR/WAR Files on WebSphere
To deploy Infrastructure application in WebSphere:

1. Start WebSphere Profile by navigating to the path "/<WebSphere_Installation_
Directory>/IBM/WebSphere/AppServer/profiles/<Profile_Name>/bin/" and 
execute the command:

 ./startServer.sh server1

2. Open the following URL in the browser: http://<ipaddress>:<Administrative 
Console Port>/ibm/console. (https if SSL is enabled). The login screen is 
displayed. 
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Figure D–2 Login Window

3. Enter the user credentials which has administrator rights and click Log In.

4. From the LHS menu, select Applications and click New Application. The New 
Application window is displayed.

Figure D–3 New Application

5. Click New Enterprise Application. The Preparing for the application installation 
window is displayed. 
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Figure D–4 Preparing for the application installation

6. Select Remote File System and click Browse. Select the EAR file generated for 
OFSAAI to upload and install. Click Next. 

Figure D–5 Installation Options

7. Select the Fast Path option and click Next. The Install New Application window is 
displayed.
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Figure D–6 Install New Application

8. Enter the required information and click Next. The Map Modules to Servers 
window is displayed.



Deploying EAR/WAR File

D-66 Oracle Financial Services Enterprise Case Management Application Pack                  

Figure D–7 Map Modules to Servers

9.  Select the Web Application and click Next. The Map Resource References to 
Resources window is displayed.
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Figure D–8 Map Resource References to Resources

10. Map each resource defined in the application to a resource JNDI name defined 
earlier.

11. Click Modify Resource Authentication Method and specify the authentication 
method created earlier.

You can specify "config" for FICMASTER resource or "atomic" for atomic resource 
as the authentication method.

12. Select the OFSAAI Web Application check box and click Next. The Map Virtual 
hosts for Web Modules window is displayed.
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Figure D–9 Map Virtual host for Web Modules

13. Select the Web Application check box and click Next. The Summary page is 
displayed.
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Figure D–10 Summary

14. Click Finish and deploy the Infrastructure Application on WebSphere.

On successful installation, a message is displayed. 

15. Click Save and save the master file configuration. The details are displayed in the 
Master File Configuration window.

Start the Application
To start the application, follow these steps:

1. Expand Applications > Application Type > WebSphere enterprise applications. 
The Enterprise Applications window is displayed.
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Figure D–11 Enterprise Application

2. Select the installed application and click Start.

Note: 

• <profile name> is the profile name given while creating the 
WebSphere profile. 

• <cell name > is the cell name given during profile creation.

•  <contextname> is the context name given during installation.

Deploying EAR/WAR files for WebLogic
Following are the steps for deploying Infrastructure application that would be created 
during installation:

1. Navigate to the path "<WebLogic Installation directory>/user_
projects/domains/<domain name>/bin" in the machine in which WebLogic is 
installed.

2. Start WebLogic by executing the command: 

./startWebLogic.sh -d64 file

3. Open the URL in the browser window: http://<ipaddress>:<admin server 
port>/console. (https if SSL is enabled). The Sign in window of the WebLogic 
Server Administration Console is displayed.

Note: Ensure that you have started Infrastructure Server by executing 

"./startofsaai.sh" as mentioned in Starting Infrastructure Services 

section.

4. Log on to the WebLogic Server by entering the user credentials having privileges 
to deploy the EAR file.
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5. From the Domain Structure LHS menu, click Deployments. The Summary of 
Deployments window is displayed.

Figure D–12 Summary of Deployments

6. Click Install. The Install Application Assistant window is displayed.

7. Select the Exploded EAR directory after browsing to the directory where it is 
saved and click Next.

Explode EAR File
To explode EAR, follow these steps:

1. Create the "applications" folder under domain name. For example, "/Bea/user_
projects/domains/ <Domain _name>/applications".

2. Create <context_name>.ear folder under "applications" folder. 

3. Copy the <$FIC_WEB_HOME/<context_name>.ear file to <WEBLOGIC_INSTALL_
DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_
name>.ear.

4. Explode the <context_name>.ear file by executing the command:

jar -xvf <context_name>.ear

5. Delete the <context>.ear and < context >.war files (recently created) 
<WEBLOGIC_INSTALL_DIR>/Bea/user_projects/domains/<DOMAIN_
NAME>/applications/<context_name>.ear.

6. Create a directory <context_name>.war under <WEBLOGIC_INSTALL_
DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_
name>.ear.

7. Copy <$FIC_WEB_HOME/<context_name>.war file to <WEBLOGIC_INSTALL_
DIR>/Bea/user_projects/domains/<DOMAIN_NAME>/applications/<context_
name>.ear/<context_name>.war.
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8. Explode the <context_name>.war file by executing the following command to get 
the directory structure:

jar -xvf <context_name>.war

Install Application
To install Application, follow these steps: 

1. Open the Install Application Assistant. 

Figure D–13 Install Application Assistant

2. Click Next. 

Figure D–14 Install Application Assistant

3. From the Choose targeting style section, select the Install this deployment as an 
application option and click Next. 

The Optional Settings window is displayed.
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Figure D–15 Optional Settings

4. Enter a Name for the deployment if required.

5. Under the Security section, select the DD only option to specify that only roles 
and policies that are defined in the deployment descriptors should be used.

6. Select the I will make the deployment available from the following location 
option under the Source accessibility section. 

7. Click Next to continue. 

The Deployment Summary window is displayed.
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Figure D–16 Deployment Summary

8. Select the Yes, take me to the deployment's configuration screen option and click 
Finish. 

The Settings for <Deployment Name> window is displayed.
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Figure D–17 Settings for <Deployment Name>

9. Review the general configuration details of the deployment. You can also update 
the configuration of the deployment in this window. In the Overview tab, you can 
view the complete deployment configuration.

10. Click Save to update the changes, if any.

11. From the LHS menu, click Deployments. 

The Summary of Deployments window is displayed.
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Figure D–18 Summary of Deployments

12. Select the newly deployed Infrastructure application and click Start > Servicing 
all requests. Ensure that the Infrastructure server is up and running.

Figure D–19 Summary of Deployments

13. The State of the deployed application will be displayed as Active if started 
successfully.

Deploying Tomcat WAR Files on Tomcat
Before deploying the WAR files, ensure that the previously deployed applications of 
Infrastructure are uninstalled. See Uninstalling Previously Deployed WAR Files in 
Tomcat for the procedure to uninstall the previously deployed Infrastructure war files.

On the machine that hosts Tomcat, follow these steps to deploy Infrastructure 
application:

1. Copy the <context-name>.war from $FIC_WEB_HOME/<context-name.war> to 
<Tomcat Installation Directory>/webapps/ directory. 
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Figure D–20 Tomcat Home Page

2. Click Manager App. The Connect to dialog box is displayed.

3. Enter the User Id and Password that has admin rights and click OK. (For user 
creation in tomcat, see Tomcat User Administration. The Tomcat Web Application 
Manager window is displayed with the list of all the applications deployed.
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Figure D–21 Tomcat Web Application Manager

4. In the Deploy section, enter the Context Path provided during the installation as 
"/<context-name>".

5. Enter the path where the <context-name>.war file resides (by default "$FIC_WEB_
HOME/<context-name.war>") in the WAR or Directory URL field and click Deploy.

6. On successful application deployment, a confirmation message is displayed.

Start the Tomcat server. See Starting Infrastructure Services for more details. 
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EStarting / Stopping Infrastructure Services

This section details about how to start and stop Infrastructure services. This appendix 
covers the following topics:

• Starting Infrastructure Services

• Stopping Infrastructure Services 

• Cleaning up the environment

Starting Infrastructure Services
Once the installation of Infrastructure is completed successfully and the 
post-installation steps are completed, the servers must be started. Log on to each 
machine and run the .profile file. All servers mentioned must be started from the 
same shell encoding. The following servers mentioned are dependent on each other. It 
is mandatory to maintain the order in which the servers are started. Allow each of the 
servers to initialize completely before starting the next server.

1. On the machine in which Infrastructure Application components have been 
installed, navigate to $FIC_APP_HOME/common/FICServer/bin and execute the 
following command to start the Infrastructure Server.

./startofsaai.sh

Note: You can also start the Infrastructure Server by executing the 
command "nohup ./ startofsaai.sh &". Starting the process using 
"nohup" and "&" will return the command prompt without having to 
wait till the process completes. However, this command cannot be 
used when you are starting the server for the first time or starting 
after changing user password in the configuration database schema.

2. Start ICC server:

• On the machine in which Infrastructure default Application components have 
been installed, navigate to $FIC_HOME/ficapp/icc/bin 

• Execute the command: 

./iccserver.sh

Note: Only Infrastructure Default Application Server would hold 
ICC component.
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3. Start Back-end Services:

• On the machine on which Infrastructure Database components have been 
installed, navigate to $FIC_DB_HOME/bin and execute the command to start 
"Agent server":

./agentstartup.sh 

Or

• Start Back-end services using the command:

nohup ./agentstartup.sh &

Note: This agent internally starts the Router, Message Server, OLAP 
data server and AM services: 

Starting Web Application Servers
Start the Web application server depending on the type from the following table.

Table E–1  Webserver start up options

Start up Option Description

Starting WebSphere profile On the machine in which Web sphere is installed, navigate to 
[Webshpere_Install_Directory] 
/AppServer/<profiles>/<profile name>/bin and execute the 
command: ./startServer.sh server1

Starting WebLogic Domain On the machine in which WebLogic is installed, navigate to 
<WebLogic Installation directory>/user_
projects/domains/<domain name>/bin and execute the 
command: startWebLogic.sh -d64

Note: If WebLogic is already running, access the WebLogic 
Admin Console. Stop and start the application <context 
name>.ear

Starting Tomcat 
Application

On the machine in which Tomcat is installed, navigate to 
<Tomcat_Install_ Directory>/bin and execute the command: 
./catalina.sh run

Stopping Infrastructure Services
To stop Infrastructure services, follow these steps:

1. On the machine in which Infrastructure Application components have been 
installed, navigate to $FIC_APP_HOME/common/FICServer/bin and execute the 
command:.

./stopofsaai.sh

2. To stop ICC server, on the machine in which Infrastructure default Application 
components have been installed, navigate to $FIC_HOME/ficapp/icc/bin and 
execute the command:

./iccservershutdown.sh

Note: Only Infrastructure Default Application Server would hold 
ICC component.
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3. To stop Back-end server, on the machine in which Infrastructure database 
components have been installed, navigate to $FIC_DB_HOME/bin and execute the 
command:

./agentshutdown.sh

Cleaning up the environment 
To clean up the environment, follow these steps:

1. Navigate to $FIC_HOME

2. Execute ./Uninstall.sh.

3. When prompted, enter OFSAAI configuration schema password.

4. This will delete $FIC_HOME and drop all the objects from configuration schema

5. Navigate to ftpshare folder.

6. Delete the infodom folders $ rm -rf <INFODOM>.

7. Drop configuration and atomic schemas from the database
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FAccessing OFSAA Application

This section gives details the steps to be performed to access OFSAA Application.

Access the OFSAA Application
1. From your desktop, open the browser and enter the URL in the following format: 

<scheme>://<IP address/ hostname>:<port>/<context-name>/login.jsp

For example, https://111.222.333.444:5555/ofsaa/login.jsp

The OFSAA login screen is displayed.

Figure F–1 OFSAA Login Window

2. With installation of every OFSAA Applications Pack, there are two seeded user 
profiles configured in the system: 

"SYSADMN - System Administrator

"SYSAUTH - System Authorizer



Note: For SYSADMN and SYSAUTH, the default password is 
password0.

Access the OFSAA Application
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1.  Login to the application using the "SYSADMN" User ID. (Note that, there is no "I" 
in the SYSADMN login USER ID). Enter the password that was provided during 
installation. On the first login, you will be prompted to change the password.
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GCloning OFSAA Instance

There is a consistent need for a faster and effective approach of replicating an existing 
OFSAA instance for further project developments, that is, setting up OFSAA instances 
that are exact copies of the current OFSAA instance. For more information on cloning, 
see OFSAA Cloning Reference Guide.

http://docs.oracle.com/cd/E61555_01/books/OFSAA_Cloning_Reference_Guide_8.0.pdf
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HOFSAA Landing Page

This section includes the following topics:

• OFSAA Landing Page

• Enabling a Product within an Applications Pack

OFSAA Landing Page
On successful authentication, the OFSAA Landing Page is displayed. This is a 
common landing page for all users until a preferred application landing page is set by 
the user in his preferences.

The landing page includes multiple tabs and each tab has specific links to OFSAA 
Infrastructure and/or Application modules. The tabs and links are displayed based on 
the OFSAA Application accessed and the access roles mapped to the logged in user.

Each tab contains LHS Menu and RHS Menu. The LHS Menu holds link(s) to modules 
in a tree structure. The RHS Menu holds link(s) to modules in a navigational panel 
format.

The following tabs are available in the Landing Page:

• Applications Tab

• Sandbox Tab

• Object Administration Tab

• System Configuration and Identity Management Tab

Applications Tab
This tab lists the various OFSAA Applications that are installed in the setup.

The "<Select Application>" dropdown lists the OFSAA Applications based on the user 
logged in and User Group(s) mapped to OFSAA Application. Selecting an Application 
from the drop down refreshes the menus/ links.

Sandbox Tab
This tab lists the various OFSAA Sandboxes created in the setup.

The "<Select Sandbox>" dropdown lists the OFSAA Sandboxes based on the user 
logged in and User Group(s) mapped to OFSAA Application.

Selecting a Sandbox from the drop down would refresh the menus/ links.
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Object Administration Tab
This tab lists the various OFSAA Information Domains created in the setup. 

The "<Select Information Domain>" dropdown lists the OFSAA Information Domains 
based on the user logged in and User Group(s) mapped to OFSAA Application.

Selecting an Information Domain from the drop down refreshes the menus/ links.

System Configuration and Identity Management Tab
This tab lists the OFSAA Infrastructure System Configuration and Identity 
Management modules. These modules work across Applications/ Information 
Domains and hence there are no Application/ Information Domain dropdown list in 
this tab.

Note: NOTE: See the AAI User Guide for more details on how to 
operate on each tab.

Enabling a Product within an Applications Pack
You can also enable a product/ application within an Applications Pack post 
installation at any point of time. 

To enable a product through the application UI, follow these steps:

1. Login to the application as SYSADMN user or any user with System 
Administrator privileges.

2. Navigate to System Configurations & Identity Management tab and expand 
Financial Services Analytical Applications Infrastructure >> Administration and 
Configuration >> System Configuration.

3. Click Manage OFSAA Product License(s)

4. The Manage OFSAA Product License(s) page is displayed as below.

This page includes the following sections:

• INSTALLED Applications Packs

• PRODUCTS IN THE Applications Pack
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Figure H–1 Manage OFSAA Product License(s) Page

5. The following fields are displayed in the INSTALLED Applications PackS section:

Table H–1 Installed Applications Pack - Field Description

Field Description

Applications Pack ID Displays a unique Applications Pack ID related to the 
Applications Pack. 

Select the appropriate Pack id using the radio button. The 
Products in the Applications Pack will be displayed below in 
the PRODUCTS IN THE Applications PackS section.

Applications Pack Name Displays the name of the Applications Pack.

Description Displays the description of the Applications Pack.

Install Date Displays the date when the Applications Pack was installed.

6. The following fields are displayed in the PRODUCTS IN THE Applications Pack 
section:

Table H–2 products in the Applications Pack - Field Description

Field Description

Enable Select the check box to enable a product within an Applications 
Pack. 

Product ID Displays a unique product id for the product.

Product Name Displays the name of the Product.

Description Displays the description of the product.

Enable Date Displays the date when the product was enabled.

7. Select an Applications Pack by clicking the radio button next to the Applications 
Pack ID field.
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8. Selecting an Applications Pack will display below the products within the 
Applications Pack.

9. Products which were enabled at the time of installation will have the check box 
“ENABLE” disabled. You can enable any product within the selected Applications 
Pack by clicking the “ENABLE” check box against the respective Product ID.

10. Click on RESET button to cancel the operation and refresh the screen.

11. Click VIEW LICENSE AGREEMENT button.

The License Agreement section is displayed.

Figure H–2 License Agreement

12. Select the option I ACCEPT THE LICENSE AGREEMENT.

13. Click ENABLE.

14.   An appropriate pop-up message confirmation is displayed showing that the 
product is enabled for the pack.

Note: To use the newly enabled product, you need to map your 
application users to the appropriate product specific User_Group(s) 
and subsequently, authorize the actions by logging in as System 
Authorizer.

Note: 

• For more information see Mapping/Unmapping Users section in 
the Oracle Financial Services Analytical Applications 
Infrastructure User Guide. 

• To identify the newly enabled product specific UserGroups/ 
Applications Pack specific User_Groups, see the respective 
Applications Pack specific Installation and Configuration Guide/ 
User Manual.

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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IAdditional Configuration

This section gives detailed information about the Additional Configuration regarding 
OFSAA Installation.

Additional Configuration
This section covers the following topics:

• Configuring FTP/SFTP

• Configuring Infrastructure Server Memory

• Configuring Internet Explorer Settings

• Setting OLAP Data Server Configuration

• Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance

• Executing OFSAAI Setup Information Fetching Tool

• Executing Encryption Changer

• Setting Infrastructure LDAP Configuration

• Configure Message Details in Forms Designer

• Clearing Application Cache

• Configuring Password Changes

• Configuring Internal Service (Document Upload/ Download)

Configuring FTP/SFTP
This section details about the configurations required for FTP/SFTP.

Adding FTP/SFTP Configuration for File Transfer
In OFSAA, certain modules require transfer of files from the web application server to 
the OFSAA server over SSH.   

Follow these steps to ensure the OFSAA server recognizes the web application server 
during file transfers.

1. Log in to the web application server.

2. Type sftp <user>@<OFSAA Server>.

3. Specify Yes when prompted for permission. 

Are you sure you want to continue connecting (Yes/No)? 
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 This will add an entry into the "known_hosts" file.

4. A confirmation message is displayed: 

Permanently added <OFSAA Server> RSA) to the list of known hosts.

Setting Up SFTP Private Key
Log in to OFSAA Unix user using Putty tool, where you plan for installation and 
generate a pair of authentication keys using the ssh-keygen command. If required, 
set passphrase. Otherwise OFSAAI_SFTP_PASSPHRASE tag in the OFSAAI_
InstallConfig.xml file should be set to NA.

To generate private key, enter the commands as shown:

ofsaapp@OFSASERVER:~> ssh-keygen -t rsa

Generating public/private rsa key pair.

Enter file in which to save the key (/home/ofsaapp/.ssh/id_rsa):

Created directory '/home/ofsaapp/.ssh'.

Enter passphrase (empty for no passphrase):

Enter same passphrase again:

Your identification has been saved in /home/ofsaapp/.ssh/id_rsa.

Your public key has been saved in /home/ofsaapp/.ssh/id_rsa.pub.

The key fingerprint is:

3e:4f:05:79:3a:9f:96:7c:3b:ad:e9:58:37:bc:37:e4

ofsaapp@OFSASERVER:~> cat /home/ofsaapp/.ssh/id_rsa.pub >> 
/home/ofsaapp/.ssh/authorized_keys

In case, you are generating SFTP Private key for Hive server, append the content of 
/home/ofsaapp/.ssh/id_rsa.pub to Hiveserver authorized_keys file located at 
$HOME_DIR_HIVE/.ssh folder.

Ensure the following permissions exist for the given folders:

• Permission of .ssh should be 700

• Permission of .ssh/authorized_keys should be 640

• Permission of .ssh/id_rsa should be 400

• Permission of Unix user created should be 755

Configuring Infrastructure Server Memory
The memory settings for Infrastructure Application Server, Tomcat, WebSphere, and 
WebLogic can be edited for customizing memory settings and garbage collector 
settings depending on the available hardware configuration as explained below. These 
settings are base minimum and has to be incremented considering the deployment 
metrics into account. The increments are usually handled in multiples of 128 MB for 
heap and 64 MB for stack.

Configuring Infrastructure Application Server Memory Settings
You can configure the Infrastructure Application Memory settings as follows:

1. Locate .profile file.
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2. Edit X_ARGS field in this file for customizing memory settings and garbage 
collector settings depends on the hardware configuration.

This has a default value X_ARGS="-Xms200m"

X_ARGS=" "$X_ARGS" $DELIM -Xmx2048m"

Note: This parameter is modified in 7.3.2 IR and you need to modify 
X_ARGS_APP variable in the .profile file to customize Java Memory 
Settings for Model Upload based on the Data Model size.

For Run and Rule executions, the following value is recommended:  

X_ARGS_RNEXE="-Xms1g -Xmx1g -XX:+UseAdaptiveSizePolicy 
-XX:MaxPermSize=512M -XX:+UseParallelOldGC 
-XX:+DisableExplicitGC"  

X_ARGS_RLEXE="-Xms1g -Xmx1g -XX:+UseAdaptiveSizePolicy 
-XX:MaxPermSize=512M -XX:+UseParallelOldGC 
-XX:+DisableExplicitGC"

Configuring Internet Explorer Settings

Note: OFSAAI supports only default zoom setting in Internet 
Explorer, that is, 100%.
Cookies should be enabled.

The following browser settings must be specified at every client machine prior to 
accessing the Infrastructure application.

1. Open Internet Explorer. Select Tools > Internet Options. The Internet Options 
window is displayed.

2. Click Settings. The Settings window is displayed.

3. Select Every time I Visit the webpage and click OK.
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Figure I–1 Internet Options

4. In the Internet Options window, select the Security tab and select the Internet 
option under Select a zone to view or change the security settings.

5. Click Default Level under Security level for this zone.
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Figure I–2 Internet Options - Security Tab

6. Click Apply to save.

7. Click Internet Explorer >> Tools >> Compatibility View Settings.

8. Enter the OFSAA setup URL in the Add this website field.

9. Click Add.

10. Ensure the URL is listed under Websites you've added to Compatibility View.

11. In the Internet Options window, select the Privacy tab and select the Turn on 
Pop-up Blocker option under Pop-up Blocker settings.
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Figure I–3 Internet Options- Popup Blocker Settings

12. Click Settings. The Pop-up Blocker Settings window is displayed.

13. Enter the URL of the OFSAA Application in the Address of website to allow: 
field.

14. Click Add. The OFSAA URL is displayed in the Allowed sites section.

15. Click Close.

16. Click OK in the Internet Options window.

Retrieving Patch Information
To identify the list of patches installed on your OFSAA setup, follow these steps:

1. Login to the OFSAA application as a user with Object AdminAdvanced Role.

2. Navigate to Object Administration tab.

3. Click System Utilities.

4. Click Patch Information.

5. The page displays the list of patches installed on the OFSAA setup across 
Applications/ Platform.

Setting OLAP Data Server Configuration
This section is applicable if you are using the OLAP feature of OFSAAI.

The following parameters must be set to ensure that the system limitations are not 
exceeded at any stage. The values for these OS parameters should be specified based 
on the expected load at each implementation site.
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For example:

Process Memory Limit

Max Thread Stack Size

Max Number of Threads per Process

• Sort Buffer settings: This must be set at the Essbase application level appropriate 
to the anticipated load.

• Shutdown and Restart: During shutdown of OFSAAI Server that has an instance 
of Data Services that is communicating with an OLAP Data Server, it is imperative 
to ensure that the cleanup of the old instance is completed on the OLAP Data 
Server before restarting the OFSAAI Server. Pause for a period of time based on 
the load the system was subjected to, before restarting the Data Services 
subsystem.

Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance
For information on this section, see OFS Analytical Applications Infrastructure 
Administration User Guide in OTN.

Executing OFSAAI Setup Information Fetching Tool
Executing the SetupInfo.jar file available in the FIC_HOME path will help you retrieve 
the related information about the OFSAAI Set up such as Operating System Name and 
Version, Database Type and Version, OFSAAI architecture, Log file locations and so 
on.

To execute "SetupInfo.jar" in console, follow these steps:

1. Navigate to the path $FIC_HOME.

2. Enter the command:

java -jar SetupInfo.jar

After execution, the output file location is displayed in the console.

Executing Encryption Changer
For more information on Encryption Changer, see Key Management section in 
OFSAAI Administration Guide. 

Setting Infrastructure LDAP Configuration
For more information on LDAP configuration, see OFSAAI Administration Guide.

Enabling Parallel Execution of DML statements
A configuration file, OracleDB.conf has been introduced to accommodate any 
configurable parameter related to operations on oracle database. If you do not want to 
set a parameter to a specific value, then the respective parameter entry can be 
removed/commented off form the OracleDB.conf file which resides in the path $FIC_
DB_HOME/conf.

As of now, the OracleDB.conf file has only one parameter namely CNF_DEGREE_OF_
PARALLELISM. This parameter indicates the degree of parallelism to be used for a DML 
operation if parallel DML is explicitly enabled in the session with the ENABLE 
PARALLEL DML clause of the ALTER SESSION statement. The default mode of a 

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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session is DISABLE PARALLEL DML. If CNF_DEGREE_OF_PARALLELISM is not 
set, then the default degree, as decided by Oracle will be used.

Configure Message Details in Forms Designer
You can configure the Message Details in Forms Designer under Data Entry Forms 
and Queries module by updating the details of mail server in the 
NotificationConfig.cfg file which resides in the path $FIC_APP_
HOME/common/FICServer/conf.

Ensure that the "authorized User details" for whom you need to configure the Message 
details are included in Administration > Security Management > User Administrator 
> User Maintenance window.

Update the following parameters in the "NotificationConfig.cfg" file:

Table I–1  NotificationConfig.cfg File

Parameter Description

SMTP_SERVER_IP Specify the hostname or IP address of SMTP Server.

SMTP_DEBUG_MODE To run SMTP service in Debug mode, set value to 
'true', otherwise set value to 'false'.

SMTP_AUTHORIZATION Set to 'true' if SMTP server requires the client to be 
authenticated, otherwise set to 'false'.

SMTP_USERNAME Username required for logging into SMTP server, if 
authentication is not required use a dummy value.

SMTP_PASSWORD Password required for logging into SMTP server, if 
authentication is not required use a dummy value.

SMTP_MAILID If the Messages has to go from a Particular ID that 
ID need to be added. Exchange server forces you set 
a valid ID that is there in the exchange server. 
(Based on Security settings)

Ensure that the authorized User details are included in Administration > Security 
Management > User Administrator > User Maintenance window.

Clearing Application Cache
This is applicable to all Web servers (that is, WebSphere, WebLogic, and Tomcat). 

Prior to the deployment of Infrastructure or Application Service Packs / One-off 
patches, clear the cache. Navigate to the following path depending on the WebServer 
configured and delete the files:

• Tomcat: <Tomcat installation 
folder>/work/Catalina/localhost/<Application name>/org/apache/jsp

• WebLogic: <WebLogic installation location>/domains/<Domain 
name>/servers/<Server name>/tmp/_WL_user/<Application name>/qaelce/jsp_
servlet

• WebSphere: <WebSphere installation 
directory>/AppServer/profiles/<Profile name>/temp/<Node 
name>/server1/<Application name>/<.war file name>
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Configuring Password Changes
This section explains about how to modify the OFSAA Infrastructure Config Schema 
and Atomic Schema passwords.

Modifying OFSAA Infrastructure Config Schema password
To change the Config Schema password, perform the following steps:

1. Change the Config schema User Password in the database.

2. Delete the $FIC_HOME/conf/Reveleus.SEC file.

3. Shutdown the OFSAAI App service:

cd $FIC_APP_HOME/common/FICServer/bin

./stopofsaai.sh

4. Start the Infrastructure Server in foreground directly on the server or through 
X-Windows software using the command:

./startofsaai.sh

5. At the prompt, enter System Password. Enter the "new Config schema" password. 
The service will start and initialize itself if it is able to successfully connect to the 
DB.

6. Post successful startup of the service, if required, the Infrastructure server may be 
shut down and restarted in the background using nohup mode.

Modifying OFSAA Infrastructure Atomic Schema password
To change the Atomic Schema password, perform the following steps:

1. Change the Atomic schema User Password in the database.

2. Login to the application from the browser using SYSADMN account or any user 
id, which has System Administrator role mapped.

3. Navigate to System Configuration > Database Details window. Select the 
appropriate connection and edit the password.

4. Navigate to Data Management Tools >Data Sources> Source Designer window. 
Update the password of the appropriate Source

5. If you are using Apache Tomcat as Web server, update the <Context> -> 
Resource tag details in Server.xml file from the $CATALINA_HOME/conf folder. 
(In case of Tomcat only Atomic <Resource> will exist).

If you are using WebSphere as Web server:

a. Login to the WebSphere Administration Console, from the left side menu.

b. Navigate to Resources >JDBC >Data Sources. A list of data sources will be 
populated on the right side. 

c. Select the appropriate Data Source and edit the connection details. (In this 
case, both Config and Atomic data sources will need to be modified).

If you are using WebLogic as Web server:

a. Login to the WebLogic Administration Console, from the left side menu

b. Under Domain Structure list box, expand the appropriate Domain and 
navigate to Services > JDBC >Data Sources. A list of data sources will be 
populated on the right side. 
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c. Select the appropriate Data Source and edit the connection details. (In this 
case, both Config and Atomic data sources need to be modified).

6. Restart the OFSAAI services.

Configuring Internal Service (Document Upload/ Download)
This step can be ignored if it has already been configured as part of any previous IR 
/ML installation. 

The Document Upload /Download feature has undergone a change and can now be 
configured to use Internal service for document upload / download instead of the 
earlier ExeWebService.

To facilitate Internal service for document upload/ download, perform the following 
configurations:

1. Create the folders download, upload, TempDocument and Temp in the local path 
of Web application server and provide Read/Write permission.

• To find the exact location, execute the following query in CONFIG schema:

select localpath from web_server_info

• To create folders with Read/Write permission, execute the command:

mkdir -m 777 download upload TempDocument Temp

2. Create DocStorage folder in the FTPSHARE location of APP tier and provide 
Read/Write permission.

• To find the exact location, execute the query in CONFIG schema:

select ftpdrive from app_server_info

• To create folder with Read/Write permission, execute the command:

mkdir -m 777 DocStorage
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JPatching OFSAA Infrastructure Installation

Oracle strongly recommends installing the latest available patchset so as to be up to 
date with the various releases of the OFSAA product.

See http://support.oracle.com for more information on latest release.

http://support.oracle.com/
http://support.oracle.com/
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KGrants for Atomic/ Config Schema

This section mentions about the various grants required for the CONFIG, ATOMIC 
schemas.

This section discusses the following sections:

• Configuring Grants for Atomic Schema

• Configuring Grants for Config Schema

• Configuring Grants for Config Schema Entities for Atomic Users

Configuring Grants for Atomic Schema
Atomic Schema creation requires certain grants for object creation. This can be located 
in $FIC_HOME/privileges_atomic_user.sql file. 

The following are the Grants for Atomic Schema:

grant create SESSION to &database_username

/

grant create PROCEDURE to &database_username

/

grant create SEQUENCE to &database_username

/

grant create TABLE to &database_username

/

grant create TRIGGER to &database_username

/

grant create VIEW to &database_username

/

grant create MATERIALIZED VIEW to &database_username

/

grant select on SYS.V_$PARAMETER to &database_username

/

grant create SYNONYM to &database_username

/



Note: If you intend to use Oracle OLAP feature, execute the below 
grant on all ATOMIC schema(s)  grant olap_user to &database_
username

Configuring Grants for Config Schema
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Configuring Grants for Config Schema
Config Schema creation requires certain grants for object creation. This can be located 
in $FIC_HOME/privileges_config_user.sql file.

The following are the Grants for Config Schema:

grant create SESSION to &database_username

/

grant create PROCEDURE to &database_username

/

grant create SEQUENCE to &database_username

/

grant create TABLE to &database_username

/

grant create TRIGGER to &database_username

/

grant create VIEW to &database_username

/

grant create MATERIALIZED VIEW to &database_username

/

grant select on SYS.V_$PARAMETER to &database_username

/

grant create SYNONYM to &database_username

/

Configuring Grants for Config Schema Entities for Atomic 
Users

Atomic Schema creation requires certain grants for config schema object access. This 
can be located in $FIC_HOME/config_table_privileges_for_atomic_user.sql file. 
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LConfiguring Applications Pack XML Files

This section explains configuration of OFS_ECM_PACK.xml and OFS_ECM_SCHEMA_
IN.xml files. 

This section includes the following topics:

• Configuring OFS_ECM_PACK.xml File

• Configuring OFS_ECM_SCHEMA_IN.xml File

Configuring OFS_ECM_PACK.xml File
The OFS_ECM_PACK.xml file holds details on the various OFSAA products that are 
packaged in a particular Applications Pack. 

The following table gives details about the various tags/ parameters available in the 
file and the values that need to be updated. Prior to installing the OFSAA Applications 
Pack in Silent mode, it is mandatory to update this file. 

Table L–1 OFS_ECM_PACK.XML Parameters

Tag Name/ Attribute 
Name Description Mandatory (Y/N)

Default Value/ 
Permissible Value Comments

APP_PACK_ID Unique 
Applications 
Pack Identifier

Y Unique Seeded 
Value

DO NOT modify 
this value.

APP_PACK_NAME Unique 
Applications 
Pack Name

Y Unique Seeded 
Value

DO NOT modify 
this value.

APP_PACK_
DESCRIPTION

Unique 
Applications 
Pack Description

Y Unique Seeded 
Value

DO NOT modify 
this value.

VERSION Unique 
Application 
Pack release 
version

Y Unique Seeded 
Value

DO NOT modify 
this value.

APP Unique 
Application 
Entries

Y Unique Seeded 
Value

DO NOT remove 
these tags.

APP_ID Unique 
Application 
Identifier

Y Unique Seeded 
Value

DO NOT modify 
this value.
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Configuring OFS_ECM_SCHEMA_IN.xml File
Creating database schemas, objects within schemas and assigning appropriate grants 
are the primary steps in the installation process of OFSAA Applications. The OFS_
ECM_SCHEMA_IN.xml file contains details on the various application schemas that 
should be created prior to the Applications Pack installation. 

The following table gives details about the various tags/ parameters available in the 
file and the values that need to be updated. Prior to executing the schema creator 
utility, it is mandatory to update this file.

APP_ID/ PREREQ Prerequisite 
Application/ 
Product

Y Unique Seeded 
Value

For most 
applications 
Infrastructure 
would be the 
prerequisite set. For 
certain other 
applications, an 
appropriate 
Application ID 
would be set.

DO NOT modify 
this value.

APP_ID/ DEF_SEL_
FLAG

Default Selected 
Flag

Y Default - YES In all Applications 
Packs, 
Infrastructure 
would have this 
value set to "YES". 
DO NOT modify 
this value.

APP_ID/ ENABLE Enable 
Application/ 
Product

YES if installing in 
Silent mode.

Default - 

YES for 
Infrastructure

NO for Others

Permissible -  YES 
or NO

Set this 
attribute-value to 
YES against every 
APP_ID which is 
licensed and should 
be enabled for use.

Note: Application/ 
Product once 
enabled cannot be 
disabled. However, 
Application/ 
Product not enabled 
during installation 
can be enabled later 
through the 
Administration UI.

APP_NAME Unique 
Application/ 
Product Name

Y Unique Seeded 
Value

DO NOT modify 
this value.

APP_DESCRIPTION Unique 
Application/ 
Product Name

Y Unique Seeded 
Value

DO NOT modify 
this value.

VERSION Unique release 
version

Y Unique Seeded 
Value

DO NOT modify 
this value.

Table L–1 OFS_ECM_PACK.XML Parameters

Tag Name/ Attribute 
Name Description Mandatory (Y/N)

Default Value/ 
Permissible Value Comments
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Table L–2 OFS_ECM_SCHEMA_IN.XML Parameters

Tag Name/ 
Attribute Name Description

Mandat
ory 
(Y/N)

Default Value/ 
Permissible Value Comments

APP_PACK_ID Unique Applications Pack 
Identifier

Y Unique Seeded Value DO NOT modify this 
value.

<JDBC_URL> Enter the JDBC URL

Note: You can enter RAC 
and NON-RAC enabled 
database connectivity 
URL.

Y Example, 

jdbc:oracle:thin:@< 
DBSERVER 
IP/HOST>:<PORT>:<SID
>

or

jdbc:oracle:thin:@//[HOS
T][:PORT]/SERVICE

or

jdbc:oracle:thin:@(DESCRI
PTION=(ADDRESS_
LIST=(ADDRESS=(PROT
OCOL=TCP)(HOST=[HO
ST])(port=[PORT]))(ADD
RESS=(PROTOCOL=TCP)
(HOST=[HOST])(PORT=[
PORT]))(LOAD_
BALANCE=yes)(FAILOV
ER=yes))(CONNECT_
DATA=(SERVICE_
NAME=[SERVICE]))) 

For example, 
jdbc:oracle:thin:@//dbhos
t.server.com:1521/service
1 

or

jdbc:oracle:thin:@//dbsho
st.server.com:1521/scan-1

or

jdbc:oracle:thin:@(DESCRI
PTION=(ADDRESS_
LIST=(ADDRESS=(PROT
OCOL=TCP)(HOST=dbho
st1.server.com)(port=1521
))(ADDRESS=(PROTOCO
L=TCP)(HOST=dbhost2.s
erver.com)(PORT=1521))(
LOAD_
BALANCE=yes)(FAILOV
ER=yes))(CONNECT_
DATA=(SERVICE_
NAME=service1)))

Ensure to add an entry 
(with SID/ SERVICE 
NAME) in the 
tnsnames.ora file on the 
OFSAA server. The entry 
should match with the 
SID/SERVICE NAME 
used in the  JDBC URL.

<JDBC_
DRIVER>

By default this driver 
name is seeded. 

Note: Do not edit this 
attribute value.

Y Example, 

oracle.jdbc.driver.OracleD
river

Only JDBC Thin Driver is 
supported.

DO NOT modify this 
value.

<HOST> Enter the Hostname/ IP 
Address of the system on 
which you are installing 
the OFSAA components.

Y Host Name/ IP Address
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<SETUPINFO>/ 
NAME

Enter the acronym for the 
type of implementation. 
This information will be 
displayed in the OFSAA 
Home Page.

Note: On executing the 
schema creator utility, this 
value will be prefixed 
with each schema name. 
For example: dev_
ofsaaconf, uat_ofsaaatm.

Y Accepts strings with a 
minimum length of two 
and maximum of four.

Example, 

DEV, SIT, PROD

This name would appear 
in the OFSAA Landing 
Page as "Connected To: 
xxxx"

The schemas being 
created would get this 
prefix. For E.g. dev_
ofsaaconf, uat_ofsaaconf 
etc.

<SETUPINFO>/ 
PREFIX_
SCHEMA_
NAME

Identifies if the value 
specified in 
<SETUPINFO>/ NAME 
attribute should be 
prefixed to the schema 
name.

N YES or NO Default value is YES.

<PASSWORD>/ 
DEFAULT*

Enter the password if you 
want to set a default 
password for all schemas.

Note: You also need to set 
APPLYSAMEFORALL 
attribute as Y to apply the 
default password for all 
the schemas.

N The maximum length 
allowed is 30 characters. 
Special characters are not 
allowed.

<PASSWORD>/ 
APPLYSAMEFO
RALL

Enter as Y if you want to 
apply the password 
specified in DEFAULT 
attribute for all the 
schemas. 

If you enter as N, you 
need to provide 
individual passwords for 
all schemas.

Note: In case you have 
entered Y in 
APPLYSAMEFORALL 
attribute and also have 
specified individual 
passwords for all the 
schemas, then the 
specified individual 
passwords will take 
precedence.

Y Default - N

Permissible - Y or N

If set to N, need to specify 
PASSWORD value for 
every SCHEMA.

Note: Setting this attribute 
value is mandatory, If 
DEFAULT attribute is set.

Table L–2 OFS_ECM_SCHEMA_IN.XML Parameters

Tag Name/ 
Attribute Name Description

Mandat
ory 
(Y/N)

Default Value/ 
Permissible Value Comments
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<SCHEMA>/ 
TYPE

The different types of 
schemas that are 
supported in this release 
are ATOMIC, CONFIG, 
SANDBOX, and ADDON.

By default, the schemas 
types are seeded based on 
the Applications Pack. 

Note: Do not edit this 
attribute value.

Y ATOMIC/CONFIG/SAN
DBOX/ADDON

Note: 

SANDBOX AND 
ADDON schemas are not 
applicable for OFS AAAI 
Applications Pack.

Only One CONFIG 
schema can exist in the 
file.

This schema identifies as 
the CONFIGURATION 
schema that holds the 
OFSAA setup details and 
other metadata 
information.

Multiple ATOMIC/ 
SANDBOX/ ADDON 
schemas can exist in the 
file.

ATOMIC schema refers to 
the Information Domain 
schema. SANDBOX 
schema refers to the 
SANDBOX schema. 
ADDON schema refers to 
other miscellaneous 
schema (not applicable for 
this Applications Pack). 

Table L–2 OFS_ECM_SCHEMA_IN.XML Parameters

Tag Name/ 
Attribute Name Description

Mandat
ory 
(Y/N)

Default Value/ 
Permissible Value Comments
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<SCHEMA.>/ 
NAME

By default, the schemas 
names are seeded based 
on the Applications Pack.

You can edit the schema 
names if required. 

Note:

The Schema Name will 
have a prefix of the 
SETUPINFO/ NAME 
attribute.

SCHEMA NAME must be 
same for all the ATOMIC 
Schemas of applications 
within an Applications 
Pack.

Y The permissible length is 
15 characters and only 
alphanumeric characters 
allowed. No special 
characters allowed except 
underscore '_'.

SETUPINFO/ NAME 
attribute value would be 
prefixed to the schema 
name being created.

For E.g. if name is set as 
'ofsaaatm' and setupinfo 
as 'uat' then schema being 
created would be 'uat_
ofsaaatm'. 

NAME should be same 
where APP_GRP=1 for all 
SCHEMA tags (Not 
applicable for this 
Applications Pack). 

 Note: 

For example: 

 <Variable  
name="DATABASE 
NAME">KYCDB.oracle.com
</Variable> 

A TNS entry must be 
made in tnsnames.ora 
with tnsname same as the 
value provided for KYC 
Database Name. If 
sqlnet.ora file is 
configured with a value in 
NAMES.DEFAULT_
DOMAIN then ensure to 
use the same domain 
while defining Database 
Name. It is required for 
KYC Batch processing. 

 This name should be 
unique 

 The same above steps to 
be done for FATCA and 
CTR. 

A restart of web and app 
servers are necessary 
whenever any changes are 
done to config schema

<SCHEMA>/ 
PASSWORD*

Enter the password of the 
schema to be created. 

Note: 

If this attribute is left 
blank, then the password 
specified in the 
<PASSWORD>/DEFAUL
T attribute is applied as 
the Schema Password.

N The maximum length 
allowed is 30 characters. 
Special characters are not 
allowed.

Note: You need to 
mandatorily enter the 
password if you have set 
the <PASSWORD>/ 
APPLYSAMEFORALL 
attribute as N.

Takes precedence over 
DEFAULT attribute value 
of <PASSWORD> tag.

Table L–2 OFS_ECM_SCHEMA_IN.XML Parameters

Tag Name/ 
Attribute Name Description

Mandat
ory 
(Y/N)

Default Value/ 
Permissible Value Comments
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<SCHEMA>/ 
APP_ID

By default, the 
Application ID is seeded 
based on the Applications 
Pack. 

Note: Do not edit this 
attribute value.

Y Unique Seeded Value Identifies the 
Application/ Product for 
which the schema is being 
created.

DO NOT modify this 
value.

<SCHEMA>/ 
DEFAULTTABL
ESPACE

Enter the available default 
tablespace for DB User.

Note: 

If this attribute is left 
blank, then USERS is set 
as the default tablespace.

N Default - USERS

Permissible - Any existing 
valid tablespace name.

Modify this value to 
associate any valid 
tablespace with the 
schema.

<SCHEMA>/ 
TEMPTABLESP
ACE

Enter the available 
temporary tablespace for 
the DB User. 

Note: 

If this attribute is left 
blank, then TEMP is set as 
the default tablespace.

N Default - TEMP

Permissible - Any existing 
valid temporary 
tablespace name.

Modify this value to 
associate any valid 
tablespace with the 
schema.

<SCHEMA>/ 
QUOTA

Enter the quota to be set 
on 
DEFAULTTABLESPACE 
attribute for the schema/ 
user. By default, the quota 
size is set to 500M.
Minimum: 500M or 
Unlimited on default 
Tablespace

N Example, 

600M/m

20G/g

UNLIMITED/unlimited

Modify this value to grant 
the specified quota on the 
mentioned tablespace to 
the user. 

SCHEMA/ 
INFODOM

Infodom Name 
Associated with each 
Atomic Schema and 
ADDON. 

Y Enter the name of the 
Information Domain to 
associate this schema.

The schema creator utility 
automatically derives an 
Information Domain 
Name based on the 
Applications Pack if no 
value is specified for this 
attribute.

Permissible length is 16 
characters and only 
alphanumeric characters 
allowed. No special 
characters allowed.

Valid string with up to 11 
characters.

Mandatory for Silent 
Installation Mode

<ADV_SEC_
OPTIONS>

Parent tag to hold 
Advance Security 
Options. 

N Uncomment the tag and 
edit if you want to add 
security options. For 
example, TDE and Data 
Redact.

For details, see the 
example following the 
table.

Table L–2 OFS_ECM_SCHEMA_IN.XML Parameters

Tag Name/ 
Attribute Name Description

Mandat
ory 
(Y/N)

Default Value/ 
Permissible Value Comments
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<ADV_SEC_
OPTIONS>/TD
E

Tag to enable/disable 
TDE.

N Default is FALSE. To 
enable TDE, set this to 
TRUE.

Ensure this tag is not 
commented if you have 
uncommented <ADV_
SEC_OPTIONS>

<ADV_SEC_
OPTIONS>/ 
DATA_
REDACT

Tag to enable/disable 
Data Redaction feature.

N Default is FALSE. To 
enable DATA_REDACT, 
set this to TRUE

Ensure this tag is not 
commented if you have 
uncommented <ADV_
SEC_OPTIONS>

<TABLESPACE
S>

Parent tag to hold 
<TABLESPACE> 
elements

N NA Uncomment the tag and 
edit. ONLY if tablespaces 
are to be created as part of 
the installation.

For details, see the 
example following the 
table.

Note: When TDE is TRUE 
in ADV_SEC_OPTIONS, 
then it is mandatory for 
the <TABLESPACES> tag 
to be present in the xml 
file.

<TABLESPACE
>/ NAME

Logical Name of 
tablespace to be created.

Y Name if specified should 
be referred in the 
<SCHEMA 
DEFAULTTABLESPACE= 
"##NAME##"> attribute.

Note the ## syntax.

<TABLESPACE
>/ VALUE

Physical Name of the 
tablespace to be created

Y NA Value if specified will be 
the actual name of the 
TABLESPACE.

<TABLESPACE
>/ DATAFILE

Specifies the location of 
the data file on the server

Y NA Enter the absolute path of 
the file to be created.

<TABLESPACE
>/ 
AUTOEXTEND

Specifies if the tablespace 
should be extensible or 
have a hard limit

Y ON or OFF Set to ON to ensure that 
the tablespace does not 
run out of space when 
full.

<TABLESPACE
>/ ENCRYPT

Specifies if the 
tablespace(s) should be 
encrypted using TDE.

Y ON or OFF Set to ON to ensure that 
the tablespaces when 
created are encrypted 
using TDE.

Table L–2 OFS_ECM_SCHEMA_IN.XML Parameters

Tag Name/ 
Attribute Name Description

Mandat
ory 
(Y/N)

Default Value/ 
Permissible Value Comments



Note: Encryption of tablespaces requires to enabling Transparent 
Data Encryption (TDE) on the Database Server.

Example: (The following snippet shows that TDE is enabled and 
hence the tablespace has been shown with encryption ON.)

<ADV_SEC_OPTIONS>

<OPTION NAME="TDE" VALUE="FALSE"/>

<OPTION NAME="DATA_REDACT" VALUE="TRUE" />

</ADV_SEC_OPTIONS>

<TABLESPACES>

<TABLESPACE NAME="OFS_ECM_DATA_CM_TBSP" VALUE="DATA_CM_TBSP" 
DATAFILE="/scratch/oraofss/app/oradata/Ti26O12L64/case_data_
01.dbf" SIZE="512M" AUTOEXTEND="OFF" ENCRYPT="OFF"/>

<TABLESPACE NAME="OFS_ECM_IDX_CM_TBSP" VALUE="IDX_CM_TBSP" 
DATAFILE="/scratch/oraofss/app/oradata/Ti26O12L64/case_idx_
01.dbf" SIZE="512M" AUTOEXTEND="OFF" ENCRYPT="OFF" />

<TABLESPACE NAME="OFS_ECM_DATA_CONF_TBSP" VALUE="DATA_CONF_
TBSP" 
DATAFILE="/scratch/oraofss/app/oradata/Ti26O12L64/conf_data_
01.dbf" SIZE="1024M" AUTOEXTEND="OFF" ENCRYPT="OFF"/>

</TABLESPACES>         

<SCHEMAS>

<SCHEMA TYPE="CONFIG" NAME="ofsaaconf" PASSWORD="" APP_
ID="OFS_AAI" DEFAULTTABLESPACE="##OFS_ECM_DATA_CONF_TBSP##" 
TEMPTABLESPACE="TEMP" QUOTA="10G"/>

<SCHEMA TYPE="ATOMIC" NAME="ofsaaecm" PASSWORD="" APP_
ID="OFS_IPE" DEFAULTTABLESPACE="##OFS_ECM_DATA_CM_TBSP##" 
TEMPTABLESPACE="TEMP" QUOTA="10G" INFODOM="ECMINFO"/>

<SCHEMA TYPE="ATOMIC" NAME="ofsaaecm" PASSWORD="" APP_
ID="OFS_NGECM" DEFAULTTABLESPACE="##OFS_ECM_DATA_CM_TBSP##" 
TEMPTABLESPACE="TEMP" QUOTA="10G" INFODOM="ECMINFO"/>

</SCHEMAS>

Configuring OFS_ECM_SCHEMA_IN.xml File
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MConfiguring OFSAAI_InstallConfig.xml File

This section gives details about the OFSAAI_InstallConfig.xml file.

Configuring OFSAAI_InstallConfig.xml file
To configure the OFSAAI_InstallConfig.xml file, follow these steps.

1. Navigate to OFS_AAAI_PACK/OFS_AAI/conf/ directory.

2. Open the file OFSAAI_InstallConfig.xml in text editor.

3. Configure the OFSAAI_InstallConfig.xml as mentioned in Table M—1:

4. You must manually set the InteractionVariable parameter values as mentioned in 
the table. If a value is not applicable, enter NA and ensure that the value is not 
entered as NULL.

Table M–1  OFSAA Infrastructure Installation Tasks and Descriptions

InteractionVariable 
Name Significance and Expected Value

Mandator
y

 <Layer name="GENERAL">

InteractionGroup name="WebServerType"

WEBAPPSERVERTYPE Identifies the web application server on which the OFSAA Infrastructure 
web components would be deployed.

The following numeric value should be set depending on the type:

• Apache Tomcat = 1

• IBM WebSphere Application Server = 2

• Oracle WebLogic Server = 3

For example, <InteractionVariable 
name="WEBAPPSERVERTYPE">3</InteractionVariable>

Yes

InteractionGroup name="OFSAA Infrastructure Server Details"

DBSERVER_IP Identifies the hostname or IP address of the system on which the 
Database Engine is hosted.

Note: For RAC Database, the value should be NA.

For example, <InteractionVariable name="DBSERVER_
IP">14.15.16.17</InteractionVariable> or  <InteractionVariable 
name="DBSERVER_IP">dbhost.server.com</InteractionVariable>

Yes

InteractionGroup name="Database Details"
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ORACLE_
SID/SERVICE_ NAME

Identifies the Oracle DB Instance SID or SERVICE_NAME

Note: The Oracle_SID value should be exactly the same as it is mentioned 
in JDBC_URL.

For example, <InteractionVariable name="ORACLE_SID/SERVICE_
NAME">ofsaser</InteractionVariable>

Yes

ABS_DRIVER_PATH Identifies the directory where the JDBC driver (ojdbc<version>.jar) 
exists. This would typically be the $ORACLE_HOME/jdbc/lib

For example, <InteractionVariable name="ABS_DRIVER_
PATH">">/oradata6/revwb7/oracle </InteractionVariable>

Note: Refer Appendix O for identifying the correct "ojdbc<version>.jar" 
version to be copied.

Yes

InteractionGroup name="OLAP Detail"

OLAP_SERVER_ 
IMPLEMENTATION

Identifies if the OFSAA Infrastructure OLAP component needs to be 
configured depending on whether you intend to use the OLAP feature. 
The following numeric value should be set depending on the choice:

• YES - 1

• NO - 0

No

Note: If value for OLAP_SERVER_IMPLEMENTATION is set to 1, it checks for following environment variables are set 
in.profile: 

ARBORPATH, HYPERION_HOME and ESSBASEPATH.

InteractionGroup name="SFTP Details"

SFTP_ENABLE Identifies if the SFTP (Secure File Transfer Protocol) feature is to be 
enabled. The following numeric value should be set depending on the 
choice:

• For SFTP -1. 

• For FTP - 0 

Yes

Note:The default value for SFTP_ENABLE is 1, which signifies that SFTP will be used. Oracle recommends using 
SFTP instead of FTP because SFTP is considered more secure. However, a client may choose to ignore this 
recommendation and to use FTP by setting SFTP_ENABLE to 0. You can change this selection later by using the 
OFSAAI administration interface.

Set SFTP_ENABLE to -1 to configure ftpshare and weblocal path as local path mounted for OFSAAI server.

FILE_TRANSFER_PORT Identifies the port used for the file transfer service. The default value 
specified is 22 (SFTP). Specify default value as 21 (FTP) if SFTP_ENABLE 
is 0.  Alternatively, this value can be any Port configured by System 
Administrators to support SFTP/FTP.

For example, <InteractionVariable name="FILE_TRANSFER_
PORT">21</InteractionVariable>

Yes

InteractionGroup name="Locale Detail"

LOCALE Identifies the locale information to be used during the installation. This 
release of the OFSAA Infrastructure supports only US English. 

For example, <InteractionVariable name="LOCALE">en_
US</InteractionVariable>

Yes

InteractionGroup name="OFSAA Infrastructure Communicating ports"

Note: The following ports are used internally by the various OFSAA Infrastructure services. The default values 
mentioned are set in the installation. If you intend to specify a different value, update the parameter value 
accordingly and ensure this port value is in the range of 1025 to 65535 and the respective port is enabled.

JAVAPORT 9999 Yes

Table M–1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

InteractionVariable 
Name Significance and Expected Value

Mandator
y
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NATIVEPORT 6666 Yes

AGENTPORT 6510 Yes

ICCPORT 6507 Yes

ICCNATIVEPORT 6509 Yes

OLAPPORT 10101 Yes

MSGPORT 6501 Yes

ROUTERPORT 6500 Yes

AMPORT 6505 Yes

InteractionGroup name="Web Details"

Note: If value for HTTPS_ENABLE is set to 1, ensure you have a valid certificate available from a trusted CA 
and the same is configured on your web application server.

HTTPS_ENABLE Identifies if the UI should be accessed using HTTP or HTTPS scheme. 
The default value set is 0. The following numeric value should be set 
depending on the choice:

• YES - 1

• NO - 0

For example, <InteractionVariable name="HTTPS_
ENABLE">0</InteractionVariable>

Yes

WEB_SERVER_IP Identifies the HTTP Server IP/ Hostname or Web Application Server IP/ 
Hostname, to be used for accessing the UI. This IP would typically be the 
HTTP Server IP. 

If no separate HTTP Server is available, the value should be Web 
Application Server IP/Hostname.

For example, <InteractionVariable name="WEB_SERVER_
IP">10.11.12.13</InteractionVariable> 

or 

<InteractionVariable name="WEB_SERVER_
IP">myweb.server.com</InteractionVariable>

No

WEB_SERVER_PORT Identifies the Web Server Port. This would typically be 80 for non SSL 
and 443 for SSL. If no separate HTTP Server exists, the value should be 
the port configured for Web Server.

Note: The port value will not be accepted as 80 if HTTPS_ENABLE  is 1 and 
as 443, if HTTPS_ENABLE  is 0.

For example, <InteractionVariable name="WEB_SERVER_
PORT">80</InteractionVariable>

No

CONTEXT_NAME Identifies the web application context name which will be used to built 
the URL to access the OFSAA applications. The context name can be 
identified from a URL as follows:

<scheme>://<host>:<port>/<context-name>/login.jsp

Sample URL: https://myweb:443/ofsaadev/login.jsp

For example, <InteractionVariable name="CONTEXT_
NAME">ofsaadev</InteractionVariable>

Yes

Table M–1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

InteractionVariable 
Name Significance and Expected Value
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WEBAPP_CONTEXT_
PATH

Identifies the absolute path of the exploded .ear file on the web 
application server.

For Tomcat, specify the Tomcat directory path till /webapps, such as 
/oradata6/revwb7/tomcat/webapps/. 

For WebSphere, enter the WebSphere path as <WebSphere profile 
directory>/installedApps/ <NodeCellName>. For example, 
/data2/test//WebSphere/AppServer/profiles/<Profile_
Name>/installedApps/aix-imfNode01Cell. Where aix-imf is Host name. 

For WebLogic, provide the WebLogic home directory path as /<WebLogic 
home directory path>/bea/wlserver_10.3

Note: For WebLogic, value specified for this attribute is ignored and 
value provided against attribute WEBLOGIC_DOMAIN_HOME is 
considered.

Yes

WEB_LOCAL_PATH Identifies the absolute path to any directory on the web application 
server that can hold temporary files being uploaded as part of the 
applications usage.

Note: In case of a clustered deployment, ensure this path and directory is 
same on all the nodes.

Yes

InteractionGroup name="Weblogic Setup Details"

WEBLOGIC_DOMAIN_
HOME

Identifies the WebLogic Domain Home.

For example, <InteractionVariable name="WEBLOGIC_DOMAIN_

HOME">/home/weblogic/bea/user_ projects/domains/mydomain

</InteractionVariable>

Yes 
Specify 
the value 
only if 
WEBSER
VERTYPE 
is set as 3 
(WebLogi
c)

InteractionGroup name="OFSAAI FTP Details"

OFSAAI_FTPSHARE_
PATH

Identifies the absolute path to the directory identified as file system stage 
area.

Note: 

• The directory should exist on the same system on which the OFSAA 
Infrastructure is being installed (can be on a separate mount).

• The user mentioned in the following APP_SFTP_USER_ID 
parameter should have RWX permission on the directory.

For example, <InteractionVariable name="APP_FTPSHARE_
PATH">">/oradata6/revwb7/ftpshare</InteractionVariable>

Yes

OFSAAI_SFTP_USER_
ID

Identifies the user who has RWX permissions on the directory identified 
under the preceding parameter APP_FTPSHARE_PATH.

Yes

OFSAAI_SFTP_
PRIVATE_KEY

Identifies the SFTP private key for OFSAAI.

For example,

<InteractionVariable name="OFSAAI_SFTP_PRIVATE_
KEY">/home/ofsaapp/.ssh/id_rsa</InteractionVariable>

By default, the value is NA, which indicates password will be prompted 
for the user <OFSAAI_SFTP_USER_ ID> for authentication.

For more information on generating SFTP Private key, see the Setting Up 
SFTP Private Key section.

No

Table M–1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

InteractionVariable 
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OFSAAI_SFTP_
PASSPHRASE

Identifies the passphrase for the SFTP private key for OFSAAI.

For example,

InteractionVariable name="OFSAAI_SFTP_PASSPHRASE">enter a pass 
phrase here</InteractionVariable>

By default, the value is NA.

If OFSAAI_SFTP_PRIVATE_KEY value is given and this is kept as NA, 
then it is assumed as empty passphrase.

No

InteractionGroup name="Hive Details"

The default value set for the interaction variables under this group is set as NA. These are required only for Hive 
Configuration.

HIVE_SERVER_PORT Identifies the port used for the file transfer service. The default value set 
is 22 (SFTP). Set this value as 21 for FTP.

For example,

InteractionVariable name="HIVE_SERVER_
PORT">22</InteractionVariable>

Yes, only 
for HIVE 
Configura
tion

HIVE_SERVER_
FTPDRIVE

Identifies the absolute path to the directory identified as file system stage 
area of HIVE server.

For example,

InteractionVariable name="HIVE_SERVER_
FTPDRIVE">/scratch/ofsaa/ftpshare</InteractionVariable>

Yes, only 
for HIVE 
Configura
tion

HIVE_SERVER_FTP_
USERID

Identifies the user who has RWX permissions on the directory identified 
under the preceding parameter HIVE_SERVER_FTPDRIVE.

For example,

InteractionVariable name="HIVE_SERVER_FTP_
USERID">ofsaa</InteractionVariable>

Yes, only 
for HIVE 
Configura
tion

HIVE_SERVER_FTP_
PROTOCOL

If the HIVE_SERVER_PORT is 21, then set value as FTP, else set it as 
SFTP.

For example,

InteractionVariable name="HIVE_SERVER_FTP_
PROTOCOL">SFTP</InteractionVariable>

Yes, only 
for HIVE 
Configura
tion

HIVE_SFTP_PRIVATE_
KEY

Identifies the SFTP private key for the HIVE server.

For example,

<InteractionVariable name="HIVE_SFTP_PRIVATE_
KEY">/scratch/testuser/.ssh/id_rsa</InteractionVariable>

By default, the value is NA, which indicates password will be prompted 
for the user <HIVE_SERVER_FTP_USERID> for authentication.

For more information on generating SFTP Private key, see the Setting Up 
SFTP Private Key section.

Yes, only 
for HIVE 
Configura
tion

HIVE_SFTP_
PASSPHRASE

Identifies the passphrase for the SFTP private key for HIVE.

For example,

<InteractionVariable name="HIVE_SFTP_

PASSPHRASE">NA</InteractionVariable>

By default, the value is NA.

If HIVE_SFTP_PRIVATE_KEY value is given and this is kept as NA, then 
it is assumed as empty passphrase.

Yes, only 
for HIVE 
Configura
tion

Table M–1 (Cont.) OFSAA Infrastructure Installation Tasks and Descriptions

InteractionVariable 
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NMigrating for Excel Upload Functionality

This section provides detailed instructions to migrate excel upload functionality.

Prerequisites
The following are the prerequisites for migration.

• "Data model in ATOMIC schemas should be same on the source and target setups

• "OFS AAI (platform) patch level version should be same on the source and target 
setups.

• "PL/SQL Developer to connect and query the database.

• "WinSCP to connect and access server file system.

Migrating Excel Upload
To migrate, follow these steps:

1. Open PL/SQL Developer and log in to the source setup's configuration (CONFIG) 
schema by entering the appropriate username and password.

2. In a new SQL window query the data of table EXCEL_MAPPING_MASTER. 

3. Open a new session in PL/SQL developer and log in to the target setup's 
configuration (CONFIG) schema by entering the appropriate username and 
password. 

4. Insert the records from Step 1 above in to this table.

5. In V_INFODOM column of EXCEL_MAPPING_MASTER table update the infodom name 
with the target infodom name.

Note: If all the mappings can work out of the single target Infodom, 
update same Infodom value across all rows. If only few mappings will 
work out of the target infodom, update the infodom value for 
selective records. Kindly note, excel upload mappings will work only 
if the target infodom has same data model entities as used in the 
mappings defined on source setup.

6. Update V_CREATED_BY column with the name of any user present in the target 
setup that has appropriate roles to perform Excel Upload tasks.



Note: It is mandatory to update values for V_INFODOM and V_
CREATED_BY columns.

Migrating Excel Upload
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7. Open WinSCP and login a new session by entering the host name, port number, 
user name and password to access the source setup. 

8. Navigate to the folder referred as FTPSHARE.

9. Copy the excel-entity mapping xml file(s) which are located in this folder 
according to their folder structure on to your desktop. For example: /ftpshare 
/STAGE/ExcelUpload/$SOURCE_INFODOM_NAME/$EXCEL_FILE_NAME.xml

Note: Actual file name of Excel Sheet is mentioned in the V_EXCEL_
NAME column of EXCEL_MAPPING_MASTER table.

10. Copy the excel templates (.xls/ .xlsx) file(s) which are located in this folder 
according to their folder structure on to your desktop. For example: 
/ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx

Note: Ignore this step if files are not present at the location.

11. Login a new session in WinSCP by entering the host name, port number, user 
name and password to access the target setup. 

12. Copy the xml file(s) from Step3 to the below location in the target setup. For 
example: /ftpshare/STAGE/ExcelUpload/$TARGET_INFODOM_NAME/$EXCEL_FILE_
NAME.xml

Note: $TARGET_INFODOM_NAME should be target setup infodom in 
which you have uploaded the appropriate data model and the name 
should be same as the V_INFODOM column value updated in EXCEL_
MAPPING_MASTER table.

13. Copy the xls/ xlsx file(s) from Step 3 to the below location in target setup. For 
example: /ftpshare/STAGE/ExcelUpload/TEMPLATE/*.xls or *.xlsx

Note: Ignore this step if files are not present at the location.
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OJDBC Jar Files

The ojdbc<version>.jar file should be copied based on the Oracle Database version 
and the supported Java (JRE/ JDK) versions. See Table O—1 for details. 

Table O–1 JDBC Jar files version details

Oracle Database 
Version

JDK/JRE Version 
Supported

JDBC Jar files specific to the 
release

12.1 or 12cR1 JDK 8,JDK 7 and JDK 8 ojdbc7.jar for JDK 7/JDK 8

ojdbc6.jar for JDK 6

11.2 or 11gR2 JDK 6 & JDK 5

JDK 7 supported in 11.2.0.3 
and 11.2.0.4 

ojdbc6.jar for JDK 7

ojdbc6.jar for JDK 6

ojdbc5.jar for JDK 5
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PUpgrading an Existing OFSAA 8.0.x Java 7 
Instance to Java 8

This section explains the configurations required to upgrade an existing OFSAA 8.0.x 
Java 7 instance to Java 8. It consists of the following topics:

• Prerequisites

• Upgrading OFSAA 8.0.x Java 7 instance to Java 8

• Configuring Web application server

• Configuring User .profile Settings

• Configuring OFSAA for New Web application server Installation

Prerequisites
The following are the prerequisites for upgrading OFSAA 8.0.x Java 7 instance to Java 
8:

• Java 8 should be installed on the OFSAA server and Web application server.

• Oracle WebLogic Server should be 12.1.3.0 or above. Download and install patch 
18729264 from http://support.oracle.com/ for the same.

Upgrading OFSAA 8.0.x Java 7 instance to Java 8
To upgrade OFSAA 8.0.x Java 7 instance to Java 8, follow these steps:

1. Configure Web application server to Java 8. For more information, see 
Configuring Web application server.

2. Configure the OFSAA instance to Java 8. For more information, see Configurations 
for Java 8. For a newly installed Web application server, see Configuring OFSAA 
for New Web application server Installation

3. Restart the OFSAA services. For more information, see the Start/Stop 
Infrastructure Services section in Appendix E

4. Generate the application EAR/WAR file and redeploy the application onto your 
configured web application server. For more information on generating and 
deploying EAR / WAR file, see Appendix D.

https://support.oracle.com/epmos/faces/MosIndex.jspx?_afrLoop=172681987651544&_afrWindowMode=0&_adf.ctrl-state=9bxcn9tmr_14
https://support.oracle.com/epmos/faces/MosIndex.jspx?_afrLoop=172681987651544&_afrWindowMode=0&_adf.ctrl-state=9bxcn9tmr_14


Configuring Web application server

P-126 Oracle Financial Services Enterprise Case Management Application Pack                  

Configuring Web application server
This section describes the changes to be made in the Web application server. 
Following are the two options to perform Web application server Configurations 
which are listed as follows:

• Upgrade the existing Web application server installation to Java 8

• Install a new instance of the Web application server with Java 8

This section consists of the following topics:

• Upgrading Oracle WebLogic Server

• Upgrading Apache Tomcat Server

Upgrading Oracle WebLogic Server 
Perform the following configurations to upgrade the existing WebLogic server 
instance to Java 8:

1. Navigate to <WLS_HOME>/Middleware/Oracle_Home/wlserver.

2. Edit the product.properties file. Set JAVA_HOME, WLS_JAVA_HOME, 
JAVAHOME properties to the new Java path and java.vm.version to the new 
Java version. For example,

JAVA_HOME=/usr/java/jre1.8.0_45

WLS_JAVA_HOME=/usr/java/jre1.8.0_45

JAVAHOME=/usr/java/jre1.8.0_45

java.vm.version=1.8.0_45

3. Navigate to <WLS_HOME>/Middleware/Oracle_Home/user_
projects/domains/<domain>/bin. Update SUN_JAVA_HOME, DEFAULT_
JAVA_HOME, JAVA_HOME in the setDomainEnv.sh file to point to the new Java 
path. For example, 

SUN_JAVA_HOME="/usr/java/jre1.8.0_45"

DEFAULT_SUN_JAVA_HOME="/usr/java/jre1.8.0_45"

JAVA_HOME="/usr/java/jre1.8.0_45"

4. Clear the Application cache. Navigate to the following path and delete the files:

<WebLogic installation location>/domains/<Domain name>/servers/<Server 
name>/tmp/_WL_user/<Application name>/qaelce/jsp_servlet

If you wish to install a new instance of the Oracle WebLogic Server, follow these steps:

1. Install Oracle WebLogic Server 12.1.3.x on Java 8.

2. Perform the configurations for the newly installed WebLogic server. For more 
information, see Configuring Resource Reference in WebLogic Application Server.

Note: While creating WebLogic Domain, the Listen Port should be 
set same as that of the existing Domain.

Note down the new Domain path to perform OFSAA Configurations.
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Upgrading Apache Tomcat Server
Perform the following configurations to upgrade the existing Apache Tomcat Server 
from Java 7 to Java 8:

1. Login to the Apache Tomcat Server as a non-root user.

2. Edit the user .profile. Update the value for JAVA_HOME from JRE 1.7 to JRE 1.8. 
For Example, 

JAVA_HOME=/usr/java/jre1.8.0_45

3. Clear the Application cache. Navigate to the following path and delete the files:

<Tomcat installation folder>/work/Catalina/localhost/<Application 
name>/org/apache/jsp

If you wish to install a new instance of the Apache Tomcat Server, follow these steps:

1. Install Apache Tomcat Server 8 with Java 8.

2. Perform the configurations for the newly installed Tomcat server. For more 
information, see Configuring Resource Reference in Tomcat Application Server.

Note: Update the Connector Port in 
/apache-tomcat-8.0.21/conf/server.xml file to that of the 
existing Tomcat instance.

Note down the new deployment path to perform OFSAA 
Configurations.

Configuring User .profile Settings
Perform the following configurations:

1. Login to the OFSAA Server as a non-root user.

2. Edit the user.profile. Update the value for PATH variable from JRE 1.7 to JRE 
1.8. For Example,

PATH=/usr/java/jre 1.8.0_45/jre

JAVA_BIN=/usr/java/jre 1.8.0_45/jre/bin

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/usr/java/jre 1.8.0_
45/jre/lib/amd64/server

Configuring OFSAA for New Web application server 
Installation

This configuration is required only if you have freshly installed Oracle WebLogic 
12.1.3 or Apache Tomcat Server 8.0. Follow these steps:

1. Modify the following parameters in the Configuration table present in the Config 
Schema with the new Domain Path in case of WebLogic or with the new 
deployment path in case of Tomcat:

• DeFiHome

• REV_IMG_PATH
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• EMBEDDED_JSP_JS_PATH

2. Login to the OFSAA Server as a non-root user.

3. Navigate to $FIC_HOME/ficweb/webroot/WEB_INF and update the following 
parameters in the web.xml file with the new Domain path in case of WebLogic or 
with the new deployment path in case of Tomcat:

• FIC_PHYSICAL_HOME_LOC

• FIC_HOME

• ICC_SERVLET_LOG_FILE

4. Navigate to $FIC_HOME/ficweb/webroot/conf and update the Domain path 
in case of WebLogic or with the new deployment path in case of Tomcat:

• OFSAALogger.xml 

• MDBLogger.xml 

• RevLog4jConfig.xml 

• RFDLogger.xml 

• ExportLog4jConfig.xml 

• RFDLogger.xml

• PR2Logger.xml
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QRemoving OFSAA

This chapter includes the following sections:

• Uninstalling OFSAA Infrastructure

• Uninstalling EAR Files in WebSphere

• Uninstalling EAR Files in WebLogic

• Uninstalling WAR Files in Tomcat

Uninstalling OFSAA Infrastructure
This section will guide you through the necessary steps to uninstall the OFSAA 
Infrastructure product.

Before you start the uninstallation process, ensure that no open connections exist to 
the OFSAA Infrastructure Config and Atomic Schemas and Infrastructure services are 
brought down.

To uninstall OFSAA Infrastructure:

1. Log in to the system as non-root user.

2. Navigate to the $FIC_HOME directory and execute the command:

./Uninstall.sh

3. Enter the password for OFSAAI Configuration Schema when prompted as shown 
in the following figure. 

Figure 2–18 Uninstalling OFSAA Infrastructure



Note: 

• Uninstallation does not remove the Infrastructure application 
from the Web application server. This has to be done manually.

• The entries in the .profile file will have to be removed manually.

• The files/ folders under the file system staging area (ftpshare) 
have to be deleted manually.

• All the Database objects from Atomic Schemas have to be 
dropped manually. 
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Uninstalling EAR Files in WebSphere
Following are the steps to uninstall any previously deployed application:

1. Open the URL in the browser window: http://<ipaddress>:<Administrative 
Console Port>/ibm/console (https if SSL is enabled). The Login window is 
displayed.

2. Login with the user id that has admin rights. 

3. Expand Applications > Application Types > WebSphere enterprise applications 
from the LHS. The Enterprise Applications window is displayed with all the 
deployed applications.

Figure 2–19 Enterprise Applications

4. Select the check box adjacent to the application to be uninstalled and click Stop.

5. Click Uninstall. The Uninstall Application window is displayed.
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Figure 2–20 Uninstall Application

6. Click OK to confirm.

7. Click Save to save the master file configuration.

Uninstalling EAR Files in WebLogic
On the machine that hosts WebLogic, perform the following steps to uninstall any 
previously deployed application:

1. Open the URL in the browser window: http://<ipaddress>:<admin server 
port>/console (https if SSL is enabled). The Login window of the WebLogic 
Server Administration Console is displayed.

2. Login with the WebLogic user credentials having administrator privileges. 

3. From the Domain Structure LHS menu, click Deployments. The Summary of 
Deployments screen is displayed.

Figure 2–21 Summary of Deployments

4. Select the check box adjacent to the application to be uninstalled and click Stop> 
Force Stop Now.

5. Click Yes in the confirmation dialog to stop the selected deployment. 
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Figure 2–22 Summary of Deployments- Messages

6. Select the check box adjacent to the application and click Delete to delete the 
selected deployment.

7. Click Yes in the confirmation dialog to remove the selected deployment from the 
domain configuration.

Uninstalling WAR Files in Tomcat
On the machine that hosts Tomcat, perform the following steps to uninstall any 
previously deployed application:

1. Comment out Context path section from server.xml file in $CATALINA_HOME/conf 
directory to avoid conflict during undeploy and re-deploy of the WAR file.

Place comment <!-- --> in between the context path section. For example:

<!-- 

<Context path ="/pr2test" 
docBase="/home/perfuser/tomcat-7.0.19/webapps/pr2test" debug="0" 
reloadable="true" crossContext="true">

<Resource auth="Container" 

name="jdbc/PR2ATM"

type="javax.sql.DataSource"

driverClassName="oracle.jdbc.driver.OracleDriver"

username="pr2atm" 

password="pr2atm" 

url="jdbc:oracle:thin:@10.184.74.99:1521:PERFTEST"

maxActive="100" 

maxIdle="30"

maxWait="10000"/>

</Context> 
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-->

Restart the Tomcat service by doing the following:

d. Login to the "Unix server" through a terminal emulator.

e. Navigate to $catalina_home/bin directory.

f. Stop the tomcat services using the command ./shutdown.sh

g. Start the tomcat services using the command ./startup.sh

2. Open the URL in a browser window: http://<IP address>:<Tomcat server 
port>. (https if SSL is enabled). The Tomcat home window is displayed. 

3. Click the Manager App. The Connect to window is displayed.

4. Login with the user credentials having admin rights. The Tomcat Web Application 
Manager window is displayed with the list of all applications deployed in Tomcat.

Figure 2–23 Tomcat Web Application Manager

5. Click the Undeploy link against the deployed Infrastructure application. A 
confirmation message is displayed on the application /Infrastructure being 
uninstalled.
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RConfiguring Transparent Data Encryption 
(TDE) and Data Redaction in OFSAA

Two features comprise Oracle Advanced Security: Transparent Data Encryption and 
Oracle Data Redaction

This section details about the configurations required in case you want to enable TDE 
or Data Redaction in OFSAA applications.

This section includes the following:

• Transparent Data Encryption (TDE)

• Data Redaction

Transparent Data Encryption (TDE)
Transparent Data Encryption (TDE) enables you to encrypt sensitive data, such as 
Personally Identifiable Information (PII), that you store in tables and tablespaces. After 
the data is encrypted, this data is transparently decrypted for authorized users or 
applications when they access this data. To prevent unauthorized decryption, TDE 
stores the encryption keys in a security module external to the database, called a 
Keystore. For more details on TDE, see the Database Advanced Security Guide. TDE 
tablespace encryption enables you to encrypt all of the data stored in a tablespace. To 
control the encryption, you use a Keystore and TDE master encryption key. Oracle 
Database supports both software keystores and hardware, or HSM-based, keystores. A 
software keystore is a container for the TDE master encryption key, and it resides in 
the software file system.

Configuring TDE During Enterprise Case Management Installation 
Using Full Installer

This section provides information on how to enable TDE (Transparent Data 
Encryption) in the database. This section consists of the following sub sections:

• Configuring a Software Keystore and Encrypted Tablespace Creation

• Running the Schema Creator Utility With Encryption

• Testing the Encryption

Configuring a Software Keystore and Encrypted Tablespace Creation
A software keystore is a container for the TDE master encryption key, and it resides in 
the software file system. You must define a location for the key in the sqlnet.ora file 
so that the database locates the keystore (one per database) by checking the keystore 

https://docs.oracle.com/cloud/latest/db121/ASOAG/toc.htm
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location in the sqlnet.ora file. After defining the location, create the keystore and 
open it. Set the TDE master key after opening it and then encrypt the data

To find whether a wallet is already existing, check the following entries:

1. The location specified by the ENCRYPTION_WALLET_LOCATION parameter in 
the sqlnet.ora file.

2. The location specified by the WALLET_LOCATION parameter in the sqlnet.ora 
file.

Encrypted tablespaces can share the default database wallet. However, Oracle 
recommends that you use a separate wallet for transparent data encryption 
functionality by specifying the ENCRYPTION_WALLET_LOCATION parameter in 
the sqlnet.ora file.

Note: NOTE: You should have proper privileges to perform the 
following actions. 

For details to configure the software keystore, perform the following steps: 

Step 1: Set the Software keystore location in the sqlnet.ora file

The first step is to designate a location for software keystore in the sqlnet.ora file. 
The Oracle Database will check the sqlnet.ora file for the directory location of the 
keystore to determine whether it is a software keystore or a hardware module security 
(HSM) keystore

Note: Ensure that the directory location which you want to set for 
software keystore exists beforehand. Preferably, this directory should 
be empty.

In a multitenant environment, the keystore location is set for the entire 
multitenant container database (CDB), not for individual pluggable 
databases (PDBs).

By default, the sqlnet.ora file is located in the ORACLE_
HOME/network/admin directory or in the location set by the TNS_
ADMIN environment variable. Ensure that you have properly set the 
TNS_ADMIN environment variable to point to the correct sqlnet.ora 
file.

To create a software keystore on a regular file system, use the following format when 
you edit the sqlnet.ora file:

ENCRYPTION_WALLET_LOCATION=

  (SOURCE=

    (METHOD=FILE)

    (METHOD_DATA=

    (DIRECTORY=<<path to keystore>>)))

Examples:

For regular file system in which the database name is orclb:

ENCRYPTION_WALLET_LOCATION=
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  (SOURCE=

   (METHOD=FILE)

    (METHOD_DATA=

     (DIRECTORY=/etc/ORACLE/WALLETS/orcl)))

When multiple databases share the sqlnet.ora file:

ENCRYPTION_WALLET_LOCATION=

  (SOURCE=

   (METHOD=FILE)

    (METHOD_DATA=

     (DIRECTORY=/etc/ORACLE/WALLETS/orcl)))

When Oracle Automatic Storage Management (ASM) is configured: 

ENCRYPTION_WALLET_LOCATION=

 (SOURCE=

  (METHOD=FILE)

   (METHOD_DATA=

    (DIRECTORY=+disk1/mydb/wallet)))

For ASM Diskgroup:

ENCRYPTION_WALLET_LOCATION=

 (SOURCE=

  (METHOD=FILE)

   (METHOD_DATA=

    (DIRECTORY=+ASM_file_path_of_the_diskgroup)))

Step 2: Create the Software Keystore

There are three different types of Software Keystores:

• Password-based Software Keystores

• Auto-login Software Keystores

• Local Auto-login Software Keystores

Perform the following steps to create a software keystore:

1. Login as sysdba or user with ADMINISTER KEY MANAGEMENT or SYSKM 
privilege.

2. Use the following command to create password-based software keystore:

CONN sys/password@serviceid AS SYSDBA

ADMINISTER KEY MANAGEMENT CREATE KEYSTORE 'keystore_location' 
IDENTIFIED BY software_keystore_password;

• keystore_location is the path of the keystore directory you want to create

• software_keystore_password is the password of the keystore that you want 
to create.

For example, to create the keystore in the /etc/ORACLE/WALLETS/orcl directory:
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ADMINISTER KEY MANAGEMENT CREATE KEYSTORE '/etc/ORACLE/WALLETS/orcl' 
IDENTIFIED BY password;

After you run this statement, the ewallet.p12 file, which is the keystore, appears in 
the keystore location.

Alternatively, you can create an Auto-Login or Local-Login Keystore to avoid 
opening the Keystore manually every time. Use the following command:

ADMINISTER KEY MANAGEMENT CREATE [LOCAL] AUTO_LOGIN KEYSTORE FROM 
KEYSTORE 'keystore_location' IDENTIFIED BY keystore_password;

LOCAL enables you to create a local auto-login software keystore. Otherwise, omit 
this clause if you want the keystore to be accessible by other computers.

After you run this statement, the cwallet.sso file appears in the keystore location.

Note: It is important to remember the master key password 
(<keystore_password>) used during creation of the keystore. There 
are no ways to retrieve the password if forgotten.

Step 3: Open the Software Keystore

Depending on the type of keystore you create, you must manually open the keystore 
before you can use it.

You do not need to manually open auto-login or local auto-login software keystores. 
These keystore are automatically opened when it is required, that is, when an 
encryption operation must access the key. If necessary, you can explicitly close any of 
these types of keystores. You can check the status of whether a keystore is open, 
closed, open but with no master key, or open but with an unknown master key by 
querying the STATUS column of the V$ENCRYPTION_WALLET view.

Note: After you open a keystore, it remains open until you manually 
close it. Each time you restart a database instance, you must manually 
open the password keystore to re-enable encryption and decryption 
operations.

Perform the following steps to open the software wallet:

1. Login as sysdba or user with ADMINISTER KEY MANAGEMENT or SYSKM 
privilege.

2. Use the following command to open password-based software keystore:

CONN sys/password@serviceid AS SYSDBA

ADMINISTER KEY MANAGEMENT SET KEYSTORE OPEN IDENTIFIED BY software_
keystore_password [CONTAINER = ALL | CURRENT];

• software_keystore_password is the same password that you used to create 
the keystore in "Step 2: Create the Software Keystore".

• CONTAINER is for use in a multitenant environment. Enter ALL to set the 
keystore in all of the PDBs in this CDB, or CURRENT for the current PDB.



Note: In a CDB, open the Keystore in the ROOT (CDB$ROOT) 
container and in all the associated PDBs, where TDE is enabled. 

You do not need to manually open auto-login or local auto-login 
software Keystores.
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Step 4: Set the Software TDE Master Encryption Key

Once the keystore is open, you can set a TDE master encryption key for it. The TDE 
master encryption key is stored in the keystore. This key protects the TDE table keys 
and tablespace encryption keys. By default, the TDE master encryption key is a key 
that Transparent Data Encryption (TDE) generates.

In a multitenant environment, you can create and manage the TDE master encryption 
key from either the root or the PDB.

Ensure that the database OPEN_MODE is set as READ WRITE. To find the status for a 
non-multitenant environment, query the OPEN_MODE column of the V$DATABASE 
dynamic view. If you are using a multitenant environment, then query the V$PDBS 
view. (If you cannot access these views, then connect as SYSDBA and try the query 
again. In order to connect as SYSKM for this type of query, you must create a 
password file for it. See Oracle Database Administrator's Guide for more information.)

Perform the following steps to set the encryption key:

1. Login as sysdba or user with ADMINISTER KEY  MANAGEMENT or SYSKM 
privilege

2. Use the following command to set the encryption key:

CONN sys/password@serviceid AS SYSDBA

ADMINISTER KEY MANAGEMENT SET KEY [USING TAG 'tag'] IDENTIFIED BY 
password [WITH BACKUP [USING 'backup_identifier']] [CONTAINER = ALL | 
CURRENT];

• tag is the associated attributes and information that you define. Enclose this 
setting in single quotation marks (' ').

• password is the mandatory keystore password that you created when you 
created the keystore in "Step 2: Create the Software Keystore".

• WITH BACKUP creates a backup of the keystore. You must use this option for 
password-based keystores. Optionally, you can use the USING clause to add a 
brief description of the backup. Enclose this description in single quotation 
marks (' '). This identifier is appended to the named keystore file (for example, 
ewallet_time_stamp_emp_key_backup.p12, with emp_key_backup being the 
backup identifier). Follow the file naming conventions that your operating 
system uses.

• CONTAINER is for use in a multitenant environment. Enter ALL to set the key in 
all of the PDBs in this CDB, or CURRENT for the current PDB.

For example, 

ADMINISTER KEY MANAGEMENT SET KEY IDENTIFIED BY password WITH BACKUP 
USING 'emp_key_backup';

Step 5: Encrypting your Data
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After completing the keystore configuration, encrypt the data. You can encrypt 
individual columns in a table or entire tablespaces. OFSAA recommends encrypting 
entire tablespaces and the description in this section covers encrypting entire 
tablespaces.

Note the following restrictions on using Transparent Data Encryption when you 
encrypt a tablespace:

• Transparent Data Encryption (TDE) tablespace encryption encrypts or decrypts 
data during read and write operations, as compared to TDE column encryption, 
which encrypts and decrypts data at the SQL layer. This means that most 
restrictions that apply to TDE column encryption, such as data type restrictions 
and index type restrictions, do not apply to TDE tablespace encryption.

• To perform import and export operations, use Oracle Data Pump.

Encrypting data involves the following steps:

1. Setting the COMPATIBLE initialization parameter for tablespace encryption

2. Setting the tablespace TDE master encryption key

3. Creating the Encrypted Tablespace

Step 1: Setting the COMPATIBLE initialization parameter for tablespace encryption

Prerequisite- You must set the COMPATIBLE initialization parameter for the database 
to 11.2.0.0 or later. Once you set this parameter to 11.2.0.0, the change is irreversible.

Perform the following steps to set the COMPATIBLE initialization parameter:

1. Log into the database instance. In a multitenant environment, log into the PDB. 

2. Check the current setting of the COMPATIBLE parameter.

For example:

Table R–1 SHOW PARAMETER COMPATIBLE

Name Type Value

Compatible String 12.0.0.0

noncdbcompatible Boolean False

3. If you want to change the COMPATIBLE parameter, perform the following steps:

1. Locate the initialization parameter file for the database instance.

UNIX systems: This file is in the ORACLE_HOME/dbs directory and is named 
initORACLE_SID.ora (for example, initmydb.ora).

2. In SQL*Plus, connect as a user who has the SYSDBA administrative privilege, 
and then shut down the database.

For example:

CONNECT /AS SYSDBA

SHUTDOWN

3. Edit the initialization parameter file to use the correct COMPATIBLE setting.

For example:

COMPATIBLE = 12.2.0.0
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4. In SQL*Plus, ensure that you are connected as a user who has the SYSDBA 
administrative privilege, and then start the database.

For example:

CONNECT /AS SYSDBA

STARTUP

5. If tablespace encryption is in use, then open the keystore at the database mount. 
The keystore must be open before you can access data in an encrypted tablespace.

STARTUP MOUNT;

ADMINISTER KEY MANAGEMENT SET KEYSTORE OPEN IDENTIFIED BY password;

ALTER DATABASE OPEN;

Step 2: Setting the tablespace TDE master encryption key

Make sure that you have configured the TDE master encryption key as shown in Step 
4: Setting the software TDE master encryption key.

Step 3: Creating the Encrypted Tablespace

After you have set the COMPATIBLE initialization parameter, you are ready to create the 
encrypted tablespace. 

Follow the instruction given in Running the Schema Creator Utility with Encryption 
section for configuring the schema creator file to create tablespaces. 

If you are enabling TDE in case of upgrade or you did not enable it during installation 
and want to enable at a later point of time, see the following reference link for details 
on manually creating encrypted tablespaces:

https://docs.oracle.com/cloud/latest/db121/ASOAG/asotrans_
config.htm#ASOAG9555

Running the Schema Creator Utility With Encryption
This section is applicable only if you want to enable TDE during installation.

Run the schema creator utility by including the encrypt=on option in the Tablespace 
tag in the <<APP PACK>>_SCHEMA_IN.xml file. You have to perform this procedure 
manually as it is not a part of the <<APP PACK>>_SCHEMA_IN.xml.TEMPLATE originally.

Following is an example for OFS _AAAI_PACK_ SCHEMA_IN.xml 

<APPPACKSCHEMA>

<APP_PACK_ID>OFS_AAAI_PACK</APP_PACK_ID>

<JDBC_URL>jdbc:oracle:thin:@<DB_Server_IP>:1521:<DB_NAME></JDBC_URL>

<JDBC_DRIVER>oracle.jdbc.driver.OracleDriver</JDBC_DRIVER>

<HOST><OFSAA_Server_IP/HOST Name></HOST>

<SETUPINFO NAME="<PREFIX_NAME>" PREFIX_SCHEMA_NAME="Y"/>

<PASSWORD APPLYSAMEFORALL="Y" DEFAULT="<PASSWORD>"/>

<TABLESPACES>

<TABLESPACE NAME="OFS_AAI_TBSP" VALUE="TS_USERS1" DATAFILE="<ABSOLUTE PATH 
to TABLESPACE>/<TABLESPACE_DATA_FILE_NAME>.dbf" SIZE="500M" 
AUTOEXTEND="OFF" ENCRYPT="ON" />

</TABLESPACES>

https://docs.oracle.com/cloud/latest/db121/ASOAG/asotrans_config.htm#ASOAG9555
https://docs.oracle.com/cloud/latest/db121/ASOAG/asotrans_config.htm#ASOAG9555
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<SCHEMAS>

<SCHEMA TYPE="CONFIG" NAME="ofsaaconf" PASSWORD="" APP_ID="OFS_AAI" 
DEFAULTTABLESPACE="##OFS_AAI_TBSP##" TEMPTABLESPACE="TEMP" 
QUOTA="unlimited"/>

<SCHEMA TYPE="ATOMIC" NAME="ofsaaatm" PASSWORD="" APP_ID="OFS_AAAI" 
DEFAULTTABLESPACE="##OFS_AAI_TBSP##" TEMPTABLESPACE="TEMP" 
QUOTA="unlimited" INFODOM="OFSAAAIINFO"/>

<SCHEMA TYPE="ATOMIC" NAME="ofsaaatm" PASSWORD="" APP_ID="OFS_IPE" 
DEFAULTTABLESPACE="##OFS_AAI_TBSP##" TEMPTABLESPACE="TEMP" 
QUOTA="unlimited" INFODOM="OFSAAAIINFO"/>

</SCHEMAS>

</APPPACKSCHEMA>

Testing the Encryption
Test the encryption by checking if a tablespace is encrypted or not. Execute the 
following query to check:

SELECT tablespace_name, encrypted FROM dba_tablespaces;

The following result is displayed, which indicates whether the TABLESPACE is 
encrypted or not   in the ENCRYPTED column:

Table R–2 

TABLESPACE_NAME           ENCRYPTED

SYSTEM No

SYSAUX No

UNDOTBS1 No

TEMP No

USERS No 

ENCRYPTED_TS                   Yes

6 rows selected.

The above example indicates TABLESPACE ENCRYPTED_TS is created with Encryption 
ON.

Configuring TDE in Case of Upgrade 
This section details about the configurations required in case you want to enable TDE 
in OFSAA applications after upgrade to OFSAA 8.0.6.0.0 version from a previous 
version. Additionally, these configurations are required in case you did not enable 
TDE during 8.0.6.0.0 installation and want to enable at a later point of time. 

1. Create a new PDB (12c)/ instance (11g) on same or different Database Server for 
TDE. For more information, see Configuring Software Keystore and Encrypted 
Tablespace Creation. 

2. Shutdown the OFSAAI Services.

3. Export all Configuration, Atomic and Sandbox Schemas as per the applications 
installed in your OFSAA instance.

For example:
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expdp SYSTEM/oracle@OFSA12C2DB  DIRECTORY=data_pump_dir 
DUMPFILE=ofsaaconf_ofsaaatm_%U.dmp filesize=2G 
SCHEMAS=ofsaaconf,ofsaaatm LOGFILE=ofsaaconf_ofsaaatm_exp.log

Note: The above command will create data dumps as files of 2GB 
size each (multiples). Any other commands/ tools as appropriate may 
be used to archive the schemas.

4. Import all schemas that are exported using the above command, into the new DB 
instance.

For example: 

impdp SYSTEM/oracle@OFSA12nDB  DIRECTORY=data_pump_dir 
DUMPFILE=ofsaaconf_ofsaaatm_%U.dmp  SCHEMAS=ofsaaconf,ofsaaatm 
LOGFILE=ofsaaconf_ofsaaatm_imp.log

Note: ?Restoring the exported dumps creates Configuration and Atomic 
Schema(s) with the same user credentials as that of the source, along with 
the existing grants. 

? If schemas are restored using a tool/ mechanism other than as mentioned 
in the Step 1 and 2, retain the user credentials of Configuration and 
Atomic Schemas same as in the Source environment, along with the 
Schema grants.

5. Provide select grants on sys.V_$parameter to view Configuration and Atomic 
Schemas of Target Environment database

For example:

Login as sys user:

SQL> GRANT SELECT ON SYS.V_$PARAMETER TO ofsaaconf;

Grant succeeded

SQL> GRANT SELECT ON SYS.V_$PARAMETER TO ofsaaatm;

Grant succeeded

6. Update .profile for ORACLE_SID environment variable with new ORACLE_SID.

7. Update JDBC URL by executing Port Changer utility. For details on how to 
execute Port Changer utility, see Changing IP/ Hostname, Ports, Deployed paths, 
Protocol of the OFSAA Instance section.

8. Navigate to the $FIC_WEB_HOME directory and execute the following command to 
trigger the creation of EAR/WAR file:

./ant.sh

9. The EAR/WAR file - <contextname>.ear/.war - is created in $FIC_WEB_HOME 
directory.

10. On completion of EAR/WAR file creation, the message "BUILD SUCCESSFUL" 
will be displayed.

11. Edit the existing Connection Pool settings to point to new JDBC URL and verify 
connections.
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12. Clear the webserver cache and redeploy the application onto your configured web 
application server.

13. Restart the OFSAA Services. For more information, refer to the Start/Stop 
Infrastructure Services section in the Oracle Financial Services Advanced 
Analytical Applications Infrastructure Application Pack Installation and 
Configuration Guide 8.0.2.0.0.

Data Redaction
OFSAA is enhanced to enable masking of sensitive data and Personal Identification 
Information (PII) to adhere to Regulations and Privacy Policies. Oracle Data Redaction 
provides selective, on-the-fly redaction of sensitive data in database query results 
prior to display by applications so that unauthorized users cannot view the sensitive 
data. The stored data remains unaltered, while displayed data is transformed to a 
pattern that does not contain any identifiable information.

Enabling Data Redaction in case of Upgrade
This section details about the configurations required in case you want to enable Data 
Redaction in OFSAA applications after upgrade to OFSAA 8.0.6.0.0 version from a 
previous version. Additionally, these configurations are required in case you did not 
enable TDE during ECM Application Pack 8.0.6.0.0 installation and want to enable at a 
later point of time.

Perform the following steps:

1. Login as SYSDBA into the database.

2. Execute the file $FIC_HOME/utility/data_security/scripts/create_data_sec_
roles.sql only once per database (PDB in case of 12c). 

3. Execute the following sql statement to find out the list of atomic users from the 
table:

select v_schema_name from aai_db_detail where V_DB_NAME <> 'CONFIG' AND 
V_DB_TYPE = 'ORACLE'

4. Execute the file $FIC_HOME/utility/data_security/scripts/grant_data_sec_
roles.sql for all atomic users found in the previous step.

5. From the Configuration window in the System Configuration module, select the 
Allow Data Redaction checkbox.

6. Run the Data Redaction utility. For more details on how to run the utility, see 
Data Redaction section under Data Security and Data Privacy chapter in OFS 
Analytical Applications Infrastructure Administration Guide 8.0.6.0.0.

http://docs.oracle.com/cd/E60058_01/PDF/8.0.2.x/8.0.2.0.0/ig_ofs_aaai_app_pack.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.2.x/8.0.2.0.0/ig_ofs_aaai_app_pack.pdf
http://docs.oracle.com/cd/E60058_01/PDF/8.0.2.x/8.0.2.0.0/ig_ofs_aaai_app_pack.pdf
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STunable Database Parameters

This appendix contains the Tunable Database Parameters.

Note: Review the Oracle recommended guidelines in setting the 
SGA_TARGET, SGA_MAX_SIZE and PGA_AGGREGATE_TARGET parameters. 
The values for these memory parameters can vary significantly based 
on database server specifications and estimated data volume. For 
values of PGA_AGGREGATE_TARGET parameters Oracle recommends that 
they be kept at a minimum of 1024 MB.

Table S–1 Database Tunable Parameters

Tunable Database Parameters Parameter Values

Category Parameter Name Type Default

Oracle 
Recomme
nded

Oracle 
Recomme
nded for 
Exadata

Parameters 
affecting 
database

creation (not

tunable 
through the

init.ora

file)

CHARACTER SET string AL32UTF8 AL32UTF8 AL32UTF8

NLS_LENGTH_
SCHEMATICS

string byte byte byte

NLS_SORT binary binary binary binary

MAXDATAFILES integer 254

MASXINSTANCES integer 1

MAXLOGFILES integer 32

MAXLOGHISTORY integer 24794

MAXLOGMEMBER
S

integer 2 4 4

REDO LOG SIZE integer 10M 3G 16G
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Parameters 
affecting I/O 
operation

DB_BLOCK_SIZE integer 2048 8192 8192

DB_FILE_
MULTIBLOCK_
READ_COUNT

integer The 
default 
value 
correspon
ds to the 
maximum 
I/O size 
that can be 
efficiently 
performed 
and is 
platform-d
ependent.

32 32

DB_FILES integer 200

DISK_ASYNCH_IO boolean TRUE

TAPE_ASYNCH_IO boolean TRUE

DB_WRITER_
PROCESSES

integer 1 4 4

Table S–1 Database Tunable Parameters

Tunable Database Parameters Parameter Values

Category Parameter Name Type Default

Oracle 
Recomme
nded

Oracle 
Recomme
nded for 
Exadata
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Parameters 
affecting  
resource 
consumption 
and parallel 
operations

FAST_START_
PARALLEL_ROLLB 
ACK

string LOW HIGH HIGH

LOG_BUFFER integer 7M 10000000 10000000

LOG_
CHECKPOINT_
INTERVAL

integer 0 10000 10000

LOG_
CHECKPOINT_
TIMEOUT

integer 0 0 0

OPEN_CURSORS integer 50 4096 4096

PARALLEL_
EXECUTION_
MESSAG E_SIZE

integer 2148 16384 16384

PARALLEL_MAX_
SERVERS

integer 10 * No of 
CPUs

Set if you 
are 
configuring 
DOP 
manually at 
site and 
PARALLEL
_DEGREE_
POLICY is 
set to 
MANUAL.

Do not set 
or change

PARALLEL_MIN_
SERVERS

integer 0 Set if you 
are 
configuring 
DOP 
manually at 
site and 
PARALLEL
_DEGREE_
POLICY is 
set to 
MANUAL.

Do not set 
or change

PROCESSES integer 150 600 600

LARGE_POOL_
SIZE

integer 0 512M

PARALLEL_MIN_
PERCENT

integer 0 Set if you 
are 
configuring 
DOP 
manually at 
site and 
PARALLEL
_DEGREE_
POLICY is 
set to 
MANUAL.

Do not set 
or change

PARALLEL_
THREADS_PER_
CPU

integer 2

Table S–1 Database Tunable Parameters

Tunable Database Parameters Parameter Values

Category Parameter Name Type Default

Oracle 
Recomme
nded

Oracle 
Recomme
nded for 
Exadata
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Additional 
needed 
parameters

OPTIMIZER_MODE string ALL_
ROWS

ALL_
ROWS

ALL_
ROWS

COMPATIBLE string 11.2.0 (for 
Oracle 
11gR2)

11.2.0 .3.0(if 
using 
Oracle 
11.2.0.3.0) 
otherwise 
11.2.0.2.0

GLOBAL_NAMES string FALSE TRUE TRUE

PRE_PAGE_SGA string FALSE TRUE TRUE

UNDO_
MANAGEMENT

string AUTO AUTO AUTO

UNDO_
TABLESPACE

string Set as Per 
Site Values

Set as Per 
Site Values

UNDO_
RETENTION

integer 900 10800 18000

TIMED_
STATISTICS

boolean TRUE TRUE TRUE

OPTIMIZER_
INDEX_CACHING

integer 0

OPTIMIZER_
INDEX_COST_ADJ

integer 100 30

QUERY_REWRITE_
ENABLED

string TRUE FALSE FALSE

STAR_
TRANSFORMATIO
N_ENABLED

string FALSE FALSE FALSE

Table S–1 Database Tunable Parameters

Tunable Database Parameters Parameter Values

Category Parameter Name Type Default

Oracle 
Recomme
nded

Oracle 
Recomme
nded for 
Exadata
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TFAQs and Error Dictionary

This section of the document consists of resolution to the frequently asked questions 
and error codes noticed during OFSAAI installation.

• Frequently Asked Questions

• Error Dictionary

OFSAAI installer performs all the pre-requisite validation check during installation. 
Any errors encountered in the process is displayed with an appropriate Error Code. 
You can see the Error Dictionary to find the exact cause and resolution to rectify the 
error.

Frequently Asked Questions
You can see the Frequently Asked Questions which has been developed with the 
interest to help you resolve some of the OFSAAI Installation and configuration issues. 
This intends to share the knowledge of problem resolution to a few of the known 
issues. This is not an official support document and just attempts to share the 
knowledge of problem resolution to a few of the known issues. 

This section includes the following topics: 

• OFSAAI FAQs

• Applications Pack 8.0.6.0.0 FAQs

• Forms Framework FAQs

OFSAAI FAQs
What are the different components that get installed during OFSAAI?

The different components of OFSAAI are illustrated in Figure 1—2, "Components 
of OFSAAI".

What are the different modes of OFSAAI installation?

OFSAAI can be installed in Silent mode.

Can the OFSAA Infrastructure components be installed on multi-tier?

No. OFSAA Infrastructure components (ficapp, ficweb, ficdb) cannot be installed on 
multi-tier. By default, they will be installed on single-tier. However, OFSAA 
Infrastructure can be deployed within the n-Tier architecture where the Database, Web 
server and Web application server is installed on separate tiers.

Is JDK (Java Development Kit) required during installation of OFSAA? Can it be 
uninstalled after OFSAA installation?
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JDK is not required during installation of OFSAA and only a run time is needed 
for details. See Hardware and Software Requirements, Java Runtime Environment 
section.

Is JRE required during installation of OFSAA? Can it be uninstalled after OFSAAI 
installation?

Only JRE (Java Runtime Environment) is required during installation of OFSAA 
and cannot be uninstalled as the JRE is used by the OFSAA system to work.

How do I know what is the Operating system, webservers and other software versions 
that OFSAA supports?

See OFSAA Technology Stack Matrices.

What are the different files required to install OFSAAI?

The following files are required:

• setup.sh

• envCheck.sh

• preinstallcheck.sh

• VerInfo.txt

• OFSAAInfrastructure.bin

• validatedXMLinputs.jar

• MyResources_en_US.properties

• log4j.xml

• OFSAAI_PostInstallConfig.xml

• OFSAAI_InstallConfig.xml

• privileges_config_user.sql

• privileges_atomic_user.sql

• XML_Utility.jar

What should I do if I get the following error message during installation, "Execute 
Permission denied"?

Please check whether all the files provided for OFSAAI installation has execute  
permissions. 

To give execute permissions,

• Navigate to the path OFSAAI_80000 and execute the command

chmod 755

"Graphical installers are not.."

If error resembles "Graphical installers are not supported by the VM. The console 
mode will be used instead..." then check whether any of the X-windows software 
has been installed.

Example: Hummingbird Exceed is started and configured to Graphical mode 
installation.

Note: Type 'xclock' from prompt and this should display clock in 
graphical mode.

http://docs.oracle.com/cd/E55339_01/homepage.htm
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"No Java virtual machine could be…"

If the error message reads "No Java virtual machine could be found from your 
PATH environment variable. You must install a VM prior to running this 
program", then 

• Check whether "java path" is set in PATH variable. See the Table 3—1, 
" Prerequisite Information"section in this document.

• Check whether sufficient temporary space is available.

• Ensure that the movement of OFSAAI Installer text files to the target system is 
done in the Text mode so that setup.sh file does not contain control line feed 
characters (^M).

What should I do if I get the following error message during installation, 
"OracleDriver Files Not Found, Please Choose the Right Path To Continue"?

Check whether the provided path for Oracle Driver files is correct and whether the 
user has permissions to access the files.

What should I do if I get the following error message during installation, "User must 
have CREATE TABLE, CREATE VIEW, CREATE TRIGGER, CREATE INDEX, 
CREATE SEQUENCE, CREATE PROCEDURE" even though the oracle schema user 
created has the mentioned privileges?

OFSAAI installer validates the database details provided during installation, so 
ensure:

• Whether the oracle schema user has the required set of privileges for 
successful installation.

• Whether the oracle schema user has been created with quota privileges on 
tablespace to create database objects.

• See the Table 3—1, " Prerequisite Information" section in this document.

Installation of OFSAAI was completed successfully! What next?

Post the successful completion of OFSAAI installation, one has to perform the Post 
Installation steps. See Chapter 5, "Post Installation Configuration". 

What is to be done when OFSAAI Installation is unsuccessful?

OFSAAI installer generates log file OFSAAInfrastructure_Install.log in the 
Infrastructure Installation Directory. There is also another log file created in the 
path configured in Log4j.xml. The logs of any of these reported, Warnings/Non 
Fatal Errors/Fatal Errors/Exceptions should be brought to the notice of the 
OFSAAI Customer Support. It is recommended not to proceed, until the reported 
problems are adequately addressed.

How do I completely uninstall OFSAAI?

OFSAAI can be completely uninstalled by performing the steps provided in 
Uninstalling OFSAA Infrastructure in the OFS AAAI Installation and 
Configuration Guide Release 8.0.6.0.0.

Can OFSAAI config and atomic schemas be on different databases?

OFSAAI requires both config and atomic schemas to be present on the same 
database instance. 

How to grant privileges if a new information domain is created?

If you are creating a new information domain, provide a set of privileges (database 
permissions) to the new Atomic schema.
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• Log into the database as sys and connect as sysdba user.

• Execute the file privileges_config_user.sql available under $FIC_HOME 
directory

• Enter the database schema for which you want to grant privileges.

When should I run the MLS utility?

See the Multiple Language Support (MLS) Utility section in OFS AAI 
Administration Guide available on OTN.

Does OFSAAI support Oracle Linux versions other than 5.5?

OFSAAI supports the Oracle Linux versions from 5.5 up to 5.10 and also from 6.0 
and above.

What should I do if I get the following error message on the UNIX System terminal 
while executing ./setup.sh, "Insert New Media. Please insert Disk1 or type its 
location"?

1. Login as root user on the Unix machine where OFSAAI is getting installed.

2. Navigate to the path /etc/security/. 

3. Edit the file limits.conf to add/edit a row for the unix user installing 
OFSAA:

<Unix User> soft nofile 9216

4. After saving the changes, log in as unix user with which OFSAAI is getting 
installed and execute the command:

ulimit -n

The command should return the value 9216.

How do I verify if the system environment is ready for OFSAAI installation?

To verify the system environment meets the minimum requirements for the 
installation, a Pre-Install Check utility is available within the Install Kit archive 
file. This utility can also be obtained separately by contacting Oracle Support 
Services.

See Verifying System Environment section for additional information. 

How do I know if  the installation is completed successfully? 

The OFSAA Infrastructure installation performs a post install health check 
automatically on successful installation of the product. To rerun the post install 
verification at a later time, perform the following steps:

1. Navigate to the path $FIC_HOME (Product Installation Directory).

2. Execute the command:

./piverify.sh

What should I do if I get the following error message during OFSAAI installation on 
Solaris 11 system?:

"Error: OFSAAI-1108

ORA-00604: error occurred at recursive SQL level 1

ORA-01882: timezone region not found"

Or

http://docs.oracle.com/cd/E60058_01/homepage.htm
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"Time zone cannot be set as null or 'localtime' "

This happens if the time zone is not set, that is NULL or it is set as ’localtime’. Set 
the environment variable TZ to a valid time zone region in the .profile file. For 
example, 

TZ=Asia/Calcutta

export TZ

What should I do if there are any exceptions or errors in installation and how to 
proceed?

1. Please backup the installation logs.

2. Share the backup logs with Oracle support.

What should I do if the installation process is abruptly terminated or aborted?

If the installation is abruptly terminated, then the installation process will be 
incomplete. To recover from this, follow the below steps:

1. Drop the DB objects in the config schema created by OFSAAI installation.

2. Open the .profile and remove the entries made by the OFSAAI installation 
which are made between the comment statements, #Beginning of entries by 
OFSAA Infrastructure installation and #End of entries by OFSAA 
Infrastructure installation.

3. Delete the OFSAA install directory created by the OFSAAI installer.

4. Perform the OFSAAI installation again. 

Does OFSAA support any other web server types, other than the ones stated in tech 
matrix and installation guide?

No, all the supported softwares and versions are stated in the  OFSAA Technology 
Stack Matrices. 

What should I do if the database connection from connection pool displays the 
following error message, "java.sql.SQLRecoverableException: IO Error: Connection 
reset"?

This happens while running several database intensive tasks in parallel. To correct this 
error, add the line securerandom.source=file:/dev/./urandom in the java.security 
configuration file available in $JAVA_HOME/jre/lib/security/ path.

Note: This needs to be configured on all the machines or VMs where 
the OFSAAI components are installed.

If the issue is not resolved even with the above settings, check the MTU(Maximum 
Transmission Unit) settings on the linux box. For details on MTU settings and 
updating them, contact your system Administrator.

What should I do when I get syntax errors/file not found error messages while 
invoking setup.sh file from my install archive?

This could mostly  happen:

• When installer was not unzipped rightly or corrupted during unzip.

• setup.sh file which resides within the install archive was  not transferred in 
ASCII or text mode, which could have corrupted the file.

http://docs.oracle.com/cd/E55339_01/homepage.htm
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To correct this, follow the steps:

1. Copy the installer (in BINARY mode) to the system on which the OFSAA 
Infrastructure components will be installed.

2. Unzip the installer using the command:

unzip <OFSAAI_Installer>.zip

3. The corrupted setup.sh file would have introduced certain ^M characters into 
the file.  You can remove ^M characters from setup.sh file by following the 
below steps:

Note: To enter ^M, hold the CTRL key then press V and M in 
succession.

a. Login to the server where the installer is copied.

b. Navigate to the directory OFSAAI_80000.

c. Open the setup.sh file in the vi editor using the command: vi setup.sh.

d. Inside vi editor in Esc mode, type: %s/^M//g 

e. Save the setup.sh file by typing: wq!

Does OFSAA support Oracle DB 11g Standard edition?

The OCI client and the jdbc driver does not change depending on whether it is a 
standard or enterprise edition. So, OFSAAI will work with standard edition as 
well.

We do not recommend standard edition because it will not scale and does not 
support partition pack, database security vault, or advanced analytics.

What should I do if I get the following error message while executing ./startofsaai.sh  
file on the UNIX System terminal "./startofsaai.sh: /java: Execute permission denied"?

• Ensure JAVA_BIN environment variable path is set on the "unix user" 
terminal from where the ./startofsaai.sh file is invoked.

• Ensure the .profile where the environment/ path settings are made has 
been executed successfully.

What should I do if the OFSAAI Login page does not open and I get the following 
error message, "Could not retrieve list of locales"?

This could be due to 2 reasons:

• System is unable to resolve the hostname configured.

• Conflict with the ports configured.

To correct them, follow the below steps:

A. Steps to replace the hostnames with IP address: 

1. Stop all the OFSAA services. For more information, see Stopping 
Infrastructure Services.

2. Replace all the hostnames with the IP address in all the places mentioned in 
the document (Where to find port, IP address, HTTPS Configuration for 
OFSAAI 7.2 Installation (DOC ID 1500479.1)).

https://mosemp.us.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=1759065458063714&id=1500479.1&_adf.ctrl-state=j420nfs72_21
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3. Restart all the OFSAAI services. For more information, see Starting 
Infrastructure Services section.

B. Steps to correct the port number conflicts

1. Stop all the OFSAA services.

2. See the port numbers stated in the document (Where to find port, IP address, 
HTTPS Configuration for OFSAAI 7.2 Installation (DOC ID 1500479.1)) and 
check on the discrepancy in the port numbers and correct them.

3. Restart all the OFSAAI services.

What happens when the OFSAAI Application Server does not proceed even after 
providing the system password?

Ensure that, the System Password provided when prompted should match with 
the "Oracle Configuration password" provided during installation. Also check 
whether the connection to the "configuration schema" can be established through 
sqlplus.

Although the OFSAAI installation has completed successfully, when OFSAAI servers 
are started, and the application URL is accessed, it gives an error message "the page 
cannot be found or displayed" or "Could not retrieve list of languages from Server. 
Please contact the system administrator". What should one do?

Ensure OFSAAI servers have been started and are running successfully. On the 
server start up parameters options, see Starting Infrastructure Services section.

For more details on the issue, see the Revappserver log in $FIC_APP_ 
HOME/common/FICServer/logs directory or the Web server log files.

Is it necessary to provide the specified grants to the Oracle schema user before 
installation? If yes, can it be revoked after completing the installation?

The "Oracle schema" user requires the necessary grants specified before, during, 
and after the installation process. Grants provided should never be revoked as the 
application makes use of these grants all the time.

Can we have distributed OFSAAI Application Server for load balancing?

OFSAAI Application server can be scaled out/distributed across different JVM's 
(machines) based on the various services and Information Domains, in other 
words, Load balancing could be achieved with distribution of services.

Why do we need Ftpshare on all the layers? Can we have ftpshare on another machine 
other than the machines where OFSAAI is installed?

Ftpshare is a Metadata Repository directory. All the metadata related files used in 
Infrastructure are stored in the ftpshare directory. The ftpshare contains folders for 
each Information Domain, with each Information Domain folders holding Erwin, 
log, and scripts folder. The transfer of data among the Web, Application, and 
Database servers in Infrastructure takes place through FTP/SFTP.

You need to configure FTP/SFTP and enable communication between the servers 
by providing App server's FTP/SFTP credentials to the Web server and DB server 
users.

Yes, we can have ftpshare on another machine other than the machines where 
OFSAAI is installed.

Is it mandatory to provide the ftp/sftp password? 

Yes, OFSAAI needs credentials of the user which has complete permissions on 
ftpshare directory, and should be able to independently login to the unix server.

https://mosemp.us.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=1759065458063714&id=1500479.1&_adf.ctrl-state=j420nfs72_21
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What are the permissions required for ftpshare and when should I give them?

It is recommended to provide permissions on ftpshare in case of installations done 
across different machines or VMs (multitier installation).

In case of single tier installation, 770 permissions can be provided if the unix users 
of OFSAAI and web server belong to the same unix group.

And on any new file that is created in the 'ftpshare' folder of any installation layer 
should be granted specific/explicit permission.

Port Change utility could be used to have the Port number modified, which are 
currently being used by the Infrastructure application. For more information, see 
Changing IP/ Hostname, Ports, Deployed Paths of the OFSAA Instance section.

Are there any in-built system administration users within OFSAAI Application?

The three in-built system administration users are provided to configure and setup 
OFSAAI.

• SYSADMN 

• SYSAUTH

• GUEST 

Does OFSAAI Application support both FTP and SFTP?

OFSAAI supports both FTP and SFTP configuration.

Is it necessary to enable the FTP/SFTP services to use the OFSAAI?

Yes, enabling of FTP/SFTP services and its ports is a pre-requisite step towards 
using the OFSAAI.

OFSAAI Configuration: Unable to save the server details?

• Ensure the input User ID, Password, and Share Name are correct.

• Ensure FTP/SFTP services are enabled.

• Have a test FTP/SFTP connection made and confirm if they are successful.

What should I do if I get the following message while creating Information Domain, 
"Please create a database and then create the information domain"?

Information Domain is mapped to only one Database; and thus before the creation 
of Information Domain, at least one database details would need to exist.

What should I do if I get the following message during startup of backend engine 
message server, "ConnectToDatabase: FatalError, could not connect to the DB server"?

Verify whether connection to the "configuration schema" can be established through 
sqlplus.

• Verify "configuration schema" password is modified post installation.

• Ensure oracle database alias name created for oracle instance and oracle 
service name are same.

• On a multi tier Installation mode, ensure TNSNAME and SID are the same in 
both the Application and Database Layers.

What should I do if I get the following message during the startup of backend engine 
message server, "Fatal Error, failed to get user ID from LibSmsConnect"?

Ensure Reveleus.sec file exist under the $FIC_HOME/conf directory where the 
Database components are installed.
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Does OFSAAI Application support LDAP authentication?

OFSAAI supports LDAP configuration and authentication.

Does OFSAAI support multiple languages?

Yes, OFSAAI supports multiple languages.

Does OFSAAI provide any data back-up features?

OFSAAI does not have built-in back up facility. External Storage Infrastructure is 
recommended for back-up.

What kind of security features does the OFSAAI provide?

OFSAAI provides security at:

• Segment Level - Users can access only the segment they are mapped to.

• Application Level - Users can perform an operation only if mapped to 
appropriate role and functions.

Does OFSAAI have the ability to enforce periodic password change?

OFSAAI provides configurable parameters to define number of days after which 
the user password would expire and then the user is forced to change the 
password after expiration period.

What is the password policy followed in OFSAAI?

OFSAAI enforces a minimum password length with a combination of Upper and 
Lower case characters and alpha-numeric strings.

Which version of Erwin Data Modeler does OFSAAI support?

OFSAAI framework supports Data Modeler Erwin versions 9.0, 9.2, 9.6, and 9.7 for 
backward compatibility. However, the data models shipped with version 8.0.6.0.0 of 
the application packs are compatible with Erwin 9.5, 9.64, and 9.7.

Does OFSAAI provide the mechanism to upload Business Data model?

OFSAAI provides two mechanisms for business data model upload:

• Easy to use GUI based Model upload mechanism to upload the Business Data 
Model through Unified Metadata Manager --> Import Model.

• OFSAAI also provides a model upload utility "upload.sh" for uploading the 
business data model through the command line parameter by executing this 
shell script file under the path <FIC_HOME>/ficapp/common/FICServer/bin.

See the section Run Model Upload Utility of the OFS Analytical Applications 
Infrastructure User Guide available on OTN for details.

How do I apply incremental change to the existing model when the Business Data 
model undergoes a change?

Modified data model can be uploaded into the system and OFSAAI has the ability 
to compare the changes within the data model with respect to the one already 
present in the system and enables propagation of incremental changes in a 
consistent manner.

What are the different types of uploading a business data Model? 

OFSAAI supports uploading of business data model from client desktop and also 
by picking up the data model from the server location.

Can the OFSAAI "Configuration Schema" password be modified post installation?

http://docs.oracle.com/cd/E60058_01/homepage.htm
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The OFSAAI "configuration schema" password can be modified post installation. 
OFSAAI application stores the password in the database and few configuration 
files, thus any changes to the "configuration schema" password would necessitate 
updating in these. Contact OFSAAI support for more details.

Can the OFSAAI "Atomic  Schema" password be modified?

The OFSAAI "Atomic Schema" password can be modified. OFSAAI application 
stores the atomic schema password in the database and few configuration files, 
thus any change to the atomic schema password would necessitate updating the 
password.

To change the Atomic Schema password, follow the steps:

1. Login to OFSAA.

2. Navigate to System Configuration > Database Details window. Select the 
appropriate connection, provide the modified password and save.

3. Navigate to Unified Metadata Manager > Technical Metadata> Data 
Integrator > Define Sources window. Update the appropriate Source details.

a. If you are using Apache Tomcat as Web server:

* Update the <Context> -> Resource tag details in server.xml file from the 
$CATALINA_HOME/conf folder. (In case of Tomcat only Atomic <Resource> 
will exist).

b. If you are using WebSphere as Web server:

* Login to the WebSphere Administration Console from the left side menu.

* Navigate to Resources >JDBC >Data Sources. A list of data sources will be 
populated on the right side.

* Select the appropriate Data Source and edit the connection details. (In this 
case, both Config and Atomic data sources need to be modified).

c. If you are using WebLogic as Web server:

* Login to the WebLogic Administration Console from the left side menu.

* Under Domain Structure list box, expand the appropriate Domain and 
navigate to Services > JDBC >Data Sources. A list of data sources will be 
populated on the right side.

* Select the appropriate Data Source and edit the connection details. (In this 
case, both Config and Atomic data sources need to be modified).

4. Restart the OFSAAI services

Note: If the modified passwords are not updated, OFSAAI logs 
displays the message ORA-28000: the account is locked.

 Does the upload of Business Data model depend on Java Memory?

Business data model upload through OFSAAI depends on the Java memory 
settings on the client and server machines. Java memory setting varies with the 
data model size and the available RAM. Contact OFSAAI support for more details.

Why do the Business Metadata Management screens (Business Processors screen) in 
the User Interface, take more time to load than other screens?
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The Log file in DynamicServices.xml which resides in $FIC_HOME/conf is 
continuously being updated/refreshed to cache metadata. This can be observed 
when you are starting startofsaai.sh and if any of the log file (Ex: 
SMSService.log) in DynamicServices.xml is being continuously refreshed for 
longer time.

By default, the Metadata Log file cache size is set to 1000. If in case the log is being 
updated beyond this limit, retrospectively the preceding entries are overwritten. 
For example, the 1001th entry is overwritten by deleting the first entry. This 
results in the application screen taking a longer time to load.

Increase the cache size limit in Dynamicservices.xml located at <FIC_HOME>/conf, 
depending on the currently logged count for the specific metadata.

1. Generate the Log report by executing the below query in config schema.

select count(1), t.metadata_name, m.dsn_id

from metadata_master m, metadata_type_master t 

where m.metadata_type = t.metadata_type

group by t.metadata_name, m.dsn_id

2. The above query returns a list of codes with their respective metadata count. 
You can see "metadata_type_master" table to identify the metadata name.

3. View the log report to identify the metadata which is being 
updated/refreshed beyond the specified cache size limit. Accordingly increase 
the cache size limit in Dynamicservices.xml depending on the currently 
logged count for the specific metadata.

For example, if the "MEASURE_CACHE_SIZE" is set to 1000 and total 
measure reported in log is 1022, increase the limit to 2000 (approximately).

4. Restart Reveleus/OFSAAI servers (Web and APP) and check the issue.

What should I do if I get OutOfMemoryError while deploying EAR file in WebSphere 
application server?

The Java memory needs to be increased in ejbdeploy.sh file which is present 
under <WebSphere Install directory>/AppServer/deploytool/itp. For 
example, 

$JAVA_CMD \

-Xbootclasspath/a:$ejbd_bootpath \ 

Xms256m -Xmx1024m \

What configurations should I ensure if my data model size is greater than 2GB?

In order to upload data model of size greater than 2GB in OFSAAI Unified 
Metadata Manager- Import Model, you need to configure the required model size 
in struts.xml file available in the path $FIC_WEB_
HOME/webroot/WEB-INF/classes.

Note: The size requirements have to be always specified in bytes.

For example, if you need to configure for model size of 2.5GB, then you can 
approximately set the max size to 3GB (3221225472 bytes) as indicated below, in 
order to avoid size constraints during model upload.
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<constant name="struts.multipart.maxSize" value="3221225472"/>

After configuring struts.xml file, generate the application EAR/WAR file and 
redeploy the application onto your configured web application server. For more 
information on generating and deploying EAR / WAR file, see Appendix D.

What should I do if my Hierarchy filter is not reflecting correctly after I make changes 
to the underlying Hierarchy?

In some cases, the Hierarchy Filters do not save the edits correctly if the 
underlying Hierarchy has been changed. This can occur in hierarchy maintenance, 
where you have moved a member to another hierarchy branch, and that member 
was explicitly selected in the Filter and is now a child of a node which is already 
selected in the Filter.

See Support Note for the workaround.

Can I install an Applications Pack on an existing Atomic schema/ Information 
Domain created manually?

No, you cannot install an Applications Pack on existing Atomic schema/Information 
Domain created manually. Applications Packs can be installed only on Atomic 
Schemas/Information Domain created using schema creator utility and/ or the 
Applications Pack installer.

What should I do if I get the following exception while trying to view the model 
outputs in Model Outputs screen, "Exception ->Local Path/STAGE/Output file name 
(No such file or directory)"?

Ensure you have created a folder "STAGE" under the path mentioned as "Local Path" 
in the web server details screen. This folder needs to be created under the local path on 
every node, in case of web application server clustering.

What should I do if I get the following exception during OFSAA services startup, 
"Exception in thread "main" java.lang.UnsatisfiedLinkError: net (Not a directory)"?

Ensure the JRE referred in .profile is not a symbolic link. Correct the path reference to 
point to a physical JRE installed.

What is the optimized memory settings required for "New" model upload?

The following table lists the optimized memory settings required for "New" model 
upload.

Table T–1 Optimized Memory Settings for New Model Upload

Model Upload Options
Size of Data Model 
XML File

X_ARGS_APP ENV 
Variable in OFSAAI 
APP Layer

Pick from Server 106 MB "-Xms1024m 
-Xmx1024m

36 MB "-Xms2048m 
-Xmx2048m

815 MB "-Xms4096m 
-Xmx4096m

1243 MB "-Xms6144m 
-Xmx6144m

https://mosemp.us.oracle.com/epmos/faces/DocumentDisplay?id=1586342.1
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I did not enable OFS Inline Processing Engine Application license during the 
installation. However, I have enabled it post installation, using the Manage OFSAA 
Product License(s) in the Admin UI. Are there any other additional configurations 
that I need to do?

Yes. Follow the instructions explained in the OFS Inline Processing Engine 
Configuration Guide available on OTN.

I get an error when I try to build an Oracle OLAP cube. What should I do? 

Execute the below grant on the appropriate ATOMIC schema 
grant olap_user to &database_username

How do you turn off unused Information Domains (Infodoms) from caching?

Follow these steps to turn off unused infodoms from caching:

1. Navigate to $FIC_HOME/conf in the APP layer of your OFSAAI installation.

2.  In the DynamicServices.xml file, identify the section for <Service code="20">. 

3. Modify the value of parameter CACHE_ON_STARTUP to 0 (default is 1). 

Repeat the same in the WEB layer too. Generate the application EAR/WAR file 
and redeploy the application onto your configured web application server. For 
more information on generating and deploying EAR / WAR file, see Appendix D.

4. Restart the OFSAAI Services (APP and WEB). For more information, see the 
Starting / Stopping Infrastructure Services. section

Note: This setting helps cache the Infodom metadata only for the 
infodoms that get accessed after user login. Infodoms which are not 
accessed, are not cached. 

Sample code is as follows: 

Model Upload Utility 106 MB "-Xms1024m 
-Xmx1024m"-Xms2048
m -Xmx2048m

336 MB "-Xms4096m 
-Xmx4096m

815 MB "-Xms4096m 
-Xmx4096m

1243 MB "-Xms6144m 
-Xmx6144m

Save New Erwin File In 
Server

106 MB "-Xms1024m 
-Xmx1024m

336 MB "-Xms2048m 
-Xmx2048m

"-Xms4096m 
-Xmx4096m

"-Xms6144m 
-Xmx6144m

Table T–1 Optimized Memory Settings for New Model Upload

Model Upload Options
Size of Data Model 
XML File

X_ARGS_APP ENV 
Variable in OFSAAI 
APP Layer

http://docs.oracle.com/cd/E60058_01/homepage.htm
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<SERVICE CODE="20" 

CLASS="com.iflex.fic.metadata.services.MetadataServiceProvider" NAME="BMD" 

SERVERID="DEFAULT" PATH=" " LOGGERNAME="UMMLOGGER" LOGGERLEVEL="10"> 

<PARAMETERS> 

<PARAMETER NAME="CACHE_ON_STARTUP" VALUE="0" /> 

<PARAMETER NAME="BACKUP_XML" VALUE="1" /> 

<PARAMETER NAME="MAX_BACKUP_XML" VALUE="2" /> 

<PARAMETER NAME="PC_NONBI_BI_SWITCH" VALUE="2048" /> 

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000" /> 

<PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="MEASURE_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHY_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DIMENSION_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="HIERARCHYATTRIBUTE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="RDM_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" VALUE="2000" /> 

<PARAMETER NAME="DERIVEDENTITY_CACHE_SIZE" VALUE="1000" /> 

<PARAMETER NAME="LOG_GET_METADATA" VALUE="false" /> 

<PARAMETER NAME="METADATA_PARALLEL_CACHING" VALUE="0" /> 

</PARAMETERS> 

</SERVICE>

While creating an Excel Mapping, after specifying the excel worksheet, the target 
table, and mapping each column in the worksheet to a target table, I click SAVE and 
nothing happens. But when I click CANCEL, a message pops up informing me that all 
changes will be discarded", what is to be done?

Check if the excel mapping creation is done using I.E 8 with JRE 1.4 plug in enabled on 
machine. If so, upgrade the JRE plug in to 1.7+.

Can Multiple OFSAA Infrastructure instances share the same config schema?

No, only one OFSAA environment can be installed using one config schema.

Can Atomic schema be shared?

Yes, it can be shared between two OFSAA instances.

While setting a firewall, which ports should be opened for communication between 
the Web server (Apache HTTP Server/ Oracle HTTP Server/ IBM HTTP Server) and the 
Web application server  (WebSphere/ WebLogic/ Tomcat) for OFSAAI to operate 
properly?

The OFSAA Servlet port which is same as Web server port should be open. Also the 
web application port should be open.
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Can I modify the NLS_LENGTH_SEMANTICS to BYTE from CHAR for the Database 
where older versions of OFSAA is Installed?

Yes, NLS_LENGTH_SEMANTICS can be modified to BYTE from CHAR if you are not 
intending to use multi language support.

Can I install already installed application in a different infodom?

No, it is not possible to install the same application in two different infodoms.

How can I configure the OFSAA application for High Availability?

OFSAA can have active-passive high availability. For more details, see Configuring 
OFSAA in Clustered Environment Guide.

During OFSAA installation should I provide web application server's IP /Hostname 
and port or web server's IP/Hostname and port, if the Apache HTTP Server/ Oracle 
HTTP Server/ IBM HTTP Server are configured?

In case the web server is configured, you should enter the Web server IP 
Address/Hostname and Port details during OFSAA installation. Here the Servlet port 
should be same as the Web server port.fl

If Web server is not configured, the Web application server's IP Address/ Hostname

and Port is required during the installation process. Here the Servlet port should

be same as the Web application Server port.

Is "ReveleusAdminConsoleAgent" applicable for OFSAAI 8.0.0.0.0 and higher 
versions?

No, ReveleusAdminConsoleAgent is not applicable starting OFSAAI 7.3.3.0.0. 
There is a change in the way agentservers are managed through AGENTSTARTUP.SH 
& AGENTSHUTDOWN.SH.

What should I do when the message server process does not open and I get the 
following error message, "CI18NProvider::CI18NProvider, Error, unable to connect to 
the config database"?

This error is displayed due to the following reasons:

• The Config Schema password is already expired.

• If the config schema password is going to expire soon and the message such 
asflfl"ORA-28002: the passwordflwill expire within 6 days" displays while 
connecting to config schema through sqlplus.

• The Config schema password is Modified.

flflTo resolve the error, re-set the config schema password to the old password. Else, if 
the config schema password is modified to something else then follow the below steps:

1. Delete the $FIC_HOME/conf/Reveleus.SEC file.

2. Shutdown the OFSAAI App service: cd $FIC_APP_
HOME/common/FICServer/bin ./stopofsaai.sh

3. Shutdown the OFSAAI App service: cd $FIC_APP_
HOME/common/FICServer/bin ./stopofsaai.sh

4. Start the Infrastructure Server in foreground directly on the server or through 
XWindows software using the command: ./startofsaai.sh

5. Enter System Password.

http://docs.oracle.com/cd/E61555_01/books/configuring_ofsaa_in_clustered_environment_guide.pdf
http://docs.oracle.com/cd/E61555_01/books/configuring_ofsaa_in_clustered_environment_guide.pdf
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6. Enter the new Config schema password. The service starts and initializes if it is 
able to successfully connect to the DB and generates the Reveleus.SEC file.

7. Post successful startup of the service, if required, the Infrastructure server may be 
shut down and restarted in the background using nohup mode.

What is the mechanism of Log File sizing and backup?

OFSAAI Log files created under $FIC_APP_HOME/common/FICServer/logs & 
<OFSAAI_DEPLOYED_AREA>/<CONTEXT.war>/logs is configurable in 
RevLog4jConfig.xml.

The default size of the log files (MaxFileSize) is set to max 5000kb & number of max 
backup log files (MaxBackupIndex) retained is set to 5, both of which are configurable. 
Increasing these parameters to a higher value should depend on the server HW 
configurations and may reduce the performance.

To configure the Logs file size on OFSAA Application server, follow these steps:

1. Navigate to $FIC_HOME/conf where OFSAA is installed.

2. Edit the following parameters in the file RevLog4jConfig.xml

• <param name="file" : Enter the path where the Logs are to be generated.

• <param name="MaxFileSize" : Provide the required file size.

• <param name="MaxBackupIndex" : Provide the required number of backup 
files to be created.

Example: 

<appender name="REVSERVERAPPENDER" 
class="org.apache.log4j.RollingFileAppender">

<param name="file" value="$FIC_
HOME/ficapp/common/FICServer/logs/RevAppserver.log"/>

<param name="Append" value="true" />

<param name="MaxFileSize" value="5000kb" />

<param name="MaxBackupIndex" value="5" />

<layout class="org.apache.log4j.PatternLayout">

<param name="ConversionPattern" value="[REVELEUSLOG] %m%n"/>

</layout>

</appender> 

To configure the Deployed area logs file, follow these steps:

1. Navigate to <EAR/WAR Deploy area>/conf folder.

2. Repeat step 2 from the above section.

Can we modify the Log file path?

flYes, Log file path is configurable, it can be configured in 
RevLog4jConfig.xml.default log file path (file) is set by the installer. This can be 
configured to another path. 

Can I point the environment with HTTP enabled to HTTPS after installation and vice 
versa?

For more details, see the HTTPS section in the OFSAAI Administration Guide.

What should I do if the sliced data model upload takes a long time to complete?
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If the metadata cache size is set to a lower value than the actual count of each 
metadata type (hierarchy, dataset, dimension etc), then it gets into performance 
degrade issues. We have to increase the cache size for each  metadata type according 
to the count in the environment.

Following are the parameters in DynamicServices.xml to be configured depends on 
the metadata count in your environment. 

<PARAMETER NAME="HIERARCHY_NODE_LIMIT" VALUE="2000"/> 

 <PARAMETER NAME="ALIAS_CACHE_SIZE" VALUE="1000"/> 

<PARAMETER NAME="DATASET_CACHE_SIZE" VALUE="2000"/> 

 <PARAMETER NAME="MEASURE_

CACHE_SIZE" VALUE="3000"/> 

<PARAMETER NAME="HIERARCHY_

CACHE_SIZE" VALUE="2000"/> 

<PARAMETER NAME="DIMENSION_

CACHE_SIZE" VALUE="2000"/> 

<PARAMETER NAME="CUBE_CACHE_SIZE" VALUE="1000"/> 

<PARAMETER NAME="BUSINESSPROCESSOR_CACHE_SIZE" 

VALUE="2000"/> 

<PARAMETER NAME="DERIVEDENTIT

Y_CACHE_SIZE" VALUE="1000"/> 

Metadata count can be derived based on the following queries:

select count(1) from metadata_master where metadata_version=0  --- for all 
metadata select count(1) from metadata_master where metadata_version=0  
and metadata_type=1  --- for measure 

select count(1) from metadata_master where metadata_version=0  and 
metadata_

type=2  --- for Dimension 

select count(1) from metadata_master where metadata_version=0  and 
metadata_

type=3  --- for HCY 

select count(1) from metadata_master where metadata_version=0  and 
metadata_

type=4  --- for DATASET 

select count(1) from metadata_master wh

ere metadata_version=0  and  metadata_

type=59  --- for BP's 

select count(1) from metadata_master wh

ere metadata_version=0  and  metadata_

type=54   --- for Alias 

select count(1) from metadata_master wh
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ere metadata_version=0  and  metadata_

type=5  --- for CUBES 

select count(1) from metadata_master wh

ere metadata_version=0  and  metadata_

type=856  --- for Derived Entit

For LDAP authentication, which server connects with the LDAP server, the 
Application server (where ofsaai is installed), or Web Application server (where EAR 
is deployed)?

For LDAP authentication, the Application server (ficapp) connects with the LDAP 
server.

The LDAP server in the setup listens on secure protocol ldaps (port 636). I have the 
root certificate of the LDAP server for SSL, and would like to know where to offload 
this certificate?

You need to import the certificate into the JDK/JVM used by Reveleus server in ficapp 
layer.

How to relocate FTPSHARE folder?

You can run the PortC.jar utility. For more details, see Changing IP/Hostname, Ports, 
Deployed Paths of the OFSAA Instance section in the OFSAAI Admin Guide available 
on OTN.

How do we identify the list of ports that are used by/configured in an OFSAA 
environment?

1. Navigate to $FIC_HOME directory on target.

What should I do if I get the following error message, "Error while fetching open 
cursor value Status : FAIL"?

This error occurs while executing envCheck.sh because the user does not have access 
to V$parameter. This error does not occur due to sysdba or non sysdba  privileges 
provided they have access/grants to V$parameter.

Applications Pack 8.0.6.0.0 FAQs
What is an Applications Pack?

An Applications Pack is suite of products. For more information, see About OFSAA 
Infrastructure.

Can I get a standalone installer for OFSAAI 8.0?

No. AAI is part of every Applications Pack and installs automatically.

How does OFSAA 8.0 Applications Pack relate to OFSAA 7.x series?

8.0 is a new major release consolidating all products from OFSAA product suite.

Can existing OFSAA 7.x customers upgrade to OFSAA 8.0 Applications Pack? 

There is no upgrade path available. However, we will have migration kit / path for 
every product to 8.0 Applications Pack. Further details will be available with Oracle 
Support Services.

Does OFSAA 8.0 Applications Pack UPGRADE automatically to existing 
environments?

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E60058_01/homepage.htm
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No. OFSAA 8.0 Applications Pack has to be installed in an new environment and 
subsequently migration path / migration kit needs to be run to migrate from 7.x to 8.0. 
Note that the objects can be migrated only from the previously released version of 
OFSAA products.

Where can I download OFSAA 8.0 Applications Pack?

You can download the OFSAAI 8.0 Applications Pack from Oracle Software Delivery 
Cloud (OSDC).

What are the minimum system and software requirements for OFSAA 8.0 Applications 
Pack?

See installation guide section Hardware and Software Requirements.

Is my environment compatible with OFSAA 8.0 Applications Pack? 

Environment Check utility performs the task. It is part of install and can also be run 
separately.

Does the OFSAA 8.0.6.0.0 Applications Pack support all Operating systems?

OFSAA 8.0.6.0.0 Applications Pack supports the following Operating Systems: LINUX, 
AIX, SOLARIS. See Technology Matrix for the technology matrix that OFSAA suite 
products are/ will be qualified on.

How can I install OFSAA 8.0.6.0.0 Applications Pack?

See Oracle Financial Services Advanced Analytical Infrastructure Installation And 
Configuration Guide published in OTN for the Applications Pack installers.

Does this installation require any Third party Softwares? 

Oracle Financial Services Advanced Analytical Infrastructure Installation And 
Configuration Guide published in OTN lists the third party software that needs to be 
installed.

What languages are supported during OFSAA 8.0.6.0.0 Applications Pack 
installation?

US English is the language supported.

What mode of installations OFSAA Applications Pack supports?

OFSAA Applications Packs supports Silent Mode.

Does OFSAA 8.0.6.0.0 Applications Pack support Multi tier Installations?

OFSAA 8.0.6.0.0 supports only single tier installation. For more information see 
OFSAAI FAQs section.

Does this Applications Pack validate all Pre-requisites required for this installation 
i.e., Memory, Disk Space etc.?

Yes.  The pre-requisite checks are done by the respective Applications Pack installer.  

What happens if it aborts during installation of any application with in Applications 
Pack?

You must restore the system and retrigger the installation

Does this Applications Pack 'Roll Back' if any application installation fails due to 
errors?

Rollback of installation is not supported.

Does the Applications Pack install all applications bundled?

http://docs.oracle.com/cd/E60058_01/homepage.htm
http://docs.oracle.com/cd/E55339_01/homepage.htm
https://edelivery.oracle.com/EPD/Search/handle_go
https://edelivery.oracle.com/EPD/Search/handle_go
http://docs.oracle.com/cd/E60058_01/homepage.htm
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All Applications Pack system files are installed but there is an option to enable the 
licensed products.

Can I re-install any of the Applications Packs?

You can retrigger in case of failure.

Does this Applications Pack allow enabling / disabling any of the applications 
installed?

Yes. You cannot disable once the product is enabled in an environment.

I have installed one application in an Applications Pack, can I install any of new 
application within the Applications Pack later?

No, installation of additional applications is not required.   If you wish to add an 
application later, you can enable the application at that time.

How many OFSAA Infrastructures can be installed in a single server?

There is no issue in installing separate OFSAAI installations, each with their own 
PFT/FTP installations and separate associated database instances and separate Web 
server installations on the same server as long as adequate memory is allocated for 
each instance and as long as each OFSAAI installation is installed using a separate 
UNIX user and profile. Care should be taken if running multiple OFSAAI installations 
on a single server. Adequate memory will be required for each installation as several 
OFSAAI processes (model upload, DEFQ services, etc) take significant amounts of 
memory. So it depends on your server memory.

Is it possible to Install OFSAA 8.0 Applications Pack on an existing 'Infodom' where 
another OFSAA 8.0 application is installed?

Yes. However, the Behavioral Detection Applications Pack and Compliance 
Regulatory Reporting Applications Pack are the exceptions. They need to be installed 
in a different INFODOM.

Can I select an Infodom in Applications Pack during installation?

Yes. You can select or change the required infodom. 

Can I install all Applications Packs in a 'Single Infodom'?

Yes. But Behavioral Detection Applications Pack and Compliance Regulatory 
Reporting Applications Pack are the exceptions. They need to be installed in a 
different INFODOM.

Is it possible to install applications on different Infodom within the Applications 
Pack? (For example, I want to install LRM & MR in two infodoms)

Applications within Applications Pack have to be installed in the same information 
domain in the same environment.

How many Infodoms can be created over a single OFSAA Infrastructure of 8.0.6.0.0?

You can install only one infodom during installation. But after installation, you can 
create multiple infodoms.

Is the 'Data Model' bundled specific to an Applications Pack or to an individual 
application?

A merged data model for all applications within the Applications Pack is bundled and 
uploaded.

Is it possible to install OFS Enterprise Modeling later?
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OFS Enterprise Modeling is a separate product and can be enabled as an option later 
from any Applications Pack that bundles Enterprise Modeling.

Does the Applications Pack create sandbox automatically for the required 
applications?

Yes, Sandbox creation is part of application install process.

Are upgrade Kits available for individual applications or the complete Applications 
Pack?

Maintenance Level (ML) Release / Minor Release  upgrades are available across all 
applications.

Can I upgrade AAI only?

Yes, you can upgrade AAI alone.

Can I upgrade one application within the Applications Pack? (For example, I want to 
upgrade LRM in the Treasury Applications Pack, but not MR.)

No, an upgrade is applied to all applications in the Applications Pack.

Is it possible to uninstall any Application from the Applications Pack?

No, it is not possible to uninstall any Application from the Applications Pack.

Can I uninstall entire Applications Pack?

No, you cannot uninstall the Applications Pack.

Is it possible to uninstall only application and retain AAI in the installed 
environment?

No, you cannot uninstall only the application and retain AAI in the installed 
environment.

Does Applications Pack contain all Language Packs supported?

Language Packs need to be installed on 8.0 Applications Packs.

Can I install an Applications Pack over another Applications Pack (that is same 
infodom or different infodom)?

Yes, you can install an Applications Pack over another Applications Pack in the same 
information domain or different information domain. But Behavioral Detection 
Applications Pack and Compliance Regulatory Reporting Applications Pack, Asset 
Liability Management Applications Pack and Profitability Applications Pack are the 
exceptions. They need to be installed in a different INFODOM.

Can I use an existing manually created schema as information domain for 
Applications Pack installation?

No. Schemas required by OFSAA applications have to be created using Schema 
Creator Utility.

Does OFSAA 8.0 support on WebLogic 10.3.6 with Oracle 12c?

Yes, OFSAA 8.0 will support on WebLogic 10.3.6 with Oracle 12c. WebLogic 10.3.6 
supports oracle 12c with some additional configurations. See the link   
http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_
12cdriver.htm#JDBCA655 for additional configurations.

What should I do if I get the following error message while running the schema 
creator utility, "HostName in input xml is not matching with the local hostname"?

http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655 for additional configurations
http://docs.oracle.com/cd/E28280_01/web.1111/e13737/ds_12cdriver.htm#JDBCA655 for additional configurations
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 One possible reason could be the machine is configured for zonal partitioning. Ensure 
all the known IP Addresses of the machine are present in the /etc/hosts file.

What are the Java versions supported in OFS AAAI Applications Pack version 
8.0.6.0.0?

OFS AAAI Applications Pack supports Java 1.7.x and 1.8.x.

Is OFS AAAI Applications Pack version 8.0.6.0.0 supported on Java 8? 

Yes. To install this release of the OFS AAAI Applications Pack version 8.0.6.0.0 on Java 
8. For more information, see specific notes mentioned in the sections Installer and 
Installation Prerequisites, Configurations supported for Java 8, Configuring and 
Executing Schema Creator Utility, Installing in Silent Mode.

What should I do when I get "[ERROR] - Error : APP Setup bin file failed." message 
during OFS_Application_PACK installation? 

This is a generic error message that appears during application installation failure. 
You should check the installation log files for more information about what failed the 
installation.

However, if the message is displayed and the log files are not generated, it could be 
that it is a temp directory issue. The resolution is that your UNIX administrator has to 
disable the NOEXEC option. The installers extract the installation files into the /tmp 
directory, and if NOEXEC is enabled, execution of binaries will not happen in the 
directory and the installation fails. Re-run the installer after the configuration is 
changed. For detailed information, see the support note at 
https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1.

Forms Framework FAQs
What should I do when I have large volume of data to be exported?

It is recommended to use BIP reports or OBIEE reports if you have to export large 
volume of data.

How do I export the columns added to the grid using Field Chooser option?

Perform Grid Export operation to export the columns added to the grid by Field 
Chooser option.

'Expand All/ Collapse All' button is not visible in the Hierarchy Browser window. 
What should I do?

Expand All/ Collapse All button is enabled only if the number of hierarchy nodes is 
less than 50. If it is more than that, it is considered as large hierarchy and the data will 
be fetched dynamically when you expand each node.

What is the difference between the two Searches available in the Hierarchy Browser 
window?

In the new Hierarchy Browser window introduced from 7.3.5.1.0 version, there are 2 
search options available as highlighted in the following figure:

https://support.oracle.com/epmos/faces/DocumentDisplay?id=2340045.1
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• DB Search (Top search container): It will search the required node in database 
and displays the result as shown below. This search is performed on full hierarchy 
nodes.

• UI search (Below the hierarchy): This search will find the required node in the UI 
and will show in tree structure. 

Note: In case hierarchy nodes are more than 50 and if it is a 
non-custom hierarchy, then the UI search will not show the required 
node in tree structure, until all the nodes are expanded and loaded 
manually in the UI.

What is a Custom Hierarchy?

Custom hierarchies will be having the parameter configuration customQuery as 
shown below and the customized query will be taken from the HIERARCHY_FILTER_
MASTER table. 

Configuration in xml:

<CONTROL ID="1003" TYPE="41">

<CONTROLPROPS>

            <EXTRAPARAMETERS>

<PARAMETER NAME="customQuery" VALUE="Yes"/>
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</EXTRAPARAMETERS>

</CONTROLPROPS>

    </CONTROL>

For custom hierarchy, all the hierarchy nodes are loaded in UI without any limit. 

So, even if the hierarchy nodes are more than 50, the UI search will show the required 
node in tree structure and ExpandAll and ExpandBranch images will be enabled.

Error Dictionary
This contents of this section has been created with the interest to help you resolve the 
installation issues if any. There is a compilation of all the possible errors that might 
arise during the installation process with the possible cause and the resolution to 
quickly fix the issue and proceed further with the installation.

This section includes the following topics:

• Accessing Error Dictionary

• Error Code Dictionary

Accessing Error Dictionary
Instead of scrolling through the document to find the error code, you can use the pdf 
search functionality. In the "Find" dialog available in any of the Adobe Acrobat version 
that you are using to view the pdf document, follow the below instructions to quickly 
find the error resolution.

1. With the Installation pdf open, press Ctrl+F or select Edit > Find.

2. The Find dialog is displayed as indicated.

3. Enter the error code that is displayed on screen during Infrastructure installation.

4. Press Enter. The search results are displayed and highlighted as indicated below.

Figure T–1 Error Code

View the details of the issues, its cause, and resolution specific to the error code. 
Repeat the step to find an answer to any other errors that you notice during 
installation. If you are not able to resolve the issue even after following the steps 
provided in resolution, you can contact support.oracle.com along with log files and 
appropriate screen shots.

https://support.oracle.com/epmos/faces/MosIndex.jspx?_afrLoop=171145527063081&_afrWindowMode=0&_adf.ctrl-state=9bxcn9tmr_9
https://support.oracle.com/epmos/faces/MosIndex.jspx?_afrLoop=171145527063081&_afrWindowMode=0&_adf.ctrl-state=9bxcn9tmr_9
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Error Code Dictionary

Table T–2 Error code - OFSAAI-1001

Cause Unix shell is not "korn" shell.

Resolution Change the shell type to "korn". Use chsh unix command to change 
SHELL type.

Shell type can also be changed by specifying shell path for the Unix 
user in /etc/passwd file.

Note: chsh command is not available in Solaris OS.

Table T–3 Error code - OFSAAI-1002

Cause No proper arguments are available.

Resolution Provide proper arguments. Invoke Setup.sh using Silent mode.

Example: ./Setup.sh SILENT

Table T–4 Error code - OFSAAI-1004

Cause File .profile is not present in $HOME.

Resolution Create .profile in $HOME, i.e. in the home directory of user.

Table T–5 Error code - OFSAAI-1005

Cause File OFSAAInfrastructure.bin is not present in current folder.

Resolution Copy OFSAAInfrastructure.bin into installation kit directory.

Table T–6 Error code - OFSAAI-1006

Cause File CustReg.DAT is not present in current folder.

Resolution Copy CustReg.DAT into installation kit directory.

Table T–7 Error code - OFSAAI-1007

Cause File OFSAAI_InstallConfig.xml is not present in current folder.

Resolution Copy OFSAAI_InstallConfig.xml into installation kit directory.

2Error code - OFSAAI-1001

2Error code - OFSAAI-1002

2Error code - OFSAAI-1004

2Error code - OFSAAI-1005

2Error code - OFSAAI-1006

2Error code - OFSAAI-1007



Table T–8 Error code - OFSAAI-1008

Cause File validateXMLInputs.jar is not present in current folder.

Resolution Copy validateXMLInputs.jar into installation kit directory.

Table T–9 Error code - OFSAAI-1009

Cause File log4j.xml is not present in current folder.

Resolution Copy log4j.xml into installation kit directory.

Table T–10 Error code - OFSAAI-1010

Cause Unknown error occurred.

Resolution Make sure to provide proper argument (Silent) to the Setup.sh file.

Table T–11 Error code - OFSAAI-1011

Cause XML validation failed.

Resolution Check InfrastructurePreValidations.Log for more details.

Table T–12 Error code - OFSAAI-1012

Cause Property file with locale name does not exist.

Resolution Copy MyResources_en_US.properties to the setup kit directory and 
keep en_US in LOCALE tag of OFSAAI_InstallConfig.xml.

Table T–13 Error code - OFSAAI-1013

Cause File OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.xml 
not found.

Resolution Copy OFSAAI_InstallConfig.xml/OFSAAI_PostInstallConfig.xml 
to the setup kit directory.

Table T–14 Error code - OFSAAI-1014

Cause XML node value is blank.

Resolution Make sure all node values except SMTPSERVER, PROXYHOST, 
PROXYPORT, PROXYUSERNAME, PROXYPASSWORD, 
NONPROXYHOST, or RAC_URL are not blank.
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2Error code - OFSAAI-1008

2Error code - OFSAAI-1009

2Error code - OFSAAI-1010

2Error code - OFSAAI-1011

2Error code - OFSAAI-1012

2Error code - OFSAAI-1013

2Error code - OFSAAI-1014



Table T–15 Error code - OFSAAI-1015

Cause XML is not well formed.

Resolution Execute the command dos2unix OFSAAI_InstallConfig.xml to 
convert plain text file from DOS/MAC format to UNIX format.

OR

Make sure that OFSAAI_InstallConfig.xml is valid. Try to open the 
file through Internet Explorer for a quick way to check validity. If it 
is not getting opened, create new OFSAAI_InstallConfig.xml using 
the XML_Utility.jar.

Table T–16 Error code - OFSAAI-1016

Cause User installation directory contain blank spaces.

Resolution Provide an installation path that does not contain spaces. Check the 
tag USER_INSTALL_DIR in OFSAAI_InstallConfig.xml file. This path 
should not contain any spaces.

Table T–17 Error code - OFSAAI-1017

Cause User installation directory is invalid.

Resolution Provide a valid installation path. Check if you are able to create the 
directory mentioned in USER_INSTALL_DIR tag value of OFSAAI_
InstallConfig.xml file.
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2Error code - OFSAAI-1015

2Error code - OFSAAI-1016

2Error code - OFSAAI-1017
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